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CHAPTER
ONE

OVERVIEW

This manual demonstrates how to use either the Visual Setup (.sdf input files) or Text Base Setup (.pre input files)
to set up a VSim simulation. It then shows how to run the computational engine on the resulting input files, how to
perform data analysis in VSim, and how to visualize data.

VSim /[VSi] is an arbitrary dimensional, electromagnetics and plasma simulation code consisting of two major com-
ponents:

* VSimComposer, the graphical user interface.
* Vorpal [NC04], the VSim Computational Engine.

VSim also includes many more items such as Python, MPI, data analyzers, and a set of input simplifying macros.

1.1 What is VSimComposer?

VSimComposer provides an interface that allows you to edit and validate your simulation input files, run VSim simu-
lations, and visualize results using the Vislt-based Visualization pane embedded within VSimComposer. You can also
edit VSim input files in the text editor of your choice, perform calculations with the easy-to-run, command-line-driven
Vorpal engine, and then run the visualization tool of your choice.

Note: Look and Feel Differences

VSim runs on Linux, Mac OS X, and Windows. Each of these platforms has its own unique look and feel (e.g. the
ordering of buttons in dialogs, and in the case of Mac OS X the arrangement of menus and menu items). Furthermore,
the appearance of VSim can vary depending on the theme being used.

Given these differences and that screenshots may not always of the most recent release, please note that screenshots
shown in this manual may look different from the VSim that you see running on your own computers. VSim should
function the same, but if you look for a particular toolbar or button it may not be in same place in your copy of VSim.

1.2 VSim Capabilities

VSim is a flexible, multiplatform, high-performance tool for running electromagnetic, electrostatic, and plasma simu-
lations in 1, 2, or 3 dimensions.

VSim solves EM propagation in the presence of complex dielectric and metallic shapes with accurate simulation of
curved geometries using a conformal mesh. Examples include:

¢ Dish Antenna

e Horn Antenna
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 Patch Antenna

* Waveguides

* Far Field calculations
» Radar Cross Sections
* Crab Cavities

The kinetic plasma model is based on the particle-in-cell (PIC) algorithm, both in the electromagnetic and electrostatic
limits. For electromagnetics, a charge-conserving current deposition algorithm enables the integration of the Maxwell
equations without any additional divergence correction. In the electrostatic limit, the VSim computational engine
(Vorpal) solves Poisson’s equation at every time step based on the instantaneous charge distribution. Examples include:

e Magnetrons

* Electron guns

* Jon sources

* Multipacting in waveguides
 Traveling Wave Tubes

» Hall Thrusters

* Laser Plasma Accelerators

The structures within the VSim applications can be arbitrarily shaped and can define the locations of conductors,
dielectrics, particle absorbers, reflectors, and other geometrical objects.

2 Chapter 1. Overview



CHAPTER
TWO

STARTING VSIMCOMPOSER

2.1 Running Locally

Once you have installed VSim successfully as per the instructions given by VSim Installation, you are ready to run the
program. This section will detail how to run VSim locally on Windows, Mac, and Linux operating systems.

2.1.1 Running VSim on Windows

You can start VSim in the following ways on Windows:
¢ Select the VSim Icon
— Double-click on the VSim shortcut on your desktop
— Go to your Start menu, navigate to the Tech-X folder, and click on the VSim icon
¢ Run VSim from the Windows Command Line

— Navigate to the relevant program folder by going to Program Files -> Tech-X (Win 64) -> VSim-9.0 ->
Contents -> bin

— Type in VSimComposer.exe to run the VSim executable and launch the program
¢ Open VSim through Windows File Explorer
— Open Windows File Explorer, either through your start menu, desktop shortcut, or taskbar icon
— Navigate to C:Program FilesTech-X (Win64)VSim-9.0
* You can either click on the VSimComposer.Ink shortcut in this folder, or. ..
+ Continue on to Contents —> bin and then double-click on VSimComposer.exe
* Open VSim using an existing file
— Open Windows File Explorer
— Select a file that has a VSim-supported extension (like a .pre, .in, or .sdf, for example). Either. ..
# Double-click on the file if its default program is VSimComposer

# If its default program is not VSimComposer, right-click on the file and select Open with. Go into
Program Files -> Tech-X (Win64) -> VSim-9.0 -> Contents —> bin and select the VSimComposer.exe
application file.
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2.1.2 Running VSim on Mac

On Mac OS, the methods for starting VSim are:
* Start from the Applications Folder

— Click on the VSimComposer icon in the Applications/VSim-9.0 folder (or in the folder where you have
VSim installed)

¢ Run VSim from Terminal Window
— Open a Terminal window

— Navigate to the folder where VSimComposer is installed, most likely by going to /Applications/VSim-
9.0/VSimComposer.app/Contents/MacOS

— Start VSim by typing ./VSimComposer.sh to run the program executable

2.1.3 Running VSim on Linux

For Linux, you can start VSim through the following:
» Navigate to the folder where the program is installed, for example /user/local/VSim-9.0-Linux64

* Type in ./VSimComposer.sh to run the program executable

2.2 Running VSimComposer On a Remote Computer System

Just as on a local workstation or laptop, the computational engine (Vorpal) may be invoked through the graphical
interface or from the command line on a remote system. On high performance computing clusters the command line
approach may be required in order to submit a job to a resource management system. These are documented separtely
here: - Running Vorpal from the Command Line - Running Vorpal from a Queue System

In this section we discuss alternatives for setting up, running via the GUI, and visualising output.

In the present version we offer the following capabilities for running VSim remotely:

Note: Prior to starting up VSim, it may be necessary to set the environment variable export
LIBGL_ALWAYS_INDIRECT=1 in order for the visualization stage to work correctly. Some users using VNC on
ubuntu 14.04 have also reported adding the system installation of mesa to the start of the LD_LIBRARY_PATH envi-
ronment variable, has helped overcome their issues.

export LD_LIBRARY_PATH=/usr/lib/x86_64-1linux—gnu/mesa:S$SLD_LIBRARY_PATH

* RDP: If your remote system is a windows system then you may connect to that with Windows remote desktop
connection or from linux computers with a range of tools that support the RDP protocol. Make sure remote
access is enabled in system settings if you wish to use this method.

e VNC: If a VNC server is set up on the remote machine, one may try to connect a local client to the remote
machine using VNC.

* Virtual GL: If one is using a remote machine that has virtual GL server or DCV one may run using the hardware
acceleration on the remote machine. This may provide the best performance but also the most system adminis-
tration work Many HPC centers are already set up for this kind of access. There is a super-accelerated virtualGL
client, but it is more common to find virtualGL set up like DCV such that the remote machine is running a VNC
server, which you may connect to with any VNC client on your local machine.

4 Chapter 2. Starting VSimComposer
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e X Windows: If one does not have hardware acceleration on the remote machine one may forward X using an
ssh client (ssh -Y) or use accelerated X forwarding using software like NoMachine NX. As of this writing, a
good discussion is at (https://www.hoffman2.idre.ucla.edu/access/x11_forwarding). Briefly,

— Linux users running X: edit /usr/bin/Xorg as described at the above link.
— OS X users running XQuartz: execute
defaults write org.macosforge.xquartz.X1ll enable_iglx -bool true

— Windows users: many options described at the above link.

2.3 Visualizing Remote Data

The following capabilities are recommended for visualizing remote data if the previous recommendataions do not
work for you:

* One may use an external utility to copy the remote files back to a local machine (scp, sftp or winSCP are likely
options). Providing the .pre or .sdf file is in the same directory as the data to be viewed, it should be possible to
visualize the output locally. This is the most appropriate solution for those dealing with small datasets.

 Use standalone Vislt and it’s remoting feature. Vislt may be downloaded from (https://wci.llnl.gov/simulation/
computer-codes/visit/downloads). Users of native Vislt should be sure to make sure their local version number
matches up with the version running remotely. This option offers the full flexibility of Vislt, such as the ability
to make all the individual images needed to make movies in a single go and the ability to fully Python script
your visualisation, but there is a corresponding learning curve. There are many tutorials and resources at The
visitusers website (http://www.visitusers.org).

» Use matplotlib or alternative software on the remote machine. The VsHdf5 module is provided with VSim and
may be used to read and manipulate remote datasets for this purpose.

2.4 Welcome Window

Upon opening VSim, you are brought to the Welcome Window. If it is your first time opening VSim, your Recent
Simulations will be empty. However, if you have completed previous runs, you may use this area to quickly select a
recent simulation and re-open it. You can also create new simulations based on those you have recently worked with.
The Welcome Window is shown in Fig. 2.1.

2.3. Visualizing Remote Data 5
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VSim
File  Edit

Visualize

Tools

View  Help

L VSim

Welcome!

VSim is a flexible, multiplatform, Particle-in-
Cell simulation tool for running
computationally intensive plasma,
electromagnetic and electrostatic problems
Switch easily between 1, 2, or

dimensions, then watch your model run
lightning fast using algorithms designed for
the exacting demands of high performance
computing systems, whether on your laptop
or supercomputing cluster. With VSim, you
can start from our wide range of examples
both dsmonstrating classical physics
problems and real world devices spanning
plasma discharges, ion thrusters, satellite
charging, radar antennas, vacuum
electronics, photonic devices, or particle
accelerator components.

For more information, view tutorials...

@ welcome: NO SIMULATION Open a new simulation by choosing New From Example in the File menu or double-clicking item in Recent list.

Open Recent Copy Recent

Show Log

Fig. 2.1: Welcome Window

Chapter 2. Starting VSimComposer



CHAPTER
THREE

CREATING OR OPENING A SIMULATION

The first step to creating your own simulation is to open a file. It can be an existing example, an existing simulation,
or a completely new simulation.

3.1 Creating a Simulation from an Example

To run one of the examples in VSim, one must first copy the example file, and any correlated files, to a new directory.
Choose New -> From Example from the File menu. See Fig. 3.1.

X VSim

Examples ? X
Welcome!
Available Templates Description
VSim is a flexible,

Cell simulation tool for running > VSim for Basic Physics These examples show how to study basic physics

computationally intensive plasma| VSim for Electromagnetics in VSim, indluding electrostatics, electromagnetics,

slectromagnstic and electrostatic VSim for Microwave Devices D“Eg'"ﬂ e E”‘f;’“i”&‘f‘ﬂtﬁ“i” be done with
slab geometries and without colisions or

Swilch easily between 1, 2, or 3 VSim for Plasma Acceleration advanced algorithms. Al of these can be

dimensions, then watch your mod VSim for Plasma Discharges executed with only a VSimBase icense.

lightning fast using algerithms de VSim for Semicondudtor Devices
Visuslize the exacting demands of high perf

computing systems, whather on
rd or supercomputing cluster. With
can start from our wide range of e
both demonstrating classical phy:
problems and real world devices |
plasma discharges, ion thrusters,|
charging, radar antennas, vacuu
electronics, photonic devices, or
accelerator components.

For more information, view tutorials...
Open Recent Copy Recent

@ welcome: NO SIMULATION Open a new simulation by choosing New From Example in the File menu or double-dlicking item in Recent st Show Log

Fig. 3.1: Create new simulation from example
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3.1.1 Select Example Template

The Examples dialog box will open and you can choose an example template to run. Here a short description and
image of the available examples will be displayed. Examples are split into VSim Modules. You must possess the
correct license for an example to run, though you can see them all.

Upon selecting an example from the Available Templates pane, either double click the example you have chosen or
single click and then click the Choose button.

For this demonstration we have chosen the Electromagnetic Plane Wave example from the VSim for Basic Physics
module. See Fig. 3.2.

VSim - Electromagnetic Plane Wave - u] x

X VSim

Welcome!

VSim is a flexible,

Emples ? X

Avallable Templates

Description

Cell simulation tool for running
computationally intensive plasma
electromagnetic and electrostatic
Switch easily between 1, 2, or 3
dimensians, then watch your mod
lightning fast using algorithms de:
the exacting demands of high perf
computing systems, whether on
or supercomputing cluster. With
can start from our wide range of e
both demonstrating classical phy:
problems and real world devices

plasma discharges, ion thrusters.
charging, radar antennas, vacuu
electronics, photonic devices, or
accelerator components.

For more information, view tutorials...

~ VSim for Basic Physics

v Basic Examples
Cylindrical Capacitor
Oscillating Dipole Above Conducting Plane
Electromagnetic Plane Wave
Electromagnetic Particle in Cell
Vacuum Electromagnetic Pulse
Electrostatic Particle in Cell
Half-Wave Antenna
Parallel Plate Capacitor
Two-Stream Instability

> Basic Examples (text-based setup)

Vsim for Electromagnetics

VSim for Microwave Devices

VSim for Plasma Acceleration

VSim for Plasma Discharges

VSim for Semiconductor Devices

@ Welcome:  SIMULATION OPEN emPlaneiave sdfis aready open.

An electromagnetic plane wave launched into

Cpen Recent Copy Recent

Show Leg

Fig. 3.2: Selecting an example from the Examples dialog

3.1.2 Choose a Name for the New Simulation

Upon selection of the example template, the window Choose a name for the new simulation will open. Here you can
choose the folder, or create a new folder, and set the name of the new simulation.

When the name and directory have both been chosen, click the Save button to proceed. See Fig. 3.3.

3.1.3 Proceed to the Setup Window

From here, Composer will automatically take you to the Setup window where you are free to explore and alter the
parameters of the example you have chosen. See Fig. 3.4.

8 Chapter 3. Creating or Opening a Simulation
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/ Choose Simulation Name ? >

Save as: |EmPIane‘u'u"ave.sdf |

Host: | localhost -
Directory: |C:hUsers\gdegrandeocumentshtxcnrpWSimS.lhsimuIatinnshemPIane‘u'-.l‘ave w
Use Smart Grouping home simulations refresh

filename size last accessed

@ . [parent directory]

All Files -

New Folder

Fig. 3.3: Choose name and directory to use for the simulation

VSim - Electromagnetic Plane Wave - [u] X
File Edit Tools View Help

@ simulation Setup is Ready |Save and Setup
df

Simulation o4z @ phi) Properties View Solids | [select soid - 47 v || ResetFositon
Deseription

[#] Constants

[#] Parameters
Basic Settings
Functions

[#] SpaceTimeFunctions
Materials

[*] Geometries

[# Grids

[#] Field Dynamics
Histories

30 View

Database

Remove Add

Property Value

@ setup: COMPLETED Click run to continue Show Log

Fig. 3.4: Proceed to the setup window

3.1. Creating a Simulation from an Example 9
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3.2 Opening an Existing Simulation

If you have a simulation already created, you can double-click on the simulation .sdf or .pre file that appears under
Recent Simulations in the VSim Composer Welcome menu.

Or, if your simulation does not show under the Recent Simulations heading, you can go to File -> Open Simulation
and use the Open Simulation file navigation window to select the simulation .sdf or .pre file you would like to open.
See Fig. 3.5.

WSim - A Laop Antenna crested from a coaxial cable — m] X
File Edit Tools View Help

New 3

Open Simulation ... Ctri+0

Save Simulation Ctrl+S ®

Sove Simulation As .. Ctrl+Shift+S I m
Close Simulation CtrlsW

Open Ausiliary File ...
Save Auliary File

Recent Simulations

Close Auziliary File

T |coaxielLoopAntenna.sdf
platform, Particle-in- Ci\Users\jcollins\Decuments\becorp\VSim9.0\simulations
Export ... » |nning emPlaneWave.sdf

plasma, Ci\Users\jcollins\Documents\becorp\VSim9.0\simulations
Recent Simulations trostatic problems.

203
Quit Ctrl+Q our madel run
gy ry ithms designed for
Vet the exacting demands of high performance
computing systems, whether on your laptop
? or supercomputing cluster With VSim, you
can start from our wide range of examples
both demonstrating classical physics
problems and real world devices spanning
plasma discharges, ion thrusters, satellite
charging, radar antennas, vacuum
electronics, photonic devices, or particle
accelerator components.

Import ..

For more information, view tutorials...
Formors inlormation view forias. openecnt | Comvecant

D welcome:  SIMULATION OPEN coaxiall oopAntenna.sdfis already open. Show Log

Fig. 3.5: Open an existing simulation .sdf or .pre file

From here, Composer will automatically take you to the Setup window where you are free to explore and alter the
parameters of your simulation.

3.3 Creating a Blank Simulation

3.3.1 Create New Visual Setup Simulation

To create a completely custom visual-based simulation, you must choose New -> Simulation from the File menu.
Creating an entirely new simulation requires knowledge of topics covered in later sections. See Fig. 3.6.

Proceed to the Setup Window

You are automatically taken to the Setup window. You are now free to create your own custom simulation and explore
the power and versatility of the Vorpal engine. See Fig. 3.7.

10 Chapter 3. Creating or Opening a Simulation
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V/Sim - A Loop Antenna created from a coaxial cable - m] X
File | Edit Tools View Help
New »

From Bample .. CtreN
Open Simulation .. Cie0 Simulation
Save Simulation CtrleS Ty S

Save Simulation As ... Ctrl+Shift+5
Close Simulation Cerl+W

Save Awliary File

Close Ausiliary File Recent Simulations

——— | coaxialLoopAntenna.sdf
latform, Particle-in- 0

mport .. ' Ci\Users\jcollins\Do o
Export ... » |nning emPlaneWave.sdf

plasma, C\Users\jcollins\Decuments\becorp\VSim3.0\simulations
Recent Simulations trostatic problems.

2013

Quit our model run

y y et u angeithms designed for

Visuslize the exacting demands of high performance
computing systems, whether on your laptop
or supercomputing cluster. With VSim, you
can start from our wide range of examples
both demonstrating classical physics
problems and real world devices spanning
plasma discharges. ion thrusters. satellite
charging, radar antennas. vacuum
electronics, photonic devices, or particle
accelerator components

For more information, view tutorials...

s | | e

& Welcome:  STMULATION OPEN coaxialLoopAntenna.sdfis already open. Show Log ‘

Fig. 3.6: Choose to create a new visual setup simulation

Vsim - u] X

File Edit Tools View Help

\’ =vsim.sdf
Welcome
Simulation 3 %oz Garph) | propertes | |View Salids = | select said N el | [ e |
Description E
[#] Constants a
Parameters
Basic Settings 3
Ry Functions £
SpaceTimeFunctions 3
- Materials
@ [#] Geometries
¢] Grids
Analyze [¥] Field Dynamics
Histories
Visualize
?
Help
[ Remove || add |
Property Value
@ Setup: NOT SAVED Simulation needs to be saved before runring | showlog |

Fig. 3.7: A blank slate

3.3. Creating a Blank Simulation 11
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Choose Simulation Name and Save

When you are ready to save your simulation, go to File -> Save Simulation and choose a location and name for your
new simulation. See Fig. 3.8.

VSim - o ®

File Edit Tools View Help

\’ Waiting On Save, Save and Setup
=vsim.sdf
Welcome
Simulation 3 %02 ) | propertes | |view solids ~ | select sold v | TogdeAxes | [Perspectveview] [+2  ~||  ResetPositon
Description H
[#] Constants &
Parameters
Basic Settings a
Functions 11151
Specclm-Eunchons Choose Simulation Name 7%
Materials
[*] Geometries Save as: |Newvsim.sdf
[#] Grids
3] Field Dynamics Host:  locahost -
Histories
Drectory: | C:\. |
it [7] Use Smart Grouping T home | M simabons || @) refresh |
Py filename size last accessed ~
y @ . [parent directory]
@ coaxialLloopAntenna.bd 19Kb  07/16/18 16:54:41.542
@ coaxialloopAntenna Tdfiles 07/16/18 16:5441.542
@ D bt 382kb  07/24/18 12:02:21.917
Remove @  DemoAmayedWaveguideGrating  4Tfiles 07/24/1812:02:18.745
@ De Ch Di dT.bt IMb 07/24/18 11:52:27.631
Property Value (@ DemoChargeGenXportDiamondT  110files 07/24/18 11:52:27.631
) DemocylindricalCapacitor.tt 8Kb  07/17/1810:34:58.342
@  DemocylindricalCapacitor 10files 07/17/1810:3458.342
@ DemodDielectricScatterT.bdt 52Kb  07/24/1813:37:06.232
] v
All Files. -
New Folder Cancel Save
€ sewp: HOT SAVED smulation needs to be saved before running Show Log

Fig. 3.8: Choose a name and directory for your new visual setup simulation

3.3.2 Create New Text Setup Simulation

To create a completely custom text based simulation, you must choose New -> Text-setup Simulation from the File
menu. Creating an entirely new simulation requires knowledge of topics covered in later sections. See Fig. 3.9.

Choose New Simulation Name And Save

A new window entitled Choose a name for the new simulation will pop up. Here, you choose a name for your new
simulation along with a location where the simulation will be saved. See Fig. 3.10.

Proceed to the Setup Window

You are automatically taken to the Setup window. You are now free to create your own custom simulation and explore
the power and versatility of the Vorpal engine. See Fig. 3.11.

12 Chapter 3. Creating or Opening a Simulation
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o - O e
File | Edit Tools View Help

New ’ FromExample .. Ctri+N

Open Simulation ... Ctrd+0 Simulation

Save Simulation Ctrl+S Text-setup Simulation

Save Simulation As ... Ctrl+Shift+5
Close Simulation Cerl+W

Save Awliary File

Close Ausiliary File Recent Simulations

coaxialLoopAntenna.sdf

it * platform, Particle-in- C\Usersjcollins\Documents\becorp\VSim2.D\simulations
Export ... »  Inning emPlanelWave.sdf

plasma, C\Users\jcollins\Decuments\becorp\VSim3.0\simulations
Recent Simulations trostatic problems.

2013

Quit our model run

y y et u angeithms designed for

Visuslize . the exacting demands of high performance
computing systems, whether on your laptop
or supercomputing cluster. With VSim, you
can start from our wide range of examples
both demonstrating classical physics
problems and real world devices spanning
plasma discharges. ion thrusters. satellite
charging, radar antennas. vacuum
electronics, photonic devices, or particle
accelerator components

For more information, view tutorials...

openrecent | Comyecent

& Welcome: HO STM OPEN Open or create new simulation frem File menu or from recent simulation Show Log

Fig. 3.9: Choose to create a new text setup simulation
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both demonstrating classical physics
problems and real world devices spanning

@ . [parent directory]
() cosxialLoopAntenna.tet 1oKb 071618 16:54:41.542
@  coaalloopAntenna Tifiles 07716718 16:54:41.542
::’La:;::‘f:::r'ga‘:;r'“;”a;hc‘;tsﬁsateme )  DemoAmayedWavequideGrating.tt 382Kb  07/24/18 120221917
electronics, photanic devices, or particle | |8 DemoAmayedWaveguideGrating 47 files 07/24/131202:18.745
L)
kE
L2
k]
L2

accelerator components. DemoChargeGenXportDiamondT bt TMb  07/24/18 11:52:27.631
DemoChargeGenXportDiamondT 110 files 07/24/18 11:52:27.631
DemocylindricalCapacitor.txt 8Kb  07/17/1810:34:58.342
DemocylindricalCapacitor 10files 07/17/18 10:34:58.342
DemodDielectricScatterT.bdt 52Kb  07/24/1813:37:06.232

Ll files D72401212:27.06 22

For more information, view tutori.

Cpen Recent Copy Recent

€ Welcome: MO SIM OPEN Open or areate new simulation from Fie menu or from recent simulation Show Log

Fig. 3.10: Choose a name and directory for your new text simulation

3.3. Creating a Blank Simulation 13
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VSim - Text-setup Simulation - o X
File Edit Tools View Help

[
© @ [ @ 5| view InputFie (-] Validate

newSimuiation.pre  newSimulation.in

A smulation with basic parameters defined. No fields or partides.

oM [2 ]

TIMESTEP_FACTCR |.995 ]

1[50 ]

N [so ]

Nz [0 ]

Visualize

?

1X [2.0e05 ]

1¥ [2.0e05 ]

12 [2.0e05 ]

XBGN [0, ]

vBaN o, ]

86N o, ]

NsTEPS [100 ]

DUMPPERICD |10 ]

@ setup: COMPLETED Click run to continue Show Log

Fig. 3.11: A blank slate
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CHAPTER
FOUR

MENUS AND MENU ITEMS

4.1 File Menu

The File menu contains options to control creating, opening, closing, and saving VSimComposer files and simulation
directories. See Fig. 4.1.

VSim - Text-setup Simulation - m| ®
File Edit Tools View Help

New 3

Open Simulation ... Ctrl+0

Save Simulation Ctrl+S

T~ e
Save Simulation As .. CirhShift+5 I m
At Sl Ctrlew
Save Auxiliary File

Close Auwliary File Recent Simulations

T SimulationMame.pre
Import ... » platform, Particle-in-

Ci\Users\jcollins\ Documents\txcorp\VSim3 O\simulations
Export ... » |nning coaxialLoopAntenna.sdf

plasma, Ci\Users\jcollins\ Documents\txcorp\VSim3 O\simulations
Recent Simulations »  ptrostatic problems. emPlaneWave.sdf

2,003 ChUsers\jeollins\Documentsitxcorp\VSim3.0\simulations
Quit Ctrl+Q our model run

o grasvwenng-argwithms designed for
Visualize . the exacting demands of high performance
computing systems, whether on your laptop
or supercomputing cluster. With VSim, you
can start from our wide range of examples
both demonstrating classical physics
problems and real world devices spanning
plasma discharges, ion thrusters, satellite
charging, radar antennas, vacuum
electronics, photonic devices, or particle
accelerator components.

For more i view futorials.

Open Recent Copy Recent

o Welcome: SIMULATION OPEN SimulationName.pre is already open. Show Log

Fig. 4.1: File Menu

4.1.1 New

File -> New has three options:

e From Example
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 Simulation
e Text-setup Simulation
For more information on each of these options, please see Creating or Opening a Simulation

4.1.2 Open Simulation

To open a directory where existing simulation files reside, select Open Simulation from the File menu. See Fig. 4.2.

WSim - Text-setup Simulation - [m] x
File Edit Tools View Help
New >

Open Simulation ... Ctrl+0

Save Simulation Ctrl+5 r ®

Ssve Simulation As .. Ctrl-ShiftsS I m
Close Simulation Ctrl+W

Save Auxiliary File

Close Auwiliary File Recent Simulations

—————— Bl smuktontemepis
platform, Particle-in- C:\Users\jcollins\Documents\txcorp\VSim3.D\simulations

Import ... >
Export ... » |nning coaxialLoopAntenna.sdf
plasma, CUsers\jcollins\Documents\tcorp\VSima.Ohsimulations

-

Recent Simulations trostatic problems. emPlaneWave.sdf

2,0r3 Ci\Users\jcollins\Documents\tcorp\VSim3.0\simulations

Quit Ctrl+Q our model run

g grasrwonng-argerithms designed for

Visualize the exacting demands of high performance
computing systems, whether on your laptop

? or supercomputing cluster. With VSim, you
can start from our wide range of examples
both demonstrating classical physics
problems and real world devices spanning
plasma discharges, ion thrusters, satellite
charging, radar antennas, vacuum
electronics. photonic devices. or particle
accelerator components.

For more i ion, view tutorials.

Open Recent Copy Recent

o Welcome: SIMULATIOM OPEN SimulstionMame.pre is already open. Show Log

Fig. 4.2: Open selection from File menu

The default directory, simulations, is created for you during installation of VSim. You can modify this in the 7ools ->
Settings -> Host settings -> Paths menu. See Fig. 4.3.

4.1.3 Save Simulation

After a simulation is open, going to File -> Save Simulation allows you to save any modifications to the input file. The
saving process will also run the Python pre-processor on the file in order to do any Python substitutions or calculations
and to create the .in file.

4.1.4 Save Simulation As

After a simulation is open, clicking on File -> Save Simulation As allows you to save any modifications to the input
file and write it in to a new file. The saving process will also run the Python pre-processor on the file in order to do
any Python substitutions or calculations and to create the .in file.
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imulation - [m) x

File Edit Teols View Help

L VVSim

Host: |\oca\host v|
1
Welcome! Directory: | C:\sers\jcolins\Documents txcorpSim3. 0lsimulations -]
VSim is a flexible,
Cell simulation toaol f Use Smart Grouping 4 home ‘ ‘H smulanons| | @ refresh ‘

computationally intel
electromagnetic and
Switch easily betweq
dimensions, then wa
lightning fast using a
Visualize the exacting demang
computing systems,|
or supercomputing

last accessed

filename

.. [parent directory]
coaxialLoopAntenna.pre 6Kb  06/29/18 15:56:48.726
ceaxialloopAntenna.sdf 34Kb 06/29/18 13:56:42.448
emPlaneWave pre 5Kb  06/28/18 15:04:49.733
emPlaneWave.sdf 32Kk 06/29/18 13:04:42.864
SimulationName.pre 4Kb 07702718 13:53:34.221

DDDDOD&

plasma discharges,
charging, radar ante
electronics, photoni
accelerator compang

Simulation Files

D Welcome:  STMULATION OPEN  SimulationName. pre is already open. Show Log ‘

Fig. 4.3: Open Simulation window

4.1. File Menu
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4.1.5 Close Simulation

After a simulation is open, File -> Close Simulation allows you to close the current simulation and will return you to
the Welcome window.

4.1.6 Open Auxiliary File
This can be used to open any file related to a simulation. It is most useful for opening and editing Python files. Many

times, a simulation will have an associated Python file that contains script for post-processing in the Analyze window
or for importing an external magnetic field.

4.1.7 Save Auxiliary File

This can be used to save any changes made to an auxiliary file.

4.1.8 Close Auxiliary File

This can be used to close an associated auxiliary file that was previously opened.

4.1.9 Import

When doing a visual-setup simulation, use the File -> Import option to import materials or geometries to use in your
simulation.

Materials files must be of the extension “.vmat”

Geometry files can be any of .stl, .ply, .vtk, .stp, .step or .p12.

4.1.10 Recent Simulations

To access data to visualize from a recently conducted simulation, select Recent Simulations from the File menu in the
menu bar. See Fig. 4.4

Click on the name of the simulation whose data you want to open.

4.1.11 Quit

File -> Quit will close VSimComposer.

4.2 Edit Menu

The Edit menu contains commands that pertain to editing activities in the Editor pane of the VSimComposer window
during Setup.

These operations are most useful when editing the input file directly. See Fig. 4.5.
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New

Open Simulation ...

Save Simulation

Close Simulation

Save Auxiliary File
Close Auxiliary File

Import ...
Export ..

Recent Simulations

Quit

Visualize . the exacting demands
computing systems, wl
or sup!

- ¥
can start from our wide range of examples
both demonstrating classical physics
problems and real world devices spanning
plasma discharges. ion thrusters, satellite
charging, radar antennas, vacuum
electronics, photonic devices, or particle
accelerator components.

Save Simulation As ...

Open Ausdliary File ..

VSim - Text-setup Simulation
File Edit Teools View Help

»
Ctrl+0
Ctrl+5
Ctrl+ Shift+5
Ctrl+W
»
»
»
Cirl+Q

Sim

nning
plasma,

Recent Simulations

latform, Particle-in-

SimulationMame.pre
ChUsers\jcollins\Documentsktecorp\VSim3.0\simulations
coaxialLoopAntenna.sdf
CihUsersticollins\Documents\txcoro\VSim3.0hsimulations

C\Users\jcollins\Documents\tcorp\VSim8.0\simulations\SimulationName.pre

C\Users\jcollins\Documents\txcorpV5im3.0\simulations\coaxialLoopAntenna.sdf

C\Users\jcollins\Dacuments\tecorp\V5im3.0\simulationsemPlaneWave.sdf

Clear Recent Simulations

puting cll

For more i

view tutorials.

D Welcome:  STMULATION OPEN  SimulationName. pre is already open.

Open Recent

Copy Recent

Show Log

Fig. 4.4: Recent Simulation Selection in File Menu

4.2. Edit Menu
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VSim - Text-setup Simulation - O *
File = Edit Teols View Help
Unde s
P Ctrl+R L parameters @ | valdate
Cut Ctrl+X NewSimulationNametxt.in
Copy Ctrl+C [l
Paste Ctrl+V
Select All Ctrl+A
Find and Replace Ctrl+F
GoTo Ctrl+G
a9
10 <X3im basicSimulation>
11 shortDescription = "Text-setup Simulation"
12 description = simulation with basic parameters defined.”™
13 longDescription "B simulation with basic parameters defined. No fields or particles.™
14 3 nemPlaneWavel.png™
15 il = "emPlaneWavelTn.png"
16 canChangeDt = trus
17 canChangeNdim = true
18 analyzers = []
19 </XSim>
27 = of « in
28 <XVar NDIM>
29 description = "Number of dimensions for the simulation"™
30 min =
31 max = 3
32 </XVar>
33
34 # Time step is this factor times T CFL limiting time step
35 <XVar TIMESTEP FACTOR>
36 description = "Time step is this factor times the CFL limiting time step”
37 </XVar>
38
38 # Number of c in x hd
(D Setup:  COMPLETED Click run to confinue Show Log

Fig. 4.5: Select Edit menu
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4.3 View Menu

The View menu has the option for viewing the log file for VSimComposer. See Fig. 4.6.

VSim - [m] x
File Edit Tools View Help
Show Log Chl-L

Start External Vislt

Welcome! Recent Simulations

- NewSimulationNamebst. pre
VSim is a flexible, multiplatform, Particle-in- CihUsers\jcollins\Documents\txcorphVSim3.Oksimulations
Cell simulation tool for running NewSimulationMName.pre

computationally intensive plasma, C\Users\jcollins\Documents\txcorp\VSim9.0\simulations
electromagnetic and electrostatic problems. SimulationName.pre

Switch easily between 1, 2, or 3 CihUsers\jcollins\Documents\txcorphVSim3.0\simulations
dimensions, then watch your model run coaxialLoopAntenna.sdf

lightning fast using algorithms designed for C\Users\jcollins\Documents\txcorp\VSim9.0\simulations
the exacting demands of high performance emPlaneWave. sdf

computing systems, whether an your laptop CA\Users\jcollins\Documents\tcorp\VSim.Oisimulations
or supercomputing cluster. With VSim, you

can start from our wide range of examples

both demonstrating classical physics

problems and real world devices spanning

plasma discharges, ion thrusters, satellite

charging, radar antennas, vacuum

electronics, photonic devices, or particle

accelerator components.

For more i ion, view tutorials.

Open Recent Copy Recent

o Welcome: MO SIMULATION Open a new simulation by choosing Mew From Example in the File menu or double-clicking item in Recent list, Show Log

Fig. 4.6: View Log

This is useful if you run into problems and need help from the Tech-X Support team. It is a good idea to Save to file
and send a copy of your log along with your message if you ever need assistance. See Fig. 4.7.

4.4 Help Menu

The Help menu contains both the VSim Documentation set located under the Help Contents as well as information
About VSim. See Fig. 4.8.

Selecting Help Contents is the same as selecting the Help icon in the left hand icon panel, and it opens the Help
Window.

Note: It is possible to detach the documentation set from VSimComposer so that you can simultaneuosly view the
documentation as well as your simulation. To do this, click on the small icon on the upper right that looks like a box
inside of a box, as shown in Help Window. See Fig. 4.9.

Selecting About VSim will bring up a pop-up menu that tells you information about the particular build of VSimCom-
poser you have installed on your machine. It is very helpful to provide this information to Tech-X support personnel
if you encounter any difficulties running VSim.

4.3. View Menu 21
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VSim - Electromagnetic Plane Wave - m} x
File Edit Tools View Help

e

\ @ simulation Setup is Ready |Save and Setup
emPlaneWave.sdf  emPlaneWave.pre  emPlaneWave.in
Welcome
Simulation 2 %02 (2ph) Properties | |View Solids v | |SelectSoid v +z v || ResetPosition
* Description =
[#] Constants 8
Satup [#] Parameters
| Basic Settings &
‘nq Functions |
[ SpaceTimeFunctions a
e | Materials
G) [#] Geometries
N [*] Grids
- [#] Field Dynamics
Histories
-
Remove Add
Visualize
Property Value
?
Help

Processing impart: histories from 'C:\Program Files\Tech-X (Wing4)\vsim-3.0\Contents\engine pin\), . \share\macros', ~| Leglevel
Processing import: stfunes from 'C:\Program Files\Tech-X (Win64) Sim-3.0\Contents\engine \bin\. \share nacros'.
Processing impart: emfilters from 'C:\Program Files{Tech-X (Win64)\VSim-8, 0\Contents\engine \bin\\, . \share \macros'. info e
Lines from ‘C:\Users\jcolins\Pocuments\becorp\VSim3. 0\simulations \emPlaneWave. pre’ processed.
Finished with ‘C: \Users jeolins\Documents\txcorp\VSim3. 0\simulations\emPianeliave. pre'.
Clear

Process Python took 1250ms to execute. (SUCCESS)
Preprocessing completed successfully.
To run, dick on the Run button in the Run panel, v || Save ToFile
) setup: COMPLETED Click run to continue Hide Log

Fig. 4.7: Viewing the log contents from the view menu
VSim - Electromagnetic Plane Wave - O X

File Edit Tools View Help

Help Contents

About VSim9
2
x S A
Recent Simulations
Welcome!

emPlaneWave.sdf

VSim is a flexible, multiplatform, Particle-in- C:\Users)jcollins\Documents\tecorp\VSim@.0\simulations

& welcome

Cell simulation tool for running
computationally intensive plasma,
electromagnetic and electrostatic problems
Switch easily between 1, 2, or 3
dimensions. then watch your model run
lightning fast using algarithms designed for
the exacting demands of high performance
computing systems, whether on your laptop
or supercomputing cluster. With VSim, you
can start from our wide range of examples
both demonstrating classical physics
problems and real world devices spanning
plasma discharges, ion thrusters, satellite
charging, radar antennas, vacuum
electronics. photonic devices, or particle
accelerator components.

For more information, view tutorials...

: SIMULATION OPEN emPlanelave.sdf is aready open.

coaxialLoopAntenna.sdf

C\Users\jcollins\ Documentstbxcorp\VSim8.O\simulations
NewSimulationNametxt. pre
C:\Users\jcollins\Documents\txcorp\VSim3 Osimulations
NewSimulationName. pre

C:\Users\jcollins\ Documents\txcorp\VSimg.O\simulations
SimulationName,pr
Ci\Users\jcollins\Documents\brcorp\VSim3.O\simulations

———

Show Log

Fig. 4.8: Accessing help through the help menu
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VSim - Electromagnetic Plane Wave - O X
File Edit Tools View Help

Help Browser

Q 9 = @ Open External Window
~
VSim Documentation 9.0.0dev-r2012  TechX  Index Documents Current Topic +
Next topic . .
B VSim Documentation
The VSim Documentation comes in 5 manuals.
Contents . . ,
VSim Installation: System requirements, instaling the software on your machine, release notes, and licensing.
VSim Installation VSim User Guide: Basics of creating and running a simulation, and how to analyze and visualze the output.
VSim User Guide VSim Examples: Detaied walkthrough of a range of smulations.
VSim Examples VSim Customization: How to write macros to make input file writing easier, and how to write special analyzers for your data.
VSim Customization VSim Reference Manual: describes every input variable and panel, provides an API-evel discussion of every analyzer and macro, describes
VSim Reference every input block.
¢ VSim Installation
'Sim Introduction
'Sim System Requirements
o Menus and Menu Items
@® Copyright 2012-2018, Tech-X Corporation. Back to top
v
Show Leg

Fig. 4.9: Help Window

4.5 Tools/VSimComposer Menu (Settings/Preferences)

On Windows / Linux

The Tools menu provides access to global settings for VSimComposer. The Tools menu contains the
Settings selection.

Select Settings from the Tools menu to access the Application Settings window. See Fig. 4.10.
On Mac

The VSimComposer menu provides access to global settings for VSimComposer. The VSimComposer
menu contains the Preferences selection.

Select Preferences from the VSimComposer menu to access the Application Settings window. See Fig.
4.11.

4.5.1 General

General application settings set the default behavior for the VSimComposer file, directory, and other actions. See Fig.
4.12.

* When starting run on a simulation with existing data, the default setting that VSimComposer will use when
starting a simulation that already contains data is Ask before deleting existing data. If you know that you will
always want to create fresh data for each run, use the pulldown menu to set the default to Always delete existing
data. If you know that you will always want to run on the data already available, use the pulldown menu to set
the default to Never delete existing data. See Fig. 4.13.

* When opening a simulation when another simulation is already opened, the default setting that VSimComposer
will use is Ask before saving files and command line options of existing setup. If you know that you will always
want to save the simulation, this can be switched to Always save files and command line options of existing
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VSim User Guide, Release 9.0.2-r2448

W vsim - O X
File Edit Tools Vie Help

3
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Welca

VSim is
Cell simu|
computat]
electrom:
Switch e
dimensiol
lightning
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computin{
or superc|
can start
both dem|
prablems
plasma d
charging,
electroni
accelerat

/Sim

Host Settings
Editor

Application Settings 7 X
General

Visualization Options

License Settings Ask before saving files and command ine options of existing setp +

When starting run on a simulation with existing data. .. Ask before deleting existing data +

When opering a simulation when another simulation is already opened...

OK C: |
[ o | conr o

& welcome: NO SIMULATION Open a new simulation by choasing New From Exampie in the File menu or double~cicking item in Recent list. Show Log

% VSimComposer

File Edit

Fig. 4.10: Select Settings from the Tools menu

View Help (D 04:43:49 |
VRV
[ JoN ] V Application Settings
[
\’ Host Settings ‘When opening application, ask about adding license...  Ask about license on startup B
Editor

Visualization Options
License Setiings

When starting run on a simulation with existing data... | Ask before deleting existing data [

When opening a simulation when another simulation is already opened...

Ask before saving files and command line options of existing setup

For more information, view tutorials...

Fig. 4.11: Select Preferences from the VSimComposer menu
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Application Settings ? x
oo : When starting run on a simulation with existing data... Ask before deleting existing data ~
Host Settings
Editor When opening a simulation when another simulation is already opened...

Visualization Options

X . Ask before saving files and command line options of existing setup ~
License Settings

< >
| oK | Cancel Apply
Fig. 4.12: General Application Settings
Application Settings ? x
General . When starting run on a simulation with existing data... Ask before deleting existing data ~
Host Settings Ask before deleting existing data
Editor When opening a simulation when another simulation is alread AlWaYs delete existing data

Never delete existing data
Ask before saving files and command line options of existing setup ~

Visualization Options
License Settings

| oK | Cancel Apply

Fig. 4.13: Application Setting When Starting Run on a Simulation with Existing Data
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setup. If you know that you will never want to save the simulation, this can be switched to Never save files and
command line options of existing setup.

4.5.2 Host Settings

The Host Settings section allows you to specify what machine to run on, the paths to your installation directory and
workspace directory, and your preferences for serial or parallel simulations.

By default, you will be running on your localhost machine with the default installation directory and a preferred run
method of serial.

General

Currently, VSim only allows for running simulations on the localhost. See Fig. 4.14.

\\/ Application Settings ? X
General Profiles General Paths MPI
Host Settings localhost
Editar multipole Profile Mame: localhost
Visualization Options| | vorpal User Mame: |gdegrand

License Settings Host Address: localhost

< > Add |  Remove

| oK | | Cancel Apply

Fig. 4.14: Application Settings Host General Control Menu

Paths

* Simulations directory is the default directory for your runs.
* Macros directory houses the macros to be used in your runs.
¢ Analyzers directory houses the analyzers to be used in your runs.

See Fig. 4.15.
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| Application Settings

General

Host Settings

Editor

Visualization Options
License Settings

Profiles

localhost
multipole
vorpal

Add | Remove

General

User Directories

Simulations Directory Default

Paths MPI

| C:\Users\gdegrand\Documents\txcorp\WSim8. 1\simulat... |

Macros Directory Default

| C:\Users\gdegrand\Documents\txcorp\WSim8.1\macros |

Analyzers Directory Default

| C:\Users\gdegrand\Documents\txcorp\WSim8.1\analyzers |

| oK | Cancel Apply

MPI

Fig. 4.15: Application Settings Host Paths Menu

¢ Preferred run method is the VSim serial engine (vorpalser) by default. If you have a multi-core system capable
of parallel processing and a license activation file that is good on multiple cores, you can set the default to
parallel instead of serial by clicking on the Preferred Run Method drop down menu and selecting parallel.

» Cores on machine shows the number of available cores for the current system that VSimComposer detects.

¢ Preferred number of cores is the field in which you may enter a new value and change the number of cores
that will run simulations. This is helpful when you would like to run simulations using fewer processors
than the number of cores for which your software is licensed, or perhaps want to try load balancing using
more processes than you have cores. When the value in the Preferred Number of Cores field is set to
something other than the last saved value, VSimComposer places an asterisk in front of the field label so
that you are aware that you have changed the value and may wish to save the new value.

* Host File is where you can specify a file that contains the host nodes that you want to run on. This is useful
if you have a large number of nodes, but need to run on a specific subset of them. For a description of how to
create a hostfile see Running Vorpal with mpiexec Using a Hostfile.

See Fig. 4.16.

4.5.3 Editor

The editor tab contains default settings for font size and a few other Sefup tab options. These are editable to the users

desired settings.

¢ Files with Fixed-width Font

4.5. Tools/VSimComposer Menu (Settings/Preferences)
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Application Settings ? x
General Profiles General Paths MPI
Host Settings localhost Preferred run method: Serial -
Editor i

) L B multipole Cores on machine: 8
Visualization Options| | varpal -
License Settings Preferred number of cores: |4 =

Host File: |

< > Add |  Remove

| oK | Cancel Apply

Fig. 4.16: Application Settings Host MPI Control Menu

— Extensions refers to the file extensions that will obtain the following font and text size.
— Font is where you can select the desired font.
— Size is where you choose the desired text size.
All Other Files
— Font is where you select the desired font.
— Size is where you choose the desired text size.
Tabstop Width is the number of spaces that are inserted when the tab key is pressed.

Color Style is where you select one of the choices for the color style of the text editor, including a white
background, medium colored background, and dark background, with varying font colors.

Open files in “Parameter” editor by default opens the file showing the editable parameters and an image overview
(if this box is checked). When unchecked, the file is opened in the full text input file view.

Use syntax highlighting, when checked, adds color to the text in the full input file view to help denote certain
parts of the file. When unchecked, the text is all black.

Show line numbers, if checked, shows the line numbers on the full text input file view. When unchecked, they
are not.

Highlight current line highlights the line where your cursor lies. If this box is unchecked, the line is not high-
lighted.

Show post-processed file shows the post-processed .in file in a separate tab. This file shows the full text input
file after it has gone through any Python calculations. When this option is unchecked, this file is not visible.
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* Word wrap makes the text of the input file wrap at the end of the line. When this box is unchecked, the text will
not be wrapped.

See Fig. 4.17.

Application Settings ? x

General Files with Fixed-width Font
Host Settings

Editor
Visualization Options

License Settings Size

All Other Files

Extensions |py pre in |

Font | Courier New -

Font |Verdana h
Tabstop Width

Color Style Basic M
Open files in "Parameter” editor by default

Use syntax highlighting

Show line numbers

Highlight current line

Show post-processed file

Waord wrap

| oK | Cancel Apply

Fig. 4.17: Editor Menu

4.5.4 Visualization Options

The visualization options tab allows the user control over default settings of the Visualize window in VSimComposer.
¢ Manual font sizing allows you to control the size of the fonts of plots.

 Enable Vislt context menu enables you to right-click on a visualization and open Vislt itself, where the user can
access every function and feature of Vislt. It also enables the embedded point and line tools in Vislt as well as
some of the generic view controls.

 Try harder to load cycles and times determines how aggressive Vislt is when opening dataset. When this option
is checked (ON), Vislt will open every single dataset looking for time and cycle information. When this option
is unchecked (OFF), Vislt will only look at the first file in a series. The advantage of having this option OFF is
that datasets with lots of files are opened more quickly and with less memory usage. The disadvantage of having
this option OFF is that the dump slider will not display any time or cycle information— only the dump number.

¢ Default ColorTable is the default color table used for plotting color plots.
See Fig. 4.18.

For more information on Vislt, please see: https://wci.llnl.gov/codes/visit/ and http://www.visitusers.org/index.php?
title=VisIt_Wiki.
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Fig. 4.18: Visualization Menu

4.5.5 License Settings

It is possible to review your license activation file and install a new license activation file if an upgrade or additional
packages are purchased. To see the contents of the license activation file, click on the Details button. To install a new
license activation file, click on the Add button. In the resulting file window, navigate to the previously-saved license
file and then click the Open button. At this point, VSimComposer should import the license activation file and it will
appear as the active license in the list of license files. See Fig. 4.19.
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Fig. 4.19: License Activation File Menu
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CHAPTER
FIVE

SIMULATION CONCEPTS

5.1 Simulation Concepts Introduction

VSim allows one to compute the dynamics of a system that has electromagnetic fields, particles, and material shapes
that are advanced dynamically a time step at a time. A VSim simulation can contain some or all of the objects,
with them interacting in various ways. In addition, the particles can be represented by macroparticles, which clump
physical particles together so that one need not follow every individual physical particle, or by fluid fields.

The fields are defined on a structured grid in either cartesian or cylindrical coordinates. One can study just field
dynamics, e.g., the propagation of electromagnetic fields on a grid, or solving for electrostatic fields for given boundary
conditions and charge density, or fluid dynamics.

Material shapes, geometries, modify the dynamics of fields. For example, a conducting shape introduces an irregular
region where the electric field vanishes. Consequently electromagnetic fields will scatter off of such a shape, and in
electrostatics, such a shape will become an equipotential. Dielectrics shapes will modify the electric and magnetic.

Particles can be represented by macroparticles or a fluid. The particles interact with electromagnetic fields by interpo-
lating the fields from the grid to the particle position. The particles then move for a given time step and deposit their
contributions to the current and charge fields. This is the basic Particle-In-cell (aka PIC) algorithm.

Additionally, particles may interact with shapes. A shape can emit particles, absorb particles, or reflect particles.
When one particle hits the surface, it may cause the emission of another particle, of the same or different kind. This
can be secondary emission (the subsequent emission of an electron) or sputtering (the subsequent emission of a neutral
atom).

Additionally, particles may interact with other particles through collisions. This is done through the Direct Simula-
tion Monte Carlo (DSMC) method, which computes the effects of the collisions with each cell. Collisions may be
elastic, where only momentum and energy are exchanged, or they may be inelastic, where kinetic energy is lost due
to ionization or excitation of one of the particles. As well, particles may be created through field ionization, another
sub-time-step process where the local strong electric field causes an atom to separate into an ion and an electron.

To bring the power of many CPUs to simulation, VSim makes use of distributed memory (MPI) parallelism. In this
method, the simulation region is divided into domains (domain decomposition), with each process containing both
its domain plus some grid cells beyond. The addition grid cells are known as guard cells. They are used in the
communication between processes. Additionally they are used as the locations of particle sinks. Particles that leave a
simulation must be removed or reflected back into the simulation to prevent crashes caused by out-of-range accesses
of memory.

Simulation results are analyzed by looking at the generated data. In the regular course of a simulation, the simulation
data is periodically dumped. As well, VSim allows the definition of Histories, which are time sequences of data.
Examples include the Poynting flux through a surface or the number of particles absorbed by a shape.

In this section, we will begin by going over simulation concepts and properties, including:

¢ Grids
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— Decomposition and guard cells
— Periodic boundary conditions
* Geometries

¢ Fields

Electromagnetic fields

Electrostatic fields

Planar boundary conditions

Conformal boundaries

* Particles
— Macroparticles
+ Particle-in-cell simulation
+ Particle sources
* Particle sinks
— Fluids
¢ Reactions

¢ Histories

5.2 Grids

The grids used by VSim are structured, coordinate aligned, where the grid lines are along coordinate directions. Such
a two-dimensional grid is shown in Fig. 5.1. One can choose either a uniform spacing or a non-uniform spacing as
shown in Fig. 5.1, and the coordinates may be either cartesian or cylindrical. In Fig. 5.1, each of the cells is numbered
by its indices. In this 2D case, there are two indices; in general one for each direction. The cell indices start at 0 and
end in the x direction at N X — 1 for a grid that has N X cells in the x direction. For a 3D grid, there would be another
direction out of the page.

A cell of a 3D grid is shown with z coming out of the page in two views in Fig. 5.2. A cell owns its interior plus the
interior of its lower face in each direction plus, the interior of its lower edge in each direction, plus the lower node of
its owned edges. The owned node is circled in both views of Fig. 5.2. The owned edges are shown on the left side of
Fig. 5.2, with the x-edge red, the y-edge green, and the z-edge blue. Similarly, the owned faces of a cell are shown on
the right side of Fig. 5.2, with the x-normal face red, the y-normal face green, and the z-normal face blue.

In FDTD EM, the concept of a dual grid is useful. The dual grid is the grid with nodes at the centers of the regular
grid. The edges of the dual grid pierce the faces of the regular grid and vice-versa.

5.2.1 Guard cells

Guard cells, cells just outside the simulation grid, are needed for having sufficient field values in the simulation region,
for particle boundary conditions, and for parallel communication (to be dicussed later). An example of the first case is
where a field must be know at each of the nodes of the simulation. Then, since the last node in any direction is owned
by the cell one beyond the simulation, the cells one beyond the physical grid must be in the simulation. Thus, the grid
must be extended by one cell in the last of each direction, as shown in Fig. 5.3.
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Fig. 5.2: 3D cell in a view showing its edges and a view showing its faces.

ONY-1 NX-1,NY-1
0,1 11
0,0 1,0 NX-1,0
Fig. 5.1: Structured 2D grid.
y
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5.2. Grids
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Fig. 5.3: Grid extended to include the upper nodes, which belong to the cells one past the last cell in each direction.

Note: The user-defined grid is called the physical domain. The grid extended by Vorpal is called the extended domain.

For particle boundary conditions, the grid must be further extended down by one cell in each direction. When a particle
leaves the physical domain, it can end up in one of these additional cells, which can be either above or below. A data
value associated with that cell determines what to do with the particle, e.g., absorb it (remove it), reflect it, or carry
out some other process. The associated extended grid is shown in Fig. 5.4. The physical cells are depicted by the red
grid. The associated dimensions are in blue. The extended cells (shown in green) enclose both the physical cells and
the guard cells added by Vorpal.

5.2.2 Periodic Boundary Conditions

Periodic boundary conditions can be used to control both field and particle behavior at the edge of the simulation
domain. In the case of particles, periodic boundaries ensure that particles leaving one side of the domain reappear at
the opposite side. For example, particles traveling at a speed of —vy4 will go through ¢ = 0 and reappear at ¢p = 2.
Fields, on the other hand, will be copied from the plane at index O to the plane at N X and from the plane at N.X — 1
to the plane at —1, i.e. from the last physical cell to the guard cell on the other side.

5.2.3 Parallelism and Decomposition

Parallel (distributed memory, MPI) computation is carried out by domain decomposition. A particular decomposition
is shown in Fig. 5.5. In this case, this is a decomposition of a rectangular region by the red lines, with the individual
subdomains each give a unique index. However, Vorpal can simulate any region that is a non-overlapping collection
of rectangles (appropriately generalized for 3D and 1D), with each rectangle being a subdomain of the decomposition.
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Fig. 5.5: Parallel decomposition of a computational domain.
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For the most part, parallelism and decomposition are handled under the hood, but it is useful to understand a few
concepts. In Fig. 5.5 one can see a green rectangle that extends one cell more into the simulation region beyond
Domain 2. Fields in the cells of this overlap region are computed by the subdomain holding the cell, but they have to
be communicated to Domain 2, as it needs this boundary region to update its fields on the next time step. On the other
hand, particles may leave Domain 2 and end up in one of the cells still inside the green rectangle. Those particles must
be sent to the processor holding the cell they are in for further computation.

For the above situation to work, the field update method for a given cell must not need information more than one cell
away. The standard updates for electromagnetics and fluids indeed have this property. As well, the particles must not
travel more than one cell in a time step. This is true for explicit electromagnetic PIC with relativistic particles, as the
Courant condition prevents the time step from being larger than the time it takes for light to cross any cell dimension,
and relativistic particles travel slower than the speed of light. Finally, the particles must not interpolate from fields
more than one cell cell away, nor must they deposit current more than one cell away. This is true for the simplest
interpolation and deposition methods.

However, if you have electrostatic particles that travel more than one cell per timestep, or particles that have a larger
deposition footprint, then manual setting of some parameters may be necessary. In particular, the grid parameter,
maxCellXings, states the maximum number of cells a particle might cross in a simulation, and the parameter,
maxIntDepHalfWidth, provides the width of the deposition stencil. From these follow the overlap needed for
the subdomains. These parameters are discussed in more detail later.

5.3 Geometries

Geometries in Vorpal are non-grid-aligned material shapes. They can be defined in a number of ways, e.g., a triangular
surface mesh from an STL file, a set of shape from a STEP file, Constructive Solid Geometry (CSG), and functional
(a function defining whether a point in space is inside or outside). In visual setup, the material assigned to the shape
determines how the electromagnetic field interacts with the shape.

Visual Setup supports STL import with translation, STEP import, and CSG. One can then assign a material to the
shape. CSG is discussed in the Visual Setup section, where you learn to build primitives and perform operations on
them.

In text setup, you can still use CSG primitives, but the process is a little different. Rather than being able to simply
click and add primitives, text-setup requires one to import the appropriate geomet ries macro and define primitives
using built-in functions. This all will be covered in detail in the Geometries page of the following Text-based (.pre)
Input File Structure section. Also covered in this section are the procedures for importing CAD and Python-defined
geometries, moving and rotating shapes, and building custom primitives for your simulation.

One can also use geometries in particle boundary conditions. Particles can be emitted, reflected, or absorbed by a
geometry. Additionally, an absorber on a geometry can be attached to a secondary emitter or a sputterer as a source
for the same or another kind or particle.

5.4 Electric and Magnetic Fields

The electric and magnetic fields are the most important fields in VSim, as they impact the motion of charged particles.
In this section we discuss how fields generally work, then we discuss the field update concept. We then discuss the
particulars of the updates for each of electromagnetics and electrostatics.

5.4.1 Field Basics

The general concept of a field is a scalar, vector, or tensor that is a function of space and time. It is most commonly
implemented in VSim by values on a grid, i.e, a value for each cell. For finite difference methods, the different
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components (e.g., vector components) have a location, i.e., place where they most accurately represent the field value,
within each cell. For a scalar field, like the electrostatic potential, the location is either at the node (lower corner) or
the cell center. For a vector field, the natural locations are either at the centers of the edges or at the centers of the
faces. Hence, a field in VSim has a property, of £ set, that determines this offset.

Fields can be messaged as needed and described in Parallelism and Decomposition. In VSim, fields are messaged
according to their overlap, and they are always messaged both up and down.

Some fields are used for deposition of charge and/or current. These deposition fields come with a few changes. First,
they are automatically zeroed at the beginning of each time step. Second, to get the charge and current correct in a
parallel simulation, the contributions in the guard cells on one domain have to be sent to the owning domain and be
added into the charge or current on that domain.

5.4.2 Field Updating Basics

Fields can be either static or dynamic. E.g., the magnetic field in an electrostatic simulation does not evolve. It is
set once, and that field is used throughout the simulation. On the other hand, the electric field in an electromagnetic
or electrostatic simulation changes at each time step, and the magnetic field in an electromagnetic simulation also
changes at each time step. In addition, a field may be made up of a static part and a dynamic part, in which case the
two are added together to get the total field at each time step.

The update of a field can be either explicit or implicit. Explicit means that one can write the new field at a given cell in
terms of the old field values. Implicit means that one must solve an equation for the new field values. An example of
the latter, to be discussed in more detail. In either case, one is updating the field, and the object that does this is known
as an updater.

5.4.3 Electromagnetics

In electromagnetic simulations the electric and magnetic fields obey Maxwell’s equations, i.e., Ampere,

dE 1 - 1 .
— =-—J+5VxB
C

and Faraday.

dB

dt

These are discretized and updated using the Yee algorithm [Yee66]. In that algorithm staggered grids are used, which
is equivalent to saying that the electric field is an edge field, and the magnetic field is a face field, following Grids. The
Yee algorithm can be thought of as using the integral formulation of Maxwell’s equations on the faces of the grid (for
B) and the faces of the dual grid (for E). The corresponding updaters are the YeeAmpere andthe YeeFaraday
updaters. The update for pure EM is staggered in time, as in leap-frog integration.

= -VxE.

The update region is over the interior of the simulation. This varies for different components of the electric field and
is illustrated in Fig. 5.6. The electric field in the x direction, shown in red, lies on x edges. The interior x edges have
lower-left cell of (0,1) and upper-right cell of (NX-1,NY-1). In Vorpal, the region is greater than or equal to the lower
bounds and less than (not equal to) the upper bounds. Hence, the update slab for E, is [(0,1),(NX,NY)]. By similar
reasoning, now referring to the green arrows, the update slab for £, is [(1,0),(NX,NY)].

For the magnetic fields, there is a similar difference in the update region per component. The magnetic fields are face
fields, and so they are updated on any face that is in the interior or on a boundary.

When dielectrics are present, Maxwell’s equations need to be modified. Ampere’s equation gives the new value of
the displacement, D, from which one obtains the new value of the electric field, £ by multiplication by an effective
inverse dielectric tensor. Accurate algorithms for the time domain are described in [WBCI3][WCO07], while a more
rigorous, but frequency domain algorithm is described in [BWCI11].
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Fig. 5.6: Update region for the electric field.

Electromagnetic Slab Boundary Conditions

Beyond the edges of the simulation, values of the electric field are not known. Hence, one cannot update the electric
field at the edge, as that would require a difference with an unknown value. Instead one sets boundary conditions. For
the simple case of a purely rectangular region, the boundaries that must be set are shown in Fig. 5.7.

They are simply the tangential values of the electric field on the boundary. Just as in continuum EM, one need not set
boundary conditions on the magnetic field. Setting the values of the tangent electric field at boundaries is sufficient.

Electromagnetic Conformal Boundary Conditions

Electromagnetic boundary conditions are to some degree setting the value of the electric field, but they can also involve
a modification of how the magnetic field is updated.

In Fig. 5.8 is shown a curve the interior (lower and left) of which is vacuum, while outside is Perfect Electric Conductor
(PEC). All electric fields on edges that are totally in the PEC are set to zero. Then there are two approximations. In
the stair-step approximation, one additionally sets to zero all electric fields whose edges are more than half outside.
In the Dey-Mittra [DM97] algorithm, one starts by keeping any electric field on an edge even partially outside of the
PEC. One then updates the magnetic field by using a line integral around the cell to get the change in magnetic flux,
and then dividing that by that by the area of the part of the cell outside of the PEC. For the cell marked DM in Fig.
5.8, this would consist of adding up the marked electric fields (two in the x-direction and one in the y-diretion) with
appropriate signs. Because of the area divisor, the Dey-Mittra algorithm can be unstable for time steps smaller than
the uniform-grid CFL time step limit, and the smaller the area of the cell, the more the time step is limited. In practice,
one sets an amount of acceptable reduction of the time step, and then one can compute the fractional cell areas that
must be dropped [NCW+09].
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Fig. 5.7: Slab boundary regions for the electric field.

5.4.4 Electrostatics

Electrostatics refers to finding the fields by a different mechanism. The electric and magnetic fields are still present.
However, the magnetic field is static and imported, while the electric field at each time step is found by first solving
for the potential, which satisfies Poisson’s equation,

=V e(Vo) =p,
and then finding the electric field from
E=-v¢,

which becomes finite differencing in numerics. Because we cannot directly state the solution for the potential, ¢, but
instead we have to solve for the potential, this is an implicit update.

Electrostatic Slab Boundary Conditions

Poisson’s equation, upon discretization connects 2*D+1 grid nodes, as shown by the nodes within the curve in Con-
formal boundaries for the electric field.. Because this stencil reaches to each side of the node, it cannot be applied to
edge nodes (covered by open circles). On those grids one must apply boundary conditions. For Dirichlet boundary
conditions, one specifies the value of the potential on that node.

For Neumann boundary conditions, one specifies the value for the difference between the value of the potential on a
node and the value on the node just interior. In general one must take care not to specify a mathematically impossible
situation. As applied to Neumann boundary conditions, one cannot, e.g., specify zero Neumann boundary conditions
on all surfaces while having non-zero net charge in the interior, as that would violated Gauss’s law. Similary, if one
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Fig. 5.8: Conformal boundaries for the electric field.
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has a simulation that is periodic in all directions, consitency requires that it contain no net charge. Further, the matrix
is singular unless one sets the value of the potential on at least one node.

Electrostatic Conformal Boundary Conditions

As this is an extensive subject, we simply say that for the nodes interior to a surface of constant potential, one specifies
that the potential on that node, rather than being related to nearby points, is simply given. Otherwise one constructs
the matrix as before.

Solving Poisson’s equation

Upon discretization and applying all boundary conditions, numerically one is left with a large matrix equation to be
solved. There are multiple ways to do this within VSim, with direct or iterative solvers. This is discussed in more
detail in Selecting Solvers and Solver Parameters.

5.5 Particles

Particles can be represented by macroparticles or a fluid. Macroparticles should be used when there is a need to capture
kinetic effects. They also have more features in VSim.

5.5.1 Macroparticles

Macroparticles allow one to model kinetics (velocity distributions) for physical particles. Macroparticles are comprised
of a certain number of physical particles. The number of physical particles to represent in a single macroparticle is
determined by factors such as the physical particle density, volume of a grid cell, and the number of macroparticles in
a simulation grid cell. Macroparticles, if used so that there is accurate resolution, produce the same result as would
simulating all individual physical particles, but with significantly higher computational speed. We will elaborate more
on macroparticle definition and effects on simulation resolution in later sections. For macroparticles there are a number
of options for particle loading and emitting from sources, as well as various types of particle sinks available.

There exist over 70 variations in particle type and evaluation, including:
* Boris (Relativistic, Non-relativistic, Tagged, Weighted)
* Electrostatic
* Cylindrical species

For more information on particle species and some of these other algorithms, please visit the Species section of VSim
Reference.

Species and their kinds

A common term in VSim for macroparticle is Species, as that is the type of block that defines a set of macroparticles
VSim allows you to specify a species kind, determined by the particle type (relativistic, electrostatic, etc.). Within
these kinds are options for particles (i.e hydrogen, helium, argon, xenon, etc.) whose charge, mass, cross-section, and
other relevant data sets are built into VSim. Alternatively, you can import your own species data in VSim for more
custom simulations, so long as the necessary particle information is successfully imported to VSim.

Please visit the section Species Kinds in VSim Reference for all kind options and further details, as well as information
on importing your own particle data.
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Particle Sources

VSim allows for the implementation of both primary and secondary particle sources, where “primary” refers to initial
particles that are introduced into the system, and “secondary” to particles that are created by interactions between
these primary particles and either other particles or metal surfaces in the simulation.

Particle “loading” refers to the placement of particles volumetrically in a vacuum, whereas particle “emitting” is the
ejection of particles from the surface of a metal.

One can load particles over time in one of the following ways:
* Load all at once. This method is required in electromagnetics simulations for charge conservation.
* Load over about ~1000 time steps
* Load in some custom way using your own external files (.txt files in hdf5 format)

Particle sources in 2D ZR cylindrical coordinates require extra precautions, as the loading algorithm will want to
distribute particles uniformly in both directions without accounting for the larger volume/area at large radii that occurs
in this coordinate system. To learn how to compensate for this phenomenon, please visit Working with Particles in
Cylindrical Coordinates in VSim Reference.

Particle Sinks
Particle sinks, on the other hand, generally remove particles from a simulation or from a region therein. There are two
basic types of sinks, with many more types of physical sinks available for use in your simulations.

¢ Messaging sinks Automatically established by Vorpal, they are used to communicate particles between proces-
sors in parallel runs, enforce periodic boundary conditions, etc.

 Physical sinks Physical sinks can remove particles from a region of the simulation, absorb incident particles
on a boundary, or even perform more specialized tasks.

Particle sinks typically involve at least upper and lower bounds, and at the most basic level must enclose the entirety
of the simulation space that contains particles. If this is not the case and your particles try to travel into regions not
included in the simulation grid, Vorpal will likely crash. In the case of periodic boundary conditions, particles “wrap
around” from one side of the simulation to the other.

5.5.2 Fluids

Particles can also be represented by fluids. The fluid representation is valid in the limits when the pressure is known.
The two cases where this is valid are cold fluids, where the pressure vanishes, and at high collisionality, so that the
pressure can be obtained from an equation of state (EOS), such as the adiabatic EOS. The available fluid kinds

e Cold fluid
e Euler fluid
¢ Neutral Gas

Only the most basic fluid dynamics is supported. There are no conformal boundary conditions nor any internal bound-
ary conditions of any kinds.

5.6 Reactions

Reactions are bulk processes that occur on time scales much shorter than the time step of the simulation. As an
example, collisions between atoms or electrons and atoms occur on times of the atomic unit time, 2.4 x 10~!7 s, while
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even in laser-plasma interactions, the laser period is typically of order 3 x 10~!® s. Hence, even on within a time step
with the shortest time scales modeled by PIC methods, a collision can be considered an instantaneous process. This is
better for plasma discharges that evolve on ms time scales or microwave devices for which the time scale is ns.

The reactions that VSim contains are
* Particle-Particle Collisions
* Particle-Fluid Collisions
* Three-Body Reactions
* Field-Ionization Processes

e Decay Processes

5.6.1 Reactions Implementation

Decay processes are relatively easy, as they involve only a single particle at a time. For particle-particle collisions,
VSim uses Direct Simulation Monte Carlo methods, in which one computes the collisions between the pairs within
each cell. Three-body reactions are primarily useful for recombination. Finally, field ionization is the creation of an
electron-ion pair from a neutral atom in a strong electric field.

Direct Simulation Monte Carlo takes into account that random interactions between particles occur with non-negligible
probability only when the particles are in close proximity. To avoid checking the N? distances between N interacting
macroparticles, the VSim MonteCarlolInteractions package limits interactions to those between macroparticles within
the same cell. This reduces the number of possible interactions to

Neents(Nppe)?
where N5 is the number of cells in the simulation and Ny, is the number of particles per cell. Hence,
N = NppeNeeris
and
N? = (NCE“IIS)Q(JVIJPC)2 > NceIIS(NppC)2

VSim has three reaction frameworks frameworks. The original reduced reaction framework had only a limited number
of reactions. the monte carlo framework has a larger set of reactions. The reactions framework is now preferred, as it
has an even larger set of reactions as well as using the No-Time-Counter method for algorithmic speedup.

5.6.2 Resolution Issues with Reactions

In order to accurately model the desired physics, one must resolve the physical distributions of the interacting particles
and the temporal evolution of the distributions. For sufficient spatial resolution the number of macroparticles in the
simulation must be large enough to smoothly resolve the spatial distributions of the species.

As for temporal resolution, each Monte Carlo interaction has an intrinsic time scale set by the physics of the interaction
itself. In other words, the probability for an interaction event to occur can be written as P = dt/T;, where dt is the
simulation time step and 7; is the natural time scale associated with the interaction itself.

The fundamental probability for an interaction event to occur between two macroparticles in a given cell with volume
V in a time step dt is

. NlNQO'(’U)Udt

P
N,V
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where v is the relative velocity between the two macroparticles, N1 and N> are the numbers of physical particles per
macroparticles in the final-state species. This implies that the natural time scale associated with this numerical process
is:

N,V

T= o —
Ny Noo(v)v

If the simulation time step dt is not small enough to resolve the natural interaction time scale, then inaccurate statistics
will result.

The last issue of resolution comes from the need to accurately sample the velocity distributions of the interacting
particles. Since the probability for an interaction event to occur non-trivially depends on the particle velocities, and
since a single macroparticle samples only one point in velocity space, accurate statistics may only be achieved in some
simulations with many macroparticles per cell, such that the velocity distributions of the participating species are well
sampled within each cell.

5.7 Histories

A history is an array of data that is output at every time step. The type of history that you can include is dependent on
the type of simulation (i.e. particle, electrostatic, electromagnetic, etc.) that you are running.

You can incorporate a history in text-setup through one of two ways:
* Including a history by means of a History block
* Calling a macro that automatically generates history blocks for you based on a few select input parameters

More details and some example usage of these two methods will be provided later on in Text Setup. For further
information on history types and parameters as a whole, you can also visit the History section of the VSim Reference
Manual.
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CHAPTER
SIX

VISUAL SETUP

6.1 Setup Window for Visual-setup Simulations

After you open a new or example simulation that is not text-based, VSimComposer displays the Setup window con-
taining a Editor pane with a Simulation Elements Tree, a Property Editor, and a Geometry View to allow for easy
creation of your simulation. The icon panel remains available on the far left.

Note: A Navigation Pane can be shown by clicking and dragging on the vertical bar separating the Icon panel from
the Editor pane. See Fig. 6.1.
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Fig. 6.1: The Navigation Pane

The following sections will go through each of the components of the Setup window.

For in depth information on each of the properties and possible values outlined or described in the rest of the chapter,
please see VSim Reference: VSimComposer.
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The figure Visual based setup window illustrates the layout of the VSimComposer Setup window using labels for the
parts of the interface to which this introduction and the tutorials refer. See Fig. 6.2.
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Fig. 6.2: Visual based setup window

6.2 Navigation Pane and Simulation Files

The Navigation pane contains a list of Simulation Files.

To enable convenient viewing of the list of simulation files, VSimComposer allows you to specify in what order as
well as which type(s) of files you would like to view. Smart Grouping causes similar types of files to be displayed in
the same area of the Simulation Files tab list. Turning off Smart Grouping causes files to be displayed in alphabetical
order rather than by type. All Files indicates that you want to see all available files involved in the simulation. You
could choose to limit your view to only Simulation Files, which are files such as input files and macros that can be
edited in the VSimComposer Editor pane, or 7ext files, which include all types of human-readable file formats, or Data
files, which include incremental dump files and output files that can be visualized.

6.3 Elements Tree

You can navigate through the Elements Tree using either your mouse, or your keyboard arrows. The up and down
arrows will scroll up and down through the list of elements, while the right and left arrows will respectively expand
and collapse the elements. To double click, press F2.

Highlighting a particular element in the tree will cause the Property Editor to update with Property/Value pairs that
can be edited.
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6.3.1 Description

The Description element holds basic user-supplied text information about the simulation.

6.3.2 Constants

The Constants element contains a set of pre-defined physical constants that can be used in other elements of the
simulation. You may also define your own by highlighting Constants and either clicking the Add button at the lower
right of the Elements Tree or right-clicking and selecting Add Constant —> User Defined.

The name of the user-defined Constant can be modified by double clicking on the element in the Elements Tree and
typing in a new name.

Note: A constant name can contain only alphanumeric characters and underscore and must start with a letter. Our
convention is to use ALL_CAPS for constants.

A value can be given to the user defined Constant by double clicking on the value in the Property Editor. See Fig. 6.3.
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Fig. 6.3: Constant definitions

6.3.3 Parameters
The Parameters element is a location for evaluated, user-defined, variables that can be used in other elements of the
simulation.

You can add a parameter by highlighting Parameters and either clicking the Add button at the lower right of the
Elements Tree or right-clicking and selecting Add Parameter —> User Defined.
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The name of the user-defined Parameter can be modified by double clicking on the element in the Elements Tree and
typing in a new name.

Note: A parameter name can contain only alphanumeric characters and underscore and must start with a letter. Our
convention is to use ALL_CAPS for parameters.

An expression can be given to the user defined Parameter by double clicking on the expression value in the Property
Editor. You can use any of the Constants as well as any real number in the expression. See Fig. 6.4.

Note: If the expression is not valid, the parameter will appear in red in the Elements Tree.
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Fig. 6.4: Parameter definitions

6.3.4 Basic Settings

The Basic Settings element contains a group of property/value pairs that define the basic setup of the simulation.

Here you can find properties such as the type of field solve (electromagnetic or electrostatic), the dimensionality (3D,
2D, 1D), whether or not to include kinetic particles in the simulation, and the time step.

6.3.5 Functions

The Functions element is a location for writing user-defined functions that can be used in simplifying the definition of
a SpaceTimeFunction. The function can contain any number of arbitrary arguments and is not limited to the default
values of x and y.
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Note: A Function can be used to define another Function or a SpaceTimeFunction. Functions cannot be used
to define an expression in other elements nor can they be used to define parameters. Expressions are defined by
SpaceTimeFunctions.

To create your own function, highlight Function and either click the Add button at the lower right of the Elements Tree
or right-click and select Add Function —> User Defined.

The name of the user-defined Function can be modified by double clicking on the element in the Elements Tree and
typing in a new name.

Note: A function name can contain only alphanumeric characters and underscore and must start with a letter. Our
convention is to use lowerCamelCase for function names.

You can define the Function by double clicking on the expression value in the Property Editor. You can use any of
the Constants, Parameters, or Functions previously defined, as well as any real number or Python operator in the
expression. See Fig. 6.5.

U vsim - u} x
File Edit Tools View Help

A Simulation Needs Save And Setup. | Save and Setup|

*vsim.sdf

Simulation %%, (zr,phi) | Properties | |ViewSolids || select Solid v [ Toogeaxes | [perspectveview] +z v | ResetPositon

Description
[#] Constants

3D View

[=] Parameters
CHARGEMASSRATIO 8
Basic Settings £
[=] Functions 3
tumOnF0
SpaceTimeFunctions
Materials
[#] Geometries
[#] Grids
[#] Field Dynamics
Histories
Remove Add
Property Value

kind turn on
Function to turn on

A
HI70.5%(1 - cosiPI*t / T))*H(T...

A\ Setup: SIMULATION CHANGED Simulation setup has changed and needs saving Show Log

Fig. 6.5: Function definitions

6.3.6 SpaceTimeFunctions

The SpaceTimeFunctions element is a location for writing user-defined functions that specifically depend on the spatial
and temporal variables x, y, z, and t. A SpaceTimeFunction can be used in other elements of the simulation by
right clicking on the value and selecting the defined SpaceTimeFunction as shown in the figure SpaceTimeFunctions
definitions.
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To create your own function, highlight SpaceTimeFunction and either click the Add button at the lower right of the
Elements Tree or right-click and select Add SpaceTimeFunction —> User Defined.

The name of the user-defined SpaceTimeFunction can be modified by double clicking on the element in the Elements
Tree and typing in a new name.

Note: A SpaceTimeFunction name can contain only alphanumeric characters and underscore and must start with a
letter. Our convention is to use lowerCamelCase for SpaceTimeFunction names.

You can define the SpaceTimeFunction by double clicking on the expression value in the Property Editor. You can use
any of the Constants, Parameters, or Functions defined above, as well as any real number or Python operator in the
expression. See Fig. 6.6.
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Fig. 6.6: SpaceTimeFunctions definitions

6.3.7 Materials

The Materials element holds information about any materials used in the simulation. There are some Materials built
into VSim, and the user may import other desired materials.

To import a Material, either click the Add button at the lower right of the Elements Tree or right-click and select Import
Materials.

The Materials file must have the extension .vmat. You can specify your own materials file to import special materials
specific to your simulation. See Fig. 6.7.

Note: Tech-X has a standard materials file distributed with VSim. It is located in the data folder of your installation.
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Fig. 6.7: Importing materials

Once a material file has been imported into VSimComposer, you can add a specific material to your simulation by
highlighting the material of choice and clicking on the Add To Simulation button.

After a material is in the simulation, you can see it under the Materials element. The material properties can be
modified, if desired. The Materials can be assigned to a geometry in the material property in the Properties Editor
pane. See Fig. 6.8.

6.3.8 Geometries
The Geometries element contains information about any geometries that are in the simulation. You can import a file,
or create your own with CSG.

Expanding the Geometries sub-elements view will show the individual parts (if any) of the imported geometry, or CSG
built geometry.

To hide a specific part, uncheck the box next to it.

Note: Hiding a part of the geometry will not remove it from the simulation. VSim will use the full geometry defined
in the imported file.

For use in the simulation, a Geometries part MUST have a material assigned to it, other wise it is ignored (treated as
vacuum).

The material can be assigned to a geometry by double clicking on the material value in the Properties Editor.
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Fig. 6.8: Adding materials to the simulation.

Import a Pre-defined Geometry

To import a geometry into your simuation, highlight the Geometries element in the Elements Tree and click on the
Add —> Import Geometries button located at the bottom of the Elements Tree, or simply right click on the Geometries
element —> Import Geometries.

Here you can navigate to a supported file type and open the file. Supported filed types include:
* Step Files (.stp, .step, .p12)
» STereoLithography Files (.stl)
¢ Visualization Toolkit Files (.vtk)

* Polygon File Format (.ply)

Build Your Own Geometry

You can build your own geometry using Constructive Solid Geometry (CSG) to create a complex shape by combining
simple shapes using boolean operators.

To do this, highlight the CSG element and right click Add Primitive and select one of the pre-defined shapes. See Fig.
6.9.

After multiple CSG shapes have been added, you can either subtract, union, or intersect them with a boolean operation.
This will create a new Geometries element.

To do this, highlight a maximum of 2 shapes, right click, and select the boolean operation you want. See Fig. 6.10.

Note: The order of highlighting your shapes matters when doing the subtract boolean operation. The second shape
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Fig. 6.9: Constructive Solid Geometry (CSG)

will be subtracted from the first. The boolean operation menu will show the operation to be performed based on the
order of highlighting.

Note: If a shape is not part of a combined shape through a boolean operation, you can assign a material to it. Once a
shape has been combined with another shape, only the combined shape may be assigned a material.

6.3.9 Grids

The type of grid is determined in the Basic Settings element. Its parameters are determined in the Grid element.

By default, a uniform Cartesian grid is added to your simulation with dimensions of Im x Im x Im and cell numbers
of 3,4, and 5 in X, y, and z respectively.

To modify the type of grid, change the Basic Settings properties coordinate system, dimensionality, and grid spacing.
See Fig. 6.11.

The size of the domain can be set using the Min and Max properties of the Grid element. The number of cells in each
direction can also be specified. See Fig. 6.12.

Note: Only one grid may be added to any one simulation at a time.

Note: A grid can be resized to fit the bounds of a geometry by right clicking on the Grid element and choosing Resize
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Fig. 6.10: Constructive Solid Geometry (CSG) Boolean Operator
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Fig. 6.11: Grid choices
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Fig. 6.12: Grid settings

Grid. Resizing the grid puts in numbers. Any constants and parameters are lost.

6.3.10 Field Dynamics

The type of field solver is determined in the Basic Settings element. Its parameters are specified in the Field Dynamics
element.

Fields

Depending on the type of solver chosen, default fields will be initialized in the simulation. For an electrostatic sim-
ulation, default fields will be Phi, Charge Density and Electric Field. You can optionally add a Background Charge
Density field or External Field by clicking the Add —> Add Field button located at the bottom of the Elements Tree, or
simply right clicking on the Fields element —> Add Field.

An External Field is used for importing a Magnetic field in electrostatic simulations with particles.

For an electromagetic simulation, default fields will be Electric Field and Magnetic Field. You can optionally add a
Current Density field or External Field by clicking the Add —> Add Field button located at the bottom of the Elements
Tree, or simply right clicking on the Fields element — Add Field.

An External Field in electromagetic simulations can be a Magnetic, Electric, or Current field. External fields are used
to effect particle movements in simulations.
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Field Initial Conditions

An initial condition can be added to any field by clicking the Add —> Add FieldlnitialCondition button located at the
bottom of the Elements Tree, or simply right clicking on the particular Field element —> Add FieldlnitialCondition.
See Fig. 6.13.
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Fig. 6.13: Adding an initial condition to a field

Field Boundary Conditions

A boundary condition can be added to any field by clicking the Add —> Add FieldBoundaryCondition button located at
the bottom of the Elements Tree, or simply right clicking on the particular Field element —> Add FieldBoundaryCon-
dition.

Current Distributions
A current distribution can be added to any field by clicking the Add —> Add CurrentDistribution button located at the
bottom of the Elements Tree, or simply right clicking on the particular Field element —> Add CurrentDistribution.

A distributedCurrent is a volume current source where you can provide the min and max values in each direction. A
distributedCurrent will show up on the Geometry View. You can hide a distributedCurrent by unchecking the box next
to it. Hiding a current will not remove it from the simulation, it’ll just hide it from the geometry view. See Fig. 6.14.

Poisson Solver

The type of Poisson solve and any preconditioner can be set under the solver and preconditioner properties of the
Properties Editor.
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Fig. 6.14: A volume of current is shown in the smaller/interior box. The outer box is the grid.

Note: Changing the solver type may introduce more properties due to the context-sensitive nature of the input.

6.3.11 Particle Dynamics

The inclusion of Particle Dynamics is determined by the value of particles in the Basic Settings element. If particles
is set to no particles, then no particles are in the simulation and the Particle Dynamics element is hidden.

If particles is set to include particles then the Particle Dynamics element is shown and futher properties can be set.

The Particle Dynamics element holds information on any kinetic particles, background gases, and collisions in the
simulation.

KineticParticles

Electrons, charged particles, and neutral particles can be added to the KineticParticles element.

To add kinetic particles, click the Add —> KineticParticle button located at the bottom of the Elements Tree, or simply
right click on the KineticParticles element and select Add KineticParticle and then choose the type of particle you
want to include.

The properties of each kind of KineticParticle are modifiable in the Properties Editor pane.
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BackgroundGases

To add collisions between types of kinetic particles, click the Add —> Add BackgroundGas button located at the bottom
of the Elements Tree, or simply right click on the BackgroundGases element and select Add BackgroundGas.

A backgroundGas is a volume distribution where you can provide the min and max values in each direction. A
backgroundGas will show up on the Geometry View. You can hide a backgroundGas by unchecking the box next to
it. Hiding a the backgroundGas will not remove it from the simulation, just hide it from the geometry view. See Fig.
6.15.

[ vsims - ] X
File Edit Tools View Help
Editor

Simulation Needs Save And Setup. Save and Setup!

=veim.sdf

Simulation
lowerZBoundary
upperZBoundary
[ Field Dynamics
[ Particle Dynamics
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neutralParticles0

chargedParticles0
[= BackgroundGases
neutralGas0
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ionNeutralFluidCollisions0
electronNeutralFluidCollisions0
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Remove Add
Property Value
kind Neutral Backgrou.
gas temperature (K) 300.
gas kind H
=l volume cartesian 3d slab
*xMin
xMax 4
yMin 00
yMax 4
zMin -05
zMax 4

[=] initial gas density constant gas density
density 1.0

Fig. 6.15: A volume of gas is shown in the smaller/interior box. The outer box is the grid.

Collisions

There are three frameworks for setting up particle collisions available in VSim. The newest, most flexible, and fastest
is the Reactions framework. The Reactions framework supplants the Monte Carlo Interactions framework. The
Impact Collider (called “ReducedCollisions” in the Visual Setup) framework is the oldest framework, and is limited
to interactions between kinetic particles with a neutral background gas, but runs very quickly.

In the Visual Setup, only one framework can be used at a time.

Reactions

To include Reactions in the Visual Setup, first select the Basic Settings element of the setup tree and ensure that the
particles dropdown menu is set to “include particles” and the collisions framework dropdown is set to “reactions.”

With these settings selected, collisions can now be set up within the Particle Dynamics element of the setup tree.
The Reactions are organized between five options: Particle Particle Collisions, Particle Fluid Collisions, Three
Body Reactions, Field Ionization Processes, and Decay Processes. By highlighting one of these five options,
right clicking, and adding a collision process a user is setting a RxnProductGenerator’ (see :ref: VSim
Reference Manual: Text Setup: Reactions <rxn-rxnProductGenerator> for more infor-
mation on RxnProductGenerators).
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Note: The distinction between the Particle Particle Collisions and Particle Fluid Collisions is artificial in the visual
setup and is made for the convenience of the user.

After adding a collision process to the tree, the user then selects the reacting species, cross-sections/reaction rates, and
other reaction attributes. The species and fluids in the drop down menu for reactants and products are limited such
that only selections appropriate for the process are available. Charge and mass conservation is checked during the
translation from . sdf to . in. If there is a charge or mass violation, an error will be thrown.

If the drop-down menu used to set the interacting particle species is empty, make sure you've added the necessary
KineticParticle or BackgroundGas for the type of collision.

Reduced Collisions (Impact Collider)

To include Reduced Collisions in the Visual Setup, first select the Basic Settings element of the setup tree and ensure
that the particles dropdown menu is set to “include particles” and the collisions framework dropdown is set to “re-
duced”. With these settings selected, collisions can now be set up within the Particle Dynamics element of the setup
tree.

To add collisions between kinetic particles and a neutral background gas (fluid), click the Add —> Add ParticleFluid-
Collision button located at the bottom of the Elements Tree, or simply right click on the Collisions element and select
Add ParticleFluidCollision and choose whether either Electron Neutral Fluid Collision or lon Neutral Fluid Collision.
After making a selection, a new element will appear in the tree. Choose the particle species and the background gas
that will interact.

To add a specific collision process, highlight this new element and choose a specific collision process from the Add
CollisionProcess menu which will appear next to the mouse arrow. When a specific collision process is added, a new
element will appear. The cross-sections for the interaction process will be set in this element.

See Fig. 6.16 for an example of adding collisions to a simulation in the Visual Setup.

Monte Carlo Interactions

To include Monte Carlo Interactions in the Visual Setup, first select the Basic Settings element of the setup tree and
ensure that the particles dropdown menu is set to “include particles” and the collisions framework dropdown is set to
“monte carlo”.

With these settings selected, collisions can now be set up within the Particle Dynamics element of the setup tree.
The Monte Carlo are organized between five options: Particle Particle Collisions, Particle Fluid Collisions, Three
Body Reactions, Field Ionization Processes, and Decay Processes. The user can add a specific interaction process by
highlighting one of these five options, right clicking, and selecting a process from the Add CollisionType menu.

After adding a collision process to the tree, the user then selects the reacting species, cross-sections/reaction rates, and
other reaction attributes.

6.3.12 Histories

Histories are used to calculate and record data about fields and particles in a simulation.

ArrayHistory

An Array History will output an array of data for each time-step.
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Fig. 6.16: Collisions

Note: This type of history is not currently viewable in VSimComposer.

Possible Array Histories include:
* Far-Field Observation

¢ Particle Momentum

ComboHistory

Combo Histories are used to do operations on other histories. The operation is done at every time step and the resulting
values are recorded as a new history. The output will be a 1D array of the value vs time.

Possible Combo Histories include:

* Binary Combination History

FieldHistory
Field Histories record on a per time-step basis. Field histories are used to measure quantities such as the value or
energy of the field at a location. The output will be a 1D array of the value vs time.
Possible Field Histories include:
* Electric Field Energy
¢ EM Field Energy
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* Magnetic Field Energy
* Field at Position
* Poynting Vector

* Pseudo-potential

LogHistory

A Log History will record data on a per-event basis rather than at each time step. For instance, an Absorbed Particle
Log will record information about each and every particle that strikes a chosen absorbing surface. The output will be
a 1D array of the value.

Possible Log Histories include:

» Absorbed Particle Log

ParticleHistory

Farticle Histories record on a per time-step basis. Particle histories are used to measure quantities such as the total
number of particles in a simulation at each step, or the current absorbed at a chosen absorbing surface at each step.
The output will be a 1D array of the value vs time.

Possible Particle Histories include:
* Absorbed Particle Current
* Absorbed Particle Energy
* Emitted Current
* Number of Macroparticles
* Number of Physical Particles

e Particle Energy

6.3.13 Property Editor

The Property Editor allows for setting of specific properties under each of the Elements from the Elements Tree for
the simulation. Such properties might include sizes in the X, Y, and Z directions, the type of particles, and specifics of
a field solve.

The Property and Value inputs are context-sensitive. The availability of a particular property may depend on other
properties or selections of the Element Tree. For instance, changing the solver value in the PoissonSolver element
will bring up a new set of solver properties to be set. Refer to the figure Constructive Solid Geometry (CSG) Boolean
Operator (Fig. 6.10) to see the same principle with regard to geometry options.

6.3.14 Geometry View

The 3D View section can be used to view the simulation setup including the geometry, grid, and source.
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Buttons

* Properties
* View Solids
* Select Solid
» Toggle Axes
A toggle button to show or hide the axes.
* Perspective View
* Axis Drop-down Menu
Drop-down menu for choosing the axis from which the object is viewed.
* Reset Position

Pressing this button will reset the camera view to be along the axis selected in the drop-down menu.

Navigating

Navigation in 3D space is possible under keyboard and mouse control.
* Rotate

Holding down the right mouse button and dragging it will rotate the camera position around the object being
viewed.

¢ Pan

Holding down the left mouse button and the Shift key pans the view in a plane without rotating the viewed
object.

e Zoom

Using the mouse wheel, the view can be zoomed in or out. If the system does not have a mouse wheel, then
holding down the left mouse button and the Control key and moving the mouse up and down will also zoom in
and out.

6.3.15 Database View

The Database View is for viewing and adding materials to your simulation. Initially, the Database View is blank, but
upon importing a materials (.vmat) file, the view is populated with a table of data from the file. See Fig. 6.17.

You can switch between files, if more than one file is open, by changing the left drop-down menu. You can remove a
file by first switching to the file you would like to close, and then clicking on the Remove File button.

You can add materials to your simulation by highlighting the particular material you are interested in, and then clicking
on the Add to Simulation button.

For more information on materials, please see Materials.
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CHAPTER
SEVEN

TEXT SETUP

7.1 Introduction to Text Setup

VSim offers a text-based setup for simulation in addition to its visual setup method. Rather than constructing a
simulation through a graphical interface, the text setup allows the user to directly access the text-based (.pre) input
file instead. Though this method requires the user to have a more thorough knowledge of the simulation grid, field
properties, and other general characteristics governing the simulation, it also allows the user to combine fields and
particles in unique ways. It also allow one to use some features that are currently not available through visual setup.

7.2 Setup Basics

7.2.1 Setup Window for Text-Setup Simulations

You can open a simulation as described in Opening an Existing Simulation. After you open a simulation, VSim-
Composer displays the Setup window that contains an Editor pane with some easy-to-edit parameters and a short
description and image of the simulation. This is shown in Fig. 7.1.

From here you can modify the exposed parameters of the simulation, in order to explore the dynamics for different
values.

Pressing the View Input File button, boxed in red at the top, takes one to the Input File View, shown in Fig. 7.2.

This gives full access to the text-setup input file, so that you can add parameters, modify expressions, even modify the
algorithms used in the simulation.

Additionally, one can see all the files in the simulation directory by pulling the separator bar to the right, as shown in
Fig. 7.3.

The following sections will go through each of the components of the Setup window. We will then delve into the more
in-depth .pre file, including general properties, elements, and recommended structure. See Fig. 7.4.

Navigation Pane and Simulation Files

The Navigation pane contains a list of Simulation Files, and can be accessed by clicking and dragging on the vertical
bar that separates the Icon panel and the Editor pane.

To enable convenient viewing of the list of simulation files, VSimComposer allows you to specify in what order as
well as which type(s) of files you would like to view. Smart Grouping causes similar types of files to be displayed in
the same area of the Simulation Files tab list. Turning off Smart Grouping causes files to be displayed in alphabetical
order rather than by type. All Files indicates that you want to see all available files involved in the simulation. You
could choose to limit your view to only Simulation Files, which are files such as input files and macros that can be
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Fig. 7.1: Parameters view of the text-setup setup window.

VSim - Satellite Surface Charging (text-based setup) - o X
File Edit Tools View Help
Editor

e °
hargelpre | D o
~ ] satelite aperating in space goes through the solar nind environment, The satelite body collects charges from the space plasma and resuts inincrease in
Voltages near the satelite body. This localized build up of electric potential can lead to arcing and failre of the satelite components. Thesa smulations can be
nor [3 ] conducted for different space environments to investigate the effect of surface charging problem on satelite systems.
N [75 ]
ny (150 ]
ZENP SW_NUMDENS, SW_TEMP,
w5 | SW_VDRIFT
 [150 | SOLAR WIND
SATELLITE
1 [30.0 |
1z [150 | Lz
xeeN (0.0 ]
vBeN [-15.0 ]
N [ 7.5 ]
ZSTAKT|
SW_NUMDENS [ 1,087 ] . Js
SW_TEMP [10.0 ]
NEUMANN BC AT DOMAIN
SW_VDRIFT [4.05 | BOUNDARIES
z
snJormass [5. 11225 | X CONDUCTED AT VARIOUS SPACE .
ENVIRONMENTS (SW, LEO, GEO et Tl YE
SAT_INNER_V [5.0 | Y (5w, ‘ etc) “I-VQ
NP (5,643 ] «
@ setup: COMPLETED Click run to continue Show Log

Fig. 7.2: Input file view of the text-setup setup window.
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Fig. 7.4: The main parts of the Setup window
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edited in the VSimComposer Editor pane, or Text files, which include all types of human-readable file formats, or Data
files, which include incremental dump files and output files that can be visualized.

Key Parameters
All the example files in VSimComposer come with key parameters, allowing the user to easily adjust basic parameters
of the simulation.

By holding the mouse over the key input parameter name, a description of what exactly the variable does will pop up.
Many examples can be significantly modified with just the key input parameters to provide a good starting point for a
different application. See Fig. 7.4.

If you have opened one of your own simulations that is not based off of an example, you may not have these key
parameters. For more information on how to create these in your own file, please see Key Parameters.

Editor Buttons

From left to right, the editor buttons are:
* Undo
* Redo
* Paste
* Copy
e Cut
» View Input File / View Parameters
These buttons can be used for editing the key parameters as well as editing the .pre (or text-based) file.

If you would like to see the .pre (text-based) file, simply click on the View Input File button. This will bring you to the
traditional .pre file. Modifications made in the Key Parameters window will carry over if you switch to input file view.

Validate Button

If many modifications to the input file have been made, it is suggested to first validate the simulation. After the Validate
button has been clicked, the input file will be checked to make sure that there are no errors.

Description and Image

The far right of the Setup window holds a description of the simulation and a corresponding image.

If you have opened one of your own simulations that is not based off of an example, you may not have the description
and image. For more information on how to create these in your own file, please see the discussion on the XSim Block
in Key Parameters.

Hidden Log View and Find/Replace

Note: A LOG VIEW can be shown by clicking and dragging on the horizontal bar at the bottom of the Composer
window.
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Note: Find/Replace and Results tabs can be shown by clicking and dragging on the second and smaller horizontal bar
above the bottom of the Composer window.

VSimComposer notifies you of the actions that it is taking in the LOG VIEW. This includes output from the validation
of the input file, and imported files, among other things.

When editing the .pre file, VSimComposer has a Find/Replace tab to help naviagate the text. You can access this by
going to Edit —> Find and Replace or using the shortcut keys Ctrl+F.
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Fig. 7.5: Setup window tab for output message

7.3 Text-based (.pre) Input File Structure

7.3.1 Input .pre Files

We will now get into the actual construction of a text-setup simulation. Start by either going to File —> New —>
Text-setup Simulation, or by opening any text-based simulation with the intention of editing its .pre file. Once your
simulation is open, click on the View Parameters button at the top of the Setup window.

7.3.2 .pre File Structure

We will begin by discussing general .pre file syntax and concepts, including:
* Comments

e Variables
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* Globals

* Blocks
— Top-level Blocks
— Nested Blocks

We will then move into properties that you will want to be able to implement and alter to fit your specific simulation
needs:

* Geometries
* Grids
— Decomposition
* Fields
— Field Boundary Conditions
— EmField and MultiField
* Particles
— Particle Sources
— Particle Sinks
* Fluids
* Macros
* XSim and XVar Concepts

The concepts and properties discussed in this section are only introductory. It may be worthwhile to open 7Text-based
Setup examples and explore their .pre files in order to more clearly see the above concepts in action.

More information on specific types, parameters,and other options can be found in the VSim Reference Manual. For
details on further simulation customization, including information on importing your own analyzers and macros, can
also be found in VSim Customization.

Comments

Comments are helpful in either describing various parts and functions within your code, and can also be used to
visually break up your code into different sections. The loosely defined “sections” that will be used to describe .pre
file structure are technically commented sections.

Comments can be entered through one of two ways:
* Type in a pound sign (#), and then either start your comment on the same line or a new line.

 Use the opening and closing tags <Comment>, </Comment> before and after your comment text.

Note: Tech-X recommends that you always update your comments when you make changes to an input file. The
reasoning behind a change may become unclear if you do not provide comments that explain why you made the
change. Input files with old, out-of-date comments are difficult to work with.
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7.3.3 Variables

User-Defined Variables

Aside from the global variables built into VSim (see Globals), you can also establish your own variables. They are
defined through assignment, similar to many other programming languages. The syntax for defining a variable with
an expression is:

$ VARIABLE = EXPRESSION

where VARIABLE is the name of your variable and EXPRESSION represents any valid expression. (See Expression
Evaluation for more details.)

Note: Each line defining a variable must begin with a dollar sign ($).

VSim’s Python preprocessor will not try to substitute a variable on the left hand side of an equal sign (=). For example,
the following code snippet:

$ charge = 1.6e-19
charge = charge

results in

’ charge = 1.6e-19

You can also use existing variables to define your variables. For example, you can use the length and number of cells
along the x direction of your simulation in your definition of DX, as shown below:

’$ DX = LX/NX

You still must place a dollar sign ($) in front of the variable you want to define.

Scoping and Evaluation
Variables in VSim are scoped. This means that the effect of a variable’s definition is confined to the macro or block in
which that variable is defined. Whenever VSim enters a macro or a new input block, it enters a new scope.

In the case in which a variable is defined in multiple scopes, Vorpal ignores the previously-defined variable for the
duration of the current scope. If the variable is defined more than once in the current scope, the new value overrides
the previous value defined in the current scope.

A scope is closed once VSim leaves the block or macro. That is, the variable’s definition no longer has an effect once
VSim has used the variable’s value in the macro or block where it is defined and then proceeded to a different block
or macro. Scoping allows the next block to be free to redefine the value of the variable for its own purposes.

Mathematical Expressions

You can put mathematical expressions directly in an input file’s blocks by encapsulating them between dollar signs ($
math $). When you validate an input file, the expressions within the dollar signs are evaluated.

For example, in the esPtc1InCell . pre file, there exists a variable that is defined as:

$ NX1 = NX + 1
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and it appears in a vector describing the upper bounds of the simulation, [NX1 0 0]. However, you can also just
use a mathematical expression directly in the bound definition, so you’d have:

[$NX + 1$ 0 0]

instead of the separate lines defining the variable and the upper bound.

Expression Evaluation

VSim evaluates expressions by interpreting them as Python expressions, which are composed of tokens. A token is a
single element of an expression, such as a constant, identifier, or operation. The preprocessor breaks the expression
into individual tokens, then performs recursive substitution on each token. Once a token is no longer substitutable, the
preprocessor tries to evaluate it as a Python expression. The result of this evaluation will then be used as the value of
this token. All the token values are subsequently concatenated and again evaluated as a Python expression. This result
will then be assigned to the symbol.

Tokenizing, the act of breaking a string into tokens, is performed according to the lexical rules of Python. This means
that white spaces are used to delimit tokens, but are otherwise entirely ignored.

Note: A string within matching quotes is treated as a single token with the matching quotes removed.

The processed input files generated by VSim are sensitive to white spaces; as a result, VSim has to re-introduce white
spaces in the translation process. By default, tokens are joined without any white spaces. However, if both tokens are
of type string, then a white space is introduced. Also, tokens inside an array (delineated by [ 1) are delimited by a
white space.

See the Python documentation on the official Python website (http://www.python.org) for more information about
Python expression.

Parameters

Parameters can be integers, floating-point numbers, or text strings. The format of the parameter value determines the
type of parameter. For example:

e x = 10 indicates an integer

L]
b
Il

10. 0 indicates a floating-point integer

L]
b
Il

ten indicates a text string
Some parameters accept any text string (within reason). Other parameters accept only a choice of text strings.

Use a decimal point to specify a floating point number. You must write floating-point numbers with a decimal point so
that they will not be interpreted as integers. If you want to assign a floating-point value to an integer parameter, make
sure you write it as 3. (with a decimal point) rather than only the numeral 3 (without a decimal point). If you write
the number as an integer, VSim will interpret it as such. This will likely produce unexpected results.

If VSim can parse a value, such as 42, as an integer, it will do so. If VSim cannot parse the value as an integer, it
will attempt to parse it as a floating-point number. If VSim cannot parse the value as either an integer or floating-point
number, it will parse it as a string of text.

Check that you have correctly defined parameter values. If you incorrectly define a parameter that has a default value,
the default value will be used and potentially produce unsatisfactory results. If you incorrectly define a parameter that
does not have a default value, the computational engine may crash, fail to compute the physics of the simulation, or
ignore the incorrectly defined parameter and give you unsatisfactory results.
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Do not specify a parameter twice. If you do, the second occurrence of the parameter in the processed .in file (produced
from the .pre file) will be used. Although parameters and input blocks can be defined in many different sequences, if
you follow the recommendations in this guide, you should not have a problem with specifying parameters twice.

Vectors of Parameters

Vectors of parameters are enclosed by brackets [ ] with white space used as separators. For example:
e x = [10 10 10] indicates a vector of integers

e x = [10. 10. 10] indicates a vector of floats

7.3.4 Globals

Global variables can be declared outside of any particular block, and they control various general aspects of the
simulation. For example, the global variable dimension defines the number of dimensions for your simulation.
When running your simulation from the command line, you can override values set in your .pre file for required
global variables by using the variable’s command line parameter to define a new value. Not all global variables have
command line parameters, in which case they must be defined in your .pre file.

Required global variables are as follows:

floattype (string, required) Variable that defines the precision of real numbers in the simulation. For greater
precision, use the value double, otherwise use the option £1oat. You must define f1oattype in your input
file.

Example use of floattype:

floattype = double

dimension (integer, required) Variable that defines the dimensionality (1D, 2D, or 3D) of the simulation. Its
command line parameter is —dim.

Example use of dimension:

dimension = 2

dt (real, required) Time step size for your simulation. When choosing the step size, you also must consider stability
requirements. For example, you must satisfy the Courant condition when selecting a step size in electromagnetic
simulations. Its command line parameter is —dt.

Example use of dt:

dt = 1.49731212265e-16

nsteps (integer, required) Number of steps to take. (In the case of a restart, nsteps is the number of additional
steps.) Its command line parameter is —n.

Example use of nsteps:

nsteps = 22277

Optional global variables include the following, and are discussed in VSim Reference: Global Variables.
¢ dumpPeriodicity
¢ dumpSteps

* maxcellxing
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* sortPtcls

* dnSortMin

* dnSortMax

* useGridBndryRestore

* copyHistoryAtEachDump
* stepPrintPeriodicity

* timingAnalysisPeriodicity

Global Variables Specific to Moving Windows

The moving window feature allows the simulation window to move at the speed of light in the chosen direction. This
feature is used to reduce the size of the simulation box while following the physics phenomenon of interest, such as a
laser pulse or a particle beam that is propagating at a velocity close to the speed of light.

This feature and its parameters are as follows:
* moving window
* downShiftDir
* downShiftPos
* OAFuncshiftSpeed

These, as well as example code, are given in detail in VSim Reference: Global Variables.

Global Variables from Inside a Block

It is possible to declare your own global variable in VSim. This is done by first defining the variable, then declaring it
global. For example:

<Block>

S X =4

$ global X
</Block

This will cause the variable X to equal 4 outside of the block. The variable must be defined and declared global on
separate lines. For example,

$ global X = 4

will not define X as a global variable with value 4.

Defining Basic Simulation Parameters

Your simulation will include at least the following global parameters:
* dimension
e floattype
e dt

* nsteps
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e dumpPeriodicity

You can either set these equal to actual values, or you can set them equal to variables already defined in your .pre file.

7.3.5 Blocks

Input blocks are used to create simulation objects. The block is enclosed by opening and closing tags, such as:

<Grid globalGrid>

</Grid>

The tag determines the following:
Object type: Begins with a capital letter and is in “camelCase”. For example, Grid or EmField.
Object name: Indicated with a lower case letter and is in “camelCase”. For example, globalGrid.

You use the object name to refer to the object in other input blocks. For example, in the input block for a particle
object, you may refer to the name of the electromagnetic field object.

Input blocks can be nested. For example, input blocks for boundary conditions are nested within the input block for
an electromagnetic field.

Implementation Kind

Most Vorpal blocks, including both top level and nested blocks, have several algorithms from which you may choose
by specifying a parameter named k ind. For example, an EMField may be modeled as a Yee field, a direct sum field,
a constant field, or any of several other types. You use the kind parameter to select a particular implementation. Each
block description in this manual lists the available kind parameter settings for that block.

Note: If you don’t see the implementation kind you need for a given field block, you may wish to consider learning to
use the Mult iField blocks to define your own implementation. In addition, Tech-X Professional Services is avail-
able on a contractual basis to create custom implementations and simulations. Contact Tech-X at sales@txcorp.com
to discuss consulting options.

Example blocks specifying kinds:

<EmField myExternalField>
kind = funcEmField
<STFunc EO>

kind = expression
expression = EX_1 % cos(K_PE % x) » H(DRIVE_TIME - t)
</STFunc>
</EmField>

Top Level Blocks

Blocks that appear at the top level of the input block hierarchy define the basic characteristics for the simulation as
a whole and for other blocks that will be used in the simulation. Some top level blocks, such as Grid, Decomp,
SumRhodJ, can appear only once in an input file, and are denoted as singletons. Every simulation must, without
exception, contain a Grid and Decomp block.
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Other blocks, such as Species, can be used as many times as needed in the input file. You will find detailed
descriptions of blocks in the Text Setup section of VSim Reference.

Top level blocks include:

Grid (singleton): Determines the simulation size and relationship of physical coordinates to cell indices.
Grid is required in every input file block.

Decomp (singleton): Determines the domain decomposition and periodicity. Decomp is required in
every input file block.

SumRhoJ (singleton): Defines the properties of the charge and current density 4-vector field.
GridBoundary: Defines any embedded boundaries.

EmField: Defines any electromagnetic fields.

ComboEmField: Defines any combinations of electromagnetic fields.

Fluid: Defines any fluids.

Species: Defines any particles.

MonteCarloInteractions: Defines any random processes that may occur between different ob-
jects in the simulation, such as collisions or ionization processes.

MultiField: Defines general field blocks whose parameter and variable values may be adjusted during
the simulation.

ScalarDepositor: Alternate method to deposit charge from charged particles in a simulation into a
depField.

VectorDepositor: Alternate method to deposit current from charged particles in a simulation into a
depField.

History: Used to record data from a simulation over time.

For more details, please refer to the respective sections in VSim Reference.

Nested Blocks

While top level blocks are used at the top of the input file hierarchy, nested blocks are included within other code
blocks. For example, a Vorpal Species block can contain a ParticleSource block that describes how that
species is inserted into the simulation. The ParticleSource code block is, therefore, said to nested within the
species block. Nested blocks are noted in the descriptions of those blocks that can contain them.

A nested block applies only to the block that contains it. For example, you can use a BoundaryCondition block
to affect an EmField. You could then specify different boundary conditions for a second EmField block.

Particle species can also contain other objects. For example, you can use ParticleSource and ParticleSink
blocks in Species to describe where particles are to be placed into and removed from the simulation. By using these
blocks® kind parameters, you describe how the emission or absorption is to be accomplished. You are not limited
to defining blocks using a single level of nesting. The ParticleSources contained inside a particle species like
<Species electrons> also contain a Vorpal STFunc block. Taken all together, these blocks denote the space-
time function used to describe particle emission.

Example of nested blocks:

<Species electrons>
kind = relBoris
charge = -1.6e-19
mass = 9.109e-31

(continues on next page)
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(continued from previous page)

emField = myEmField
# Nominal density and particles per cell at that density
nominalDensity = 4.41204859999%e+22
nomPtclsPerCell = 2.
# Particles loaded in a ramp
<ParticleSource stepSrcl>
kind = bitRevDensSrc
density = 4.41204859999e+22

lowerBounds = [2.5e-07 -2.5e-05 -2.5e-05]
upperBounds = [5e-06 2.5e-05 2.5e-05]
doShiftLoad = 1

vbar = [0. 0. 0.]

vsig = [0. 0. 0.]

# Unit probability
<STFunc macroDensFunc>
kind = constantFunc
amplitude = 1.
</STFunc>
</ParticleSource>
<ParticleSource stepSrc2>
kind = bitRevDensSrc
density = 4.41204859999%e+22
lowerBounds = [5e-07 -2.5e-05 -2.5e-05]
upperBounds = [5e-06 2.5e-05 2.5e-05]

doShiftLoad = 1
vbar = [0. 0. 0.]
vsig = [0. 0. 0.]

# Unit probability
<STFunc macroDensFunc>

kind = constantFunc
amplitude = 1
</STFunc>

</ParticleSource>
# Particles out left are removed
<ParticleSink leftAbsorber>
kind = absorber
minDim = 1
lowerBounds = [-1 -1 -1]
upperBounds = [0 21 21]
</ParticleSink>
# Particles out right are removed
<ParticleSink rightAbsorber>
kind = absorber
minDim = 1
lowerBounds = [40 -1 -1]
upperBounds = [41 21 21]
</ParticleSink>
</Species>

Notice that adequate comments are provided to explain what is going on in each nested block.

Note: Tech-X recommends that when you nest input blocks, use an appropriate amount of indentation to improve the
readability of the input file.
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7.3.6 Geometries

You can include geometries in text-based simulations, either by importing existing geometries or creating them in your
prefile. For either of these options, you must import the geomet ry macro file.

$ import geometry

More details about the geomet ry macro, including all functions, usage, and advanced options can be found in the
Geometry Macro File document in the Version 7 Macros section of VSim Reference.

Creating Geometries

One can create primitives and perform operations on them, just as in the visual setup. By importing the geometry
macro as detailed above, one gets a number of predefined primitives, as well as functions that can be used to perform
operations on these primitivies, or to create custom shapes.

Along with the creation of primitives and/or functionally-defined shapes, the following operations will be detailed
herein:

¢ Moving and rotating shapes
* Advanced filling and voiding
* Making your own primitives
Primitives
The geomet ry macro includes a number of primitives, including some that are available in visual setup as well as
ones that are unique to the macro. Primitives that are also found in visual setup are as follows:
* geoBoxP
* geoCylinderXP
* geoPipeXP
¢ geoConeXP
* geoSphereXP
* geoTorusX
The primitives that are unique to the macro are below.
* geoQuadrilateralSlabXP
* geoHemiSphereXP
* geoBiParabolicSlabXP
* geoTriangleSlabXP
* geoRndCylinderXP
* geoRndRectangleSlabXP
* geoEllipsoid
* geoHemiEllipsoidXP
e geokEllipticalCylinderXP

* geoEllipticalConeXP
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To use these primitive functions, one must assign a geometry name to appear on the first in the parentheses, followed
by the primitive function and values you’ve entered for the parameters. Below is an example showing the creation of
a hollow cylinder with the geoCy1linderXP function, using the described syntax.

fillGeoExpression (hollowCylinder, geoPipeXP (x,vy,z, INNER_RADIUS,RADIUS,LXO))

The parameters used above are as follows, though one could also just input numerical values rather than parameters or
constants:

* X

°y

°z

INNER_RADIUS Inner radius of the cylinder.
RADIUS Outer radius of the cylinder.

* LXO Length of cylinder in the axial direction (x).

The parameters required for each of the primitive functions in the macro are detailed fully in the section on the macro
file in VSim Reference.

Moving and Rotating Shapes

The above shapes are defined around points of symmetry; cylinders and spheres are centered around the origin, and
rectilinear shapes begin at the origin and extend out in the x-direction.

However, one can provide offsets in any direction—x, y, or z-by subtracting the desired offset from the respective
variable parameter. For instance,

fillGeoExpression (hollowCylinder, geoPipeXP (x-0.03,y+0.04,z, INNER_RADIUS,RADIUS, .1))

would result in our cylinder being offset from the origin by 3 centimeters in the x-direction and 4 centimeters in the
y-direction. Its length in the z-direction would be 10 centimeters.

One can also rotate the shape so that it is centered about a different axis. For example, if the cylinder needed to be
centered about the z-axis, the .pre file input would be:

fillGeoExpression (hollowCylinder, geoPipe(z,x,y, INNER_RADIUS,RADIUS, .1))

Notice that the x, y, and z entries from before have changed so that they now are z, X, and y. The first entry is the axial
direction.

Advanced Filling and Voiding

There are two main methods of creating custom shapes, function-defined and primitive-based.

The function-based way of creating shapes involves first creating functions that describe your desired shapes, which
can be done through implementation of Heaviside functions. You can then use these functions as input for either the
fillGeoExpression or voidGeoExpression functions. We can use this process as an alternate means of
building our hollow cylinder from before, beginning with the function definition:

<function cylinderFunc>
H(-INNER_RADIUS"2 + x"2 + y"2)*H(RADIUS"2-x"2-y"2)
</function>
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where the INNER_RADIUS and RADIUS parameters are the same as those used in the hollowCylinder primitive
above.

The geometry itself can then be defined by simply determining a name as the first parameter—here, we have chosen
hollowCylinder again—and then invoking the function defined above.

fillGeoExpression (hollowCylinder, cylinderFunc(x,vy,z))

The voidGeoExpression function, on the other hand, designates a certain volume of space to be removed from
another. For example, this can be applied to a box, which can then be “subtracted” from a larger box. These operations
are implemented in a macro, whose name is that of the overall geometry.

<macro boxes>
voidGeoExpression (smallBox, geoBoxP(x,y,z,0.05,0.05,0.05))
fillGeoExpression (bigBox, geoBoxP(x,y,z,0.1,0.1,0.1))
</macro>

Making Your Own Primitives

If you want to make your own primitive that can then be used repeatedly in your simulation, you can define your
geometry in the macro format and then call the macro from multiple places in your .pre file. For example, we can
define our hollowCylinder as below:

<macro hollowCylinder>
H(-INNER_RADIUS"2 + x"2 + y”2)+«H(RADIUS"2-x"2-y"2)
</macro>

Importing Geometries

One can import both .stl and Python-defined shapes. CAD geometries can be used in conjunction with CSG primitives
built in VSim.

CAD (.stl) Shapes

You can import existing shapes whose files end with the .stl extension by using the (slightly different) functions
fillGeoCad and voidGeoCad. There also exists the optional function £111GeoFastCAD.

These functions’ parameters are detailed in full in the geometry macro file section, but a basic example of
fillGeoCad being used to import an .stl file is given below:

fillGeoCad (hollowCylinder, hollowCylinder.stl, False, 1.0,[0 0 0])

where “hollowCylinder” is the name of the object in VSim and “hollowCylinder.stl” is the .stl file being imported. The
last three entries, “False,” “1.0,” and “[0 0 0],” are default values, and as such the hollowCylinder object has imported
with 1-1 scaling and no translations.

Importing a Python File

To import a Python-defined geometry, one can use the functions £111GeoPython and voidGeoPython in con-
junction with a Python function that is defined in a .py file.
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fillGeoPython (hollowCylinder, makeHollowCylinder)

The Python file must have the same name as the input file name and contain the function you wish you use. The
function should be equal to 1 inside the geometry object and to O outside.

For more information on the geometries macro, please see Geometry in VSim Reference.

7.3.7 Grid

Define the Grid

You can use the Grid block to define the simulation grid. You can either use variables or the desired values directly
for parameters such as numCells, lengths, etc.

<Grid globalGrid>
kind = uniCartGrid
numCells = [NX NY NZ]
lengths = [LX LY LZ]
startPositions = [XBGN YBGN ZBGN]
</Grid>

A full description of all grid types and parameters can be found in the Grid section of VSim Reference.

Defining the Grid in Different Coordinates

You can set the simulation grid to be in cylindrical coordinates simply by setting

coordinateSystem = Cylindrical

Expressions will switch from relying on x and y coordinates to z and r automatically. You should still use x and y in
the actual expressions.

More information can be found in the Cylindrical Coordinates section of VSim Reference.
Define the Decomposition
You can use the decomp block to define the decomposition to be used in the simulation, particularly if you want

something other than Vorpal’s default decomposition method. It is also in this block that you can ensure periodic
boundary conditions are incorporated in your simulation.

<Decomp decomp>
kind = regular
periodicDirs = [1 2]
</Decomp>

More details on decomposition and related parameters can be found in the Decomp section of VSim Reference.

7.3.8 Fields

A number of fields can be implemented in your simulation, including different types of electromagnetic and electro-
static fields. Thus, there also exist a variety of ways to incorporate fields in VSim. In this section, we will cover
general concepts surrounding fields, including:
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* Boundary conditions

— Symmetry boundaries

— Fully periodic systems

— Modeling a time-dependent or space-dependent value on a boundary
* Signal creation

— Creating a circularly polarized pulse

— Launching a wave from the x-upper boundary of a simulation

We will then look at an example of field blocks in action. We will first look at an electrostatic field, which is created
through an EmField block. We will then look at an electromagnetic field that uses the MultiField block. This
block in particular allows the user to control more parameters for their fields, make changes pertaining to processing
efficiency, or even develop and apply their own algorithms. This object incorporates three general sub-objects:

¢ Field Specification of data.
* FieldUpdater Update operations to be performed on the the data.

o UpdateStep Algorithmic sequencing of the update operations.

Boundary Conditions
You can implement Dirichlet, Neumann, MAL, and other boundary conditions for your simulation, just like in visual
setup.

We will provide a few examples of common boundary conditions you may want to incorporate in your simulation,
including:

* Symmetry boundaries
* Fully periodic systems
* Time-dependent or space-dependent values on a boundary

¢ Launching a wave from the x-upper boundary

Symmetry Boundaries

A Neumann boundary can act as a symmetry boundary. For instance, placing Neumann boundaries appropriately on
three faces of a cube will turn the simulation into a symmetric simulation of an 1/8th of a larger cube.

Fully Periodic Systems

You can model a system that is periodic in all directions—that is, one that has no boundaries. In a fully periodic system,
however, the overall charge must be zero, as demonstrated in this equation:

x+L x+L
/ 8—de=E(x+L)—E(x): l/ pdx = £<p> (7.1)
- Ox € Jg €0

where (p) is the average charge density over the integration interval. Zero net charge can be enforced by specifying
the electrostatic solver parameter enforceZeroNetCharge = true.

For more information, see [BL04].

84 Chapter 7. Text Setup



VSim User Guide, Release 9.0.2-r2448

Modeling a Time-Dependent or Space-Dependent Value on a Boundary

An electromagnetic boundary condition may use time signals or spatial profiles. For example, the emPlaneWave.
pre file’s xLowerWaveLauncher boundary condition input block uses a spatial profile, and so kind =
variable.

The function parameter in a boundary condition input block also may be an expression, and the expression may be
any standard function of space and time.

The emPlaneWave.pre file uses the kind = expression technique.

<BoundaryCondition xLowerWaveLauncher>
# Value given by function
kind = variable

lowerBound = [0 0 0] # Lower limits
upperBound = [1 S$NY+1$ $Nz+1$] # Upper limits
components = [1] # Ey polarized
<STFunc componentl>

kind = expression

expression = 1.e6%sin (OMEGAxt)
</STFunc>

</BoundaryCondition>

For the complete content of the emP laneWave . pre file, see the example Electromagnetic Plane Wave in VSimBase.
Signal Creation Examples
Creating a Circularly Polarized Pulse

The steps to create a circularly polarized pulse are:

1. In the electromagnetic boundary condition input block, change the components parameter vector to launch both

ay and z component: components = [1 2].
2. Give the amplitudes parameter vector a value for each component: amplitudes = [AMPLITUDE
AMPLITUDE].

3. Give the phases parameter a value for each component. To make a circularly polarized pulse, the phases for the
two components should be 7/2 radians (90 degrees) apart: phases = [0. 1.57].

The widths parameter controls the spatial extent of the wave.

Launching a Wave from X-Upper Boundary of Simulation

The steps to change a wave launcher from the x-lower to the x-upper boundary follow:

1. Change the lower and upper bounds of the wave launcher boundary condition to the x-upper end of the grid.

Note: The lower bounds of a boundary condition at the x-upper end of the grid are in the physical domain.

2. Adjust the x-upper conducting boundary to zero out only the y component.

3. Adjust the x-lower conducting boundary to zero out both y and z components. Be sure to change both the
amplitudes and components vector.
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The simulation occurs in the lab frame. This means the pulse will strike the x-lower boundary and reflect back after
roughly fifty steps for the given time step and simulation size. To avoid reflections, you need to include an absorbing
boundary at the x-lower end.

Defining the EM Field and Boundary Conditions in VSim

Now that we’ve discussed boundary conditions, pre-conditioners, and solvers, we are ready to try adding fields to
simulations.

You can implement multiple electric and magnetic fields in your simulation. Here, we will show examples of both the
EmFieldand MultiField objects being used.

Electrostatic Field Example

We will begin with EmField, where we will define an electrostatic field covering the entire grid.

<EmField yseField>
kind = yeeStaticEmField

# Setting potential V = 0 on left wall of simulation
<BoundaryCondition left>

kind = dirichlet

minDim = 1

lowerBounds = [0 0 0]

upperBounds = [1 NY1 NZ1]

# NYI = NY + 1, NZ1 = NZ + 1 (these are where the guard cells are)

<STFunc voltFunc>

kind = constantFunc
amplitude = 0.
</STFunc>

</BoundaryCondition>

# Declaring our solver and preconditioner
<Solver yseSolver>

kind = gmres

precond = multigrid

smoother = GaussSiedel
nLevels = 12
threshold = 0.08
tolerance = le-8
</Solver>
</EmField>

Electromagnetic Field Example

The MultiField block, in comparison, does need a number of nested blocks that describe the fields involved, as
well as their boundary and initial conditions, field updaters, and update steps. Below, we have written up an example
with an electric and magnetic field.

<Multifield myFields>
# The default kind for MultiField is Null, which is what we will use here.

<Field E>

(continues on next page)
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(continued from previous page)

kind = regular
numComponents = 3
labels = [E_x E_y E_z]
# Set E_y = 1.0 on y-lower boundary initial condition
<InitialCondition eInitial>
kind = constant
lowerBounds = [-1 0 —1]
upperBounds = [NX1 1 Nzl] # NYl = NY + 1, NZ1 = NZ + 1
indices = [1]
amplitudes [1.0]

</InitialCondition>

# Set E_x = 0.0 (conductor) on x-lower boundary
<BoundaryCondition eBound>

kind = constant
lowerBounds = [0 -1 -1]
upperBounds = [1 NY1 NZz1l]
indices = [0]

amplitudes [0.1]

</BoundaryCondition>
</Field>

# Define simple magnetic field

<Field B>
kind = regular
numComponents = 3
labels = [B_x B_y B_z]
</Field>

<FieldUpdater yeeAmpere>
kind = yeeAmpereUpdater
readFields = [B]
writeFields = [E]

</FieldUpdater>

<FieldUpdater yeeFaraday>
kind = yeeFaradayUpdater
readFields = [E]
writeFields = [B]

</FieldUpdater>

<UpdateStep firstStep>

toDtFrac = 1.0
updaters = [yeeAmpere]
</UpdateStep>

<UpdateStep secondStep>

toDtFrac = 1.0
updaters = [yeeFaraday]
</UpdateStep>
updateStepOder [firstStep secondStep]
</MultiField>

(guard cells)
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TheMultiField we defined ended up having the same updaters as an electromagnetic field created using EmField.
However, this need not always be the case, as a large number of FieldUpdater, UpdateStep, and other related
objects exist for describing non-conventional systems.

If using the MultiField block in an electrostatic simulation, you must incorporate the linearSolveUpdater block. For
more details, visit the linearSolveUpdater sections in VSim Reference.

EM Field in Cylindrical Coordinates

When working in cylindrical coordinates, one must use a special FieldUpdater that is designed specifically for the
CoordProd grid. In the list of available updaters (found in FieldUpdater), the updaters which work with the CoordProd
grid will be named ending in CoordProd.

7.3.9 Particles

In order to define particles in your simulation, you will need to add each type of particle in its own Species block,
which will in turn include nested blocks that describe the particles’ sources and sinks.

Species Block

The Species block begins by stating the kind of the particle, which takes into account the anticipated dynamic be-
havior of the particle (relativistic or non-relativistic, for example) as well as the simulation environment it will live in
(Cartesian vs. cylindrical coordinate system, electromagnetic vs. electrostatic, etc.). More information on the types of
particle kinds can be found in the Species section of VSim Reference.

Also included in the basic Species block are parameters that describe the general characteristics of the particle, such
as mass and charge, as well as the parameters that will be used for calculation of macroparticles (nominalDensity
and nomPtclsPerCell).

For a more thorough description of the Species block, please visit VSim Reference: Species.

Macroparticles

* macroPtcIWeight used in VSim but not present in .pre file; determines particle resolution in simulation

¢ ParticleSource block: VSim determines # of macro particles to try and load in each cell, each time
step. May be << 1

¢ applyTimes parameter of said block sets an interval in seconds. VSim tries to load # of macros " into
each cell, each time step, for every time step falling w/in applyTimes

e can use applySteps instead of applyTimes

VSim uses macroparticles to model the kinetics of physical particles. The relationship between the physical density
one wishes to model and the density of macroparticles used in the simulation takes the form:

nominal Density x cellV olume

PtelsInM =
numbtcsinitacro nomPtclsPerCell

where
* numPtclsInMacro = number of physical particles in a macroparticle
* nominalDensity = nominal density of physical particles

¢ cellVolume = volume of a simulation grid cell (or average volume over all cells, if nonuniform)
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* nomPtclsPerCell = number of macroparticles in a simulation grid cell

The number of physical particles in a macroparticle can be set directly by including the following in the Species
block:

numPtclsInMacro = (float or integer value)

It can also be determined by setting both of the following parameters in the Species block:

nomPtclsPerCell = (float or integer value)
nominalDensity = (float value)

The sole purpose of the nominalDensity and nomPtclsPerCell parameters in the top level of a Species
block is to calculate the number of particles in a macroparticle of that species, according to the relation given above.

Alternatively, one can define this quantity directly using the numPtclsInMacro parameter. With the number of
particles in a macroparticle thus determined, one can then load the macroparticles into the simulation domain using
one or more ParticleSource blocks (a sub-block within the Species block); these blocks should be configured
to load macroparticles in a manner consistent with the desired physical particle density.

Many types (kinds) of ParticleSource can be used within VSim; the complete list is given in the ParticleSource
section of VSim Reference.

Use of STFunc blocks to modify density

A number of STFunc input blocks can be used to control or modify the density of physical particles represented by
the simulation. Not all ParticleSource kinds permit the use of such blocks.

For more information, please visit the section on xvLoaderEmitter in VSim Reference.
Particle Sources

ParticleSource blocks must be nested in the Species block of the particle you’d like to load or emit.
e certain blocks like xvLoaderEmitter will have sub-blocks (PositionGenerator and PositionGenerator)
* certain blocks can add in STFunc blocks (nested) for density functions over time, etc

Particle Sinks

Full Species Block Example

Below is an example of a Species block that includes nested ParticleSource and ParticleSink blocks.
For more blocks that are available for nesting under the Species block, please visit VSim Reference.

<Species electrons>
kind = nonRelES
charge = ELECCHARGE
mass = ELECMASS

nominalDensity = 1.0el2
nomPtclsPerCell = 10
fields = [esField]

<ParticleSource electronSource>
kind = xvLoaderEmitter

(continues on next page)
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(continued from previous page)

# Loading particles uniformly across entire grid
<PositionGenerator initialPosition>

kind = gridPosGen

<Slab initSlab>

lowerBounds = [0 0 0]
upperBounds = [NX1 NY1 NZ1]
</Slab>

</PositionGenerator>

# Simple velocity generator, with VEL as velocity variable
<VelocityGenerator initialVelocity>
kind = beamVelocityGen
vbar = [VEL 0. 0.]
vsig = [0. 0. 0.]
</VelocityGenerator>
</ParticleSource>

# Removing particles at upper y-boundary but saving them for use by other code,
—components
<ParticleSink electronSink>
kind = absAndSav

minDim = 1
lowerBounds = [-1 NY -1]
upperBounds = [NX1 NY1 NZ1]
</ParticleSink>
</Species>

For more details on the xvLoaderEmitter particle source, or any other particle source options, please visit the Particle
Sources in VSim Reference.

Particle Tracking

Since VSim is a particle-in-cell code, the position of a specific particle in the particle data structure will vary as the
simulation proceeds due to sorting and the creation and/or deletion of particles. Before you can track a particle, you
must identify the particle by tagging it.

Note: To track an individual particle, you must use a kind of particle species that enables tagging of
individual particles. Creating a species with the kind parameter set to one of the following kinds enables
you to create tagged particles that you can then use to generate particle position data for all tags (indicating
up to some maximum tag value) by using History.

e relBorisTagged
 relBorisVWTagged
e relBorisVWScale

Before particles can be tracked they must be tagged. There are four ways to tag particles.
* By setting the tags manually with the manualSrc.

* By using the tagGen STFunc in the funcVelGen VelocityGenerator. See VelocityGenerator in VSim
Reference.
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* By using the fieldScaleVelGen VelocityGenerator. This should only be used with
relBorisVWScale particles.

* By using the overwriteTag in the Species block. When this flag is set to true the species takes reponsi-
bility for generating the flags. This is the only option that will work with restore.

If the tags are set manually then the user must insure that the tags are unique or errors will occur tracking the particles.

Example of Using manualSrc to Tag Particles

<Species electrons>
kind = relBorisTagged
# constants defined previously
charge = ELECCHARGE
mass = ELECMASS
# Place a single particle in the macroparticle
emField = constMag
numPtclsInMacro = 1.

If the manual source 1is used to create
tagged particles, the tag must be a unique
integer or the particle tracking will not
work.

HO¥E Y ¥ W W

<ParticleSource SingleParticleSrc>
applyPeriod = 0
kind = manualSrc
# manual particle loaders always require
# AT LEAST 3 velocity components regardless
# of NDIM; in this case, NDIM=2

pl = [R_GYRO 0. 0. V_GYRO V_Z 0.]
p2 = [0. R_GYRO -V_GYRO 0. V_Z 1.]
p3 = [-R_GYRO 0. 0. -V_GYRO V_Z 2.]
p4d = [0. -R_GYRO V_GYRO 0. V_Z 3.]
</ParticleSource>
</Species>

Example of Using tagGen to Tag Particles

<VelocityGenerator velGen>
kind = funcVelGen

# This sets the tags to be unique integers so they
# can be tracked by the tagged particle tracking
# history
<STFunc component3>
kind = tagGen
</STFunc>
</VelocityGenerator>

After you have tagged those particles you would like to track using you can record the particles position and/or
velocities (or other internal variables such as the weight) by using the rm-speciestracktag History.
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Example History Block Used to Record Data from Tagged Particles

# Tagged particle trajectory history.

<History trajectory>
kind = speciesTrackTag
# Any particle with a tag greater than or equal to
# the maximum tag will not be tracked.

maximumTag = 4

xComponents = all

species = [electrons]
</History>

For more information on histories, please visit the History section in VSim Reference.

7.3.10 Fluids

One can add charged and neutral fields to your simulation by employing the F1uid block. It supports the following
three Kind options:

e coldRelFluid
e culerFluid
* neutralGas

A gasKind must then be specified, either by using a built-in value or by importing data from an external file. An
InitialCondition nested block must also be included, as it declares necessary boundary conditions and initial
condition parameters.

Below is an example of a fluid being implemented in a simulation:

<Fluid neutralFluid>

kind = neutralGas

gasKind = Ar

<InitialCondition >
kind = constant
# Lower and upper bounds with respect to the grid
lowerBounds = [0 0 0]
upperBounds = [50 50 50]
# Here, amplitude refers to the gas density, in kg/m"3
amplitudes = [1.78]

components = [0]
</InitialCondition>
</Fluid>

More details on F1uid and its parameters can be found in the Fluid section of VSim Reference.

7.3.11 Collisions

Reactions

In the Reactions framework, interactions are set up with two required blocks: a RxknsProcess block which is used to
set the products and reactants for an interaction, and a RxnPhysics block which sets the physics (cross-sections/rate
and type of interaction). The third, optional block, the RxnProcessSettings block, may also be included if
desired.
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The example code block at the bottom of this page shows the complete setup of an electron attachment process in which
an electron attaches to a neutral argon atom to create a negative argon ion. The optional RxnProcessSettings
block comes before all other blocks. Then the RxnsProcess block sets which species will react, sets the product
species that will be created, and points to a RxnPhysics block. The cross-sections for determining the likelihood of
an attachment reaction are imported via a 2-column data file in the RxnRate block within the RxnPhysics block.
Finally, the RxnProductGenerator block determines form of the reaction. The RxnProductGenerator
should be thought of as what sets the form of the chemical reaction to be undergone by the reactants.

More details of these blocks can be found on the following pages under the Reactions section of the VSim Reference
section on Text Setup: RxnProcessSettings Block (optional), RxnProcess Block (required), and RxnPhysics Block
(required).

Multiple RxnsProcess blocks can point to one RxnPhysics block. So, for example if a simulation is to include
multiple electron attachment reactions with the same cross-section, then there must be as many RxnsProcess blocks
as unique reactions, but all may point to the same RxnPhysics block.

The order in which the reactants and products are written in a RxknsProcess block is important and is determined
by which RxnProductGenerator is used in the RxnPhysics block pointed to by the RxnsProcess block.
When order is important, the necessary orders are indicated in the the documentation for each ProductGenerator (see
the RxnProductGenerator Sub-Block section under the page for the RxnProcess Block: RxnProductGenerator Sub-
Block).

In the Reactions framework, reactants and products can be any kinetically modeled particle species or background gas.
So the distinction between particle-fluid or particle-particle made in the MCI framework does not exist for Reactions.

<RxnProcessSettings RxnProcessSettings>
updateOrder = random
updatePeriod = [ 1 ]
</RxnProcessSettings>

<RxnProcess electronAttachmentParticlesRXNO>

kind = collisionProcess
reactants = [neutralArgon electrons]
products = [ArMinus]
rxnPhysics = electronAttachmentParticlesRXNOelectronAttachment
verbosity = 127
</RxnProcess>

<RxnPhysics electronAttachmentParticlesRXNOelectronAttachment>
kind = generalCollision

<RxnRate rxnRate>
kind = twoColumnFile
crossSectionVariable = velocity
file = 2ColumnData.dat
</RxnRate>

<RxnProductGenerator productGenerator>
kind = electronAttachment
thresholdEnergy = 1.0

</RxnProductGenerator>

</RxnPhysics>
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Monte Carlo Interactions (DEPRECATED)

There are three main categorizations of interactions recognized within the Monte Carlo Interactions package:

e Null (non-kinetic) Interaction not dependent on the full initial state (position and/or velocity) of any particle.
These are forced into an occurrence probability of 1, meaning that they occur every time step.

* Unary (partially-kinetic) The probability of occurrence and final state are dependent on only one of the parti-
cles’ full initial states. These interactions are randomly occurring, and an example would be the ionization
of a gas by an incident particle.

* Binary (fully-kinetic) Both particles’ full initial states determine the probability of occurrence and final state
of the interaction. These are also randomly occurring, and an example would be the collision of two
kinetically modeled particles.

Impact collisions then include the following:
* Elastic scattering collisions
* Exciting collisions
* Jonizing collisions
* Charge exchange

Data for cross-sections used in collision calculations either is built-in to VSim, or can be loaded through various
methods. Please see the Monte Carlo Interactions Introduction in VSim Reference for more information on interactions
and cross-sectional dependencies. The Using Cross Section Data in that same manual also may be helpful for your
simulations.

For more information, please visit the MonteCarloInteractions section of VSim Reference.

Partially- and non-kinetic interactions can be simulated by using a Fluid. For more details on fluids, please visit the
Fluid section of VSim Reference.

7.3.12 Histories

You may want to collect specific data from your simulation that is more complex or just different than the default data
found in the Visualization window. In this case, you can add a Hi st ory block at the end of your simulation.

An example of a Hi st ory block in action is below:

<History pseudoPotentiall>
kind = pseudoPotential
field = multiField.E
referencePoint = []
measurePoint = []
</History>

This particular history can be used to measure the “voltage” between two points in a simulation, where the points are
given in coordinate form.

You can use any number of histories in your simulation, provided that they match the type of simulation you are
running (i.e. a history concerned with the magnetic field will not work in an electrostatic simulation, etc.).

For a full list of available histories available in VSim, please see the Histories section of the VSim Reference Manual.

94 Chapter 7. Text Setup




VSim User Guide, Release 9.0.2-r2448

7.3.13 Macros

The great flexibility of the VSim input file languages allows VSim to be used to model a wide variety of systems, but
at the same time can make the construction of input files rather daunting. Macros simplify input file construction, and
are a mechanism to abstract complex input file sequences into (parameterized) tokens. In its simplest form, a macro
provides a way to substitute a code snippet from an input file. A user can then put only the macro into the input file,
and it will be expanded into the full input file at the time the .pre file is preprocessed.

An example of a macro has already been used in the Geometries section of this document, wherein we created a hollow
cylinder:

<macro hollowCylinder>
H(-INNER_RADIUS"2 + x"2 + y”~2)+«H(RADIUS"2 + x"2 + y"2)
</macro>

Macros can contain your own functions, built-in functions from VSim (like geoBoxP, for example), or a combination
of the two types. Once your macro is defined, you can call it as many times as you wish in your simulation.

VSim also contains a number of pre-defined macros that are used throughout the example input files available through
the VSimComposer interface. You may find the VSim macros to be helpful in your own simulations, especially in
cases like addFarFieldBox where the macro automatically adds 18 different (and necessary) histories to your
simulation.

The ability to use certain macros in VSim is tied to the particular VSim license in use.

For further information on macros, please visit either VSim Customization for more of the basics of macros, or refer
to VSim Reference for a full list of macros included in VSim versions 7 and 8.

7.3.14 XSim Block

When you open a .pre file, the first thing you’ll see is a section containing general information, including the .pre file
name, the example version, and copyright information.

The next section will be the XSim block. See Fig. 7.6.
The sections in the XSim block are as follows, and appear in Fig. 7.7.

1. image - The image parameter gives the name of the picture, located in the same directory as the input file, that
will be displayed on the right hand side of the Editor pane in the Setup tab. Frequently, this image is used to
illustrate key parameters such as dimensions of a physical structure. 400 x 500 pixels is a good image size.

2. longDescription - This text block will be visible above the image. It’s generally used to give a description of
what the simulation does and what will happen when key parameters are modified.

The next four parameters are only really useful to very advanced users who are creating and placing input files
in the Examples directory of VSimComposer. The Examples directory can be found in [VorpallnstallDirec-
tory]/Contents/Examples. Items 3, 4, and 5 are depicted in Fig. 7.8.

3. thumbnail - This is the small image that is visible when you select an example, and is located in the same
directory as the input file. 250 x 250 pixels is a good image size.

4. shortDescription - This is the name given to the example file.
5. description - This is the description given in the Examples window.

6. analyzers - VSimComposer will load the analysis script specified in brackets on the left hand side (which should
be located in the same directory as the input file) for use in the Analyze window.
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VSim3 - Text-setup Simulation
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Fig. 7.6: General information and XSim block
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Fig. 7.7: The image and longDescription in the Parameters View.
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Examples ? X

Available Templates Description

~ VSim for Basic Physics
Textbook Examples
v Textbook Examples (Text-based setup)

Magnetic Fields of Wire (Text-based setup)
Oscillating Dipole Above Conducting Plane (Texi-based setup)
Electromagnetic Plane Wave (Texi-based setup)
Electromagnetic Particle in Cell (Text-based setup)
Vacuum Electromagnetic Pulse (Text-based setup)
Electrostatic Particle in Cell (Text-based setup)

Two-Stream Instability (Text-based setup)

Two oppositely propagating electron
beams, with periodic boundaries and a
sinusoidal variation in their velocities.

VSi OlTe
VSim for Microwave Devices
VSim for Plasma Acceleration
VSim for Plasma Discharges
VSim for Semiconductor Devices

Fig. 7.8: Select an Example window

7.3.15 XVars

Exposed Variables

You can set which parameters are “exposed” in the Key Parameters view through adding or removing XVar blocks.
The following is an example of an XVar block:

<XVar variableName>

description = "Description of the variable"
min = minimum value
max = maximum value

</XVar>

The lines in this block are as follows:

<XVar variableName> Begins the X Var block for variableName. The variable name here must exactly match
the variable that you are trying to define.

description Describes the variable and will appear when the cursor is placed over the variable name in the Key
Parameters view.

min This is the minimum value for the variable and is optional. Setting a minimum can be very useful with
certain simulation parameters such as cell size, which can cause an instability if incorrectly specified.

max This is the maximum value for the variable and is optional.

Note: The name of the key parameter will turn red if there is no value given for the parameter, or if the parameter is
not greater than or equal to min and less than or equal to max, if they are specified.
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Primary Variables

The Primary Variables are variables that correspond to the XVar blocks defined in the above Exposed Variables section.
The syntax for setting primary variables is the same as setting any other user-defined variable:

S VARIABLENAME = default value

Variable names are generally in all capital letters. If you redefine this value through the Key Parameters pane, it will
overwrite the default value set in the .pre file.

Setting Key Parameters

You can also declare your primary variables right before their respective XVar blocks and essentially condense the
Exposed Variables and Primary Variables sections into one, as shown below:

$ VARIABLEONE = default value
<XVar VARIABLEONE>
description = "First variable"
min = minimum value
max = maximum value
</XVar>

$ VARIABLETWO = default value
<XVAR VARIABLETWO>

description = "Second variable"
</XVar>

The parameters defined in the sections above then can be passed as the values for global variables that define your
simulation. For example, if you defined a variable named NDIM as below:

$ NDIM = 3

<XVar NDIM>
description = "Number of simulated dimensions”
min = 3

</XVar>

You could then use this parameter as the value for the global variable dimension.

dimension = NDIM

For more information on global variables, see either globalvariables or the section on global variables in VSim Refer-
ence.
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CHAPTER
EIGHT

EXECUTING THE COMPUTATIONAL ENGINE (VORPAL)

8.1 Running Vorpal within VSimComposer

8.1.1 Run Window

Select the Run Icon

Once your validation is successful, you will see a checkmark by the Validate button. You can now select the Run icon
from the icon panel on the far left of the VSimComposer window.

Click on the Run icon as shown in Fig. 8.1.
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Show Leg

Fig. 8.1: Run Icon in Icon Panel
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The Run Window

The VSimComposer Run window contains two panes. As displayed in Fig. 8.2, the Runtime Options pane is on the
left and the Logs and Output Files pane is on the right, which contains an Engine Log and a File Browser tab.

U VSim - Ground Penetrating Radar (text-based setu - a X
9 P

File Edit Tools View Help
Runtime Options Logs and Output Files

Run Dump and Stop| | Force Stop
\’ These options override values calculated or setin the
Tab

Setup Enginelog | File Browser

Welcome
= Time Step | 1.7336109375110176e-11
5 (1.73361093751101766-11)
FSteps [1000
Setup
60)
:,
Run -
Reset to Setup Values
» Additional Run Options
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e RestartatDumphumber [ |
[ Dump at Time Zero
L] Mo Particle Sorting
? Paralel Run Options
Help [ Run in Paralel
Disable Per-Rark Output
Physical Cores on Machine: 4
Number of Cores |4
@ Run: READY Click run to continue Show Log

Fig. 8.2: The Run Window

Runtime Options

VSimComposer enables you to specify runtime options, and in some cases, override the settings in your simulation
input file. The Runtime Options pane contains fields and options that give you the flexibility of command line control
with the convenience of a graphical interface much like the key input parameters of the setup window.

Time Step (s): Step size to use in the simulation. When choosing the step size for your simulation, you must
consider stability requirements. For example, for electromagnetic simulations, you should specify a step size
that satisfies the Courant condition [CFL28]. You can override the dt variable using the —~dt command line
option. You must define dt in an input file.

Number of Time Steps: Number of steps to take. (In the case of a restart, nsteps is the number of additional
steps.) This can be overridden with the —n command line parameter. You must define nsteps in an input file or
on the command line.

Dump Periodicity (time steps): How often to dump the data; indicates data is to be dumped whenever
the time step has increased by this amount. The command line parameter -d overrides this variable. Must have
this defined in an input file or on the command line.

If you make changes to the Runtime Options, you can restore the options to their original settings by clicking on the
Reset to Setup Values button located below the Dump Periodicity in the left pane.

Additional Run Options
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Restart at Dump Number: Itis possible in this menu to restart a previous simulation with the Restart at Dump
Number field. VSim will load all the data associated with the dump number input in the field, and continue
running the simulation from that time.

Dump at Time Zero: Dump data at start of simulation, before any time has passed. This option is useful for
debugging purposes. It lets you see whether Vorpal used the data you wanted it to use at the start of the
simulation.

No Particle Sorting: This passes the -ns flag to Vorpal, which tells Vorpal to not sort the particles. Sorting
the particles (does not work with cell species) can affect the performance of your simulation.

Custom Run Options: You can pass command line arguments to the Vorpal engine here. The list of options can
be found in the Reference Manual under Vorpal Command Line Options.

Parallel Run Options

Run in Parallel: You may run your simulation in parallel as multiple processes by checking this box. Then,
select the number of cores you want to run on. You cannot run on more cores than you are licensed for. The
contents of the Engine Log are dumped into separate comms files when you run in parallel. You can check the
Disable Per-Rank Output box if you don’t need these files. Additional information on running in parallel can be
found below in Running in Parallel from VSimComposer.

Run the Simulation

For our example, we’ll run this simulation using only the default existing settings from the input file.

You do not need to select any file in particular in the File Browser tab before clicking on the Run button. However, if
the File Browser tab display area is too narrow for you to see the full file names in the filename list and you would like
to see the file name extensions of the files in the file browser, you can adjust the width of the filename field by using
your mouse to drag the column border.

Click on the Run button at the top of the Logs and Output Files pane as shown in Fig. 8.3.

Stopping the Simulation

VSimComposer features the ability to Dump and Stop and Force Stop a simulation. The buttons for these actions are
located next to the Run button. The two actions have slightly different uses. The Dump and Stop button is to halt
a simulation that is running normally to free up the processors used for another task, or so that one may vary the
parameters and restart. When a simulation is stopped it will dump all field and history data, so that it may be restarted
from the same point later. The output of a successfully stopped simulation is shown in Fig. 8.4.

The Force Stop is to be used if you realize that an error was made in the input file after clicking Run and needs to
be corrected. If Force Stop is used the field and history data will NOT be written to a .h5 file before the simulation
stops, but it will stop the simulation immediately rather than exiting gracefully. This option is particularly useful when
you may have more mesh cells than you intended, where the simulation is trying to allocate more memory than you
intended. The output of a successfully force stopped simulation is given below.

Restarting a Simulation

With VSimComposer it is possible to restart a simulation that has previously been run. This is useful if it is desired to
add more time steps to the initial simulation, or if the simulation had been stopped in the middle of the run. Underneath
the Runtime Options pane of the run window, under Additional Run Options, there is a Restart at Dump Number field.

Simply put in the last memory dump of the simulation and then click on the Run button, like running a normal
simulation. This process is demonstrated in Fig. 8.6.
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Fig. 8.3: Run Button
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Fig. 8.4: Stopped Simulation
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Fig. 8.6: Restarting a Simulation
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View the Engine Log

VSimComposer notifies you of the progress of its activity by reporting results along the way in the Engine Log tab as
shown in Fig. 8.7.
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Fig. 8.7: Engine Log

File Browser Tab in the Logs and Output Files Pane
In previous steps, the File Browser tab was located behind the Engine Log tab in the Logs and Output Files pane. Click
on the File Browser tab to bring it to the front as shown in File Browser Tab in Logs and Output Files Pane.

As with the File Browser in the Setup window, the File Browser in the Run window also has the Smart Grouping and
All Files pull-down menus at the bottom of the tab.

After a simulation has been run, you will be able to see the files that were output based on your number of time steps
and the dump periodicity. See Fig. 8.8.

Output File Naming Conventions

The first part of the output file name is the name of the input file. This is often referred to as the base name.
The second part of the output file name indicates the file’s contents, for example:

* The name of the field or particle species, such as E, B, or electrons.

* Globals for the file containing global variables such as the global grid, needed for restarts.

* History, containing data recorded over time.

* comms and “all” text files, containing various debugging and information about the simulation.

104 Chapter 8. Executing the Computational Engine (Vorpal)



VSim User Guide, Release 9.0.2-r2448

VSim - Dipele Abeve Conducting Plane
File Edit Tools View Help

Runtime Options

Logs and Output Files

Run Dump and Stop|  Force Stop
\’ These options override values caluiated or setin the
Setup Tab Enginelog  File Browser
e [
Default Valve (1.7380644643956894¢-11) e
P e ofsteps Tienome o — ]
Default Valve (500) [ coaxialloopAntennat 19Kb  07/16/18 16:5441.542
%, Dump Periodicity & comvialloopAntenna T4files  07/16/18 165441542
. Default Valve (50) () DemokrrayedWaveguideGrating.it Kb O7/17/1815:50:04382
. Reset fo Setup Values () DemohrrayedWaveguideGrating 10files  07/17/18 15:40:58.549 Ll
(53] () DemocylindricalCapacitor.ot 8Kb  OT/TT/I8 10:3458.342
~ Additional Run Options & DemocylindricalCapacitor 10files  07/17/13 10:3458.342
ancivee N ) DemoFieldionizeT Wfiles  BUTT/IE 10:28:57.447
- () Demovsim.tt 8Kb /1618 1656:56.777
e e @&l Demovsim 164files 07/16/18 16:56:56.777
— [ o Partice Sorting () dipoleOnConductingPlane.bt 175Ke  07/17/1815:57:36415
| cusomRunopfons[ | & dipoleOnConductingPlane Sefiles  07/17/18 15:57:36.400
2 (£ groundPenetratingRadarT.tt Kb O7/16/18 16:23:264
L Paralel Run Options @ groundPenetratingRadarT Bfiles  07/16/1816:23:26.042
Help Runin Parallel () JodipoleOnConductingPlane.txt 31kb  07/16/18 16:51:14.537
[ Disable Per-Rank Output & JodipoleOnConductingPlane Tifiles  07/16/18 16:51:14.521
Physical Cores on Machine: 4 () JoEmPlaneWave.bd 78Kb 07/16/18 16:49:34.804
Mumber of Cores (&) JoEmPlaneWave 36files  07/16/18 16:42:34.804
() JoTextSetupSimulation.bet 233Kb  07/16/13 16:53:36.681
(&) JoTextSetupSimulation Safiles  07/16/18 16:53:36.665
() TextsetupSimulation.t Kb 07/12/1810:35:55.922
{8 TesetupSimulation T0files  07/12/18 10:35:55.894
5 awgstructsti M6 DE/21/182319:24.000
[5) awgStructGeomSolid.stl M6 OI/17/18 143434860
[5) chargeGeni(portDiamondT.in 8Kb  O7/12/18 11:41:00.
[5) chargeGeni(portDiamondT.png 363Kb  06/21/18 231048,
[5) chargeGeni(portDiamondT.pre TKb OU/12/18 11:41:08:
[5) chargeGenitportDiamondTRunWin.png 146Kb  06/21/18 23:10:48.000
[5) chargeGenitportDiamondTSetupWin.png STKb  06/21/182310:48.000
[2) chargeGenitportDiamendT Tn.ang ToKb  06/21/18 2312:48.000
[2) chargeGenitportDiamondT Vars.py Kb OTAIE11:41:00.307
[2) chargeGenitportDiamandT VizWin.png 186Kb  06/21/13 23:10:48.000 |
Al Files -
Smart Grouping
@ Refresh 14 open
@ Run: SUCCESS Simulation engine finished successfully ShowLog

Fig. 8.8: File Browser Tab in Logs and Output Files Pane

The third part of the output file name is the dump number.

The final part of the output file name is the suffix.

8.1.2 Running in Parallel from VSimComposer

VSimComposer runs simulations in serial by default when you open a new simulation. If you are running on a local
system with multiple cores, you can run your simulation in parallel as multiple processes.

Permanently Switching the Engine to Parallel Execution

One can switch the engine to parallel execution from within Tools -> Settings, by following the steps provided in MPI.
See Fig. 8.9.

Defining the Number of Processors From the Run Window

It is also possible to switch the number of processors the simulation is run on within a single simulation session in
the Run window. In the Runtime Options pane, you will find the Parallel Run Options box. Here you can define the
number of cores to run on. You cannot use more cores than you are licensed for. The options will appear with their
defaulted values for that simulation, but you can override the defaults. This setting will be retained for as long as the
current file is open. See Changing number of cores on a per-simulation basis.

Now change any command line options as desired or run as usual by pressing the Run button.
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Fig. 8.9: Switching on parallel execution in the settings tab.
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8.2 Running Vorpal from the Command Line

The following sections describe how to run Vorpal from the command line.

8.2.1 Setting Up Vorpal Command Line Environment
Vorpal needs several environment variables set before it can be run from the command line. VSim provides scripts to
setup the environment on each operating system.

The following instructions use the variable SCRIPT_DIR which is the directory where VSim is installed.
For example, this would be something like SCRIPT_DIR=C:Program FilesTech-X (Win64)VSim-9.
0 (Windows), SCRIPT_DIR=/usr/bin/VSim-9.0 (Linux), SCRIPT_DIR=/Applications/VSim-9.0/
VSimComposer.app/Contents/Mac0OS (Mac).

On Windows

Open a Command Prompt (run cmd.exe) and execute the following line:

C:\> $SCRIPT_DIR%\setupCmdEnv.bat

On Linux or Mac

In a bash shell, source the VSimComposer.sh script as follows:

$ source $SCRIPT_DIR/VSimComposer.sh

This is a bash shell script, which means you must be running the bash shell to execute the above command. If you are
normally a csh/tsh user, you will need to start up a bash shell to execute the above command and subsequently execute
VSimComposer.

Most distributions/operating systems will allow you to add the above command to the .bashrc file in your home
directory, which will prevent having to run it each time you log in. Any changes you make to your .bashrc do not take
effect until the next time you log in, so after modifying your .bashrc file, you must execute the following command in
your current shell, but will not need to do it in the future:

$ source ~/.bashrc

8.2.2 Serial Computation

The Vorpal executable for use in serial computation is named vorpalser. Except as noted, the explanations and
tutorials within the vsim-user-guide and VSim Examples demonstrate Vorpal usage for serial computations. Here is
an example of Vorpal command line invocation using an input file named myfile.pre and specifying 1000 time
steps, outputting the result data (dumping) every thousand steps. By default, the output files for this example would
be named using the format myfile.out.

vorpalser -i myfile.pre -n 1000 —-d 1000

The Vorpal computation engine for serial computations also creates a single text file named myfile_comms_0.txt
unless this has been suppressed by command line or input file options.
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8.2.3 Parallel Computation
The Vorpal executable for use in parallel computation is named vorpal. This section explains use of the Vorpal
executable program for parallel computations.

Vorpal for parallel computations requires the Message Passing Interface (MPI). On Mac and Windows, you must use
our bundled MPI. On Windows the parallel message passing interface (MPI) library provided with VSim is MS MPI
(from Microsoft). On Mac, the parallel message passing interface (MPI) library provided with VSim is OpenMPI. On
Linux, the parallel message passing interface (MPI) library provided with VSim is Mpich. If there is a reason why
you must use a system MPI, please contact Tech-X support, who will quote you for a custom installation.

For administrator information about MPI for use with Vorpal, see LinuxAdvancedMPI.

Running Vorpal with mpiexec

In order to run Vorpal in parallel via the command line, you must first add the <VORPAL_BIN_DIR> to your PATH,
as noted in the running-vorpal-from-the-command-line-command-line-options section.

To run Vorpal in parallel, execute the following command:

mpiexec -n <#> vorpal -1 filename

in which <#> is the number of processors, vorpal is the executable program for parallel computations, and
filename is the name of the input file (which must be in the current directory, or must be specified by a full
path).

Following mpiexec, but before vorpal, you can specify a variety of mpiexec options. In particular, for the
openmpi implementation of MPI (supplied with macOS), one may need to add the arguments, -x PYTHONPATH -x
LD_LIBRARY_PATH to ensure that all processes are using the correct values for these environment variables. For the
mpich implementation of MPI (supplied with Linux) these arguments are not needed, as mpich by default exports all
environment variables to all processes. For more information about mpiexec, including the complete list of options,
it can be run with mpiexec -h.

Following vorpal, you can specify a variety of Vorpal options. Some of the more common options are

’vorpalser -1 esPtclInCell.pre -o newesPtclInCell

’vorpalser -1 esPtclInCellSteps.pre —-r 50

For a complete list of options, see VSim Reference: Running Vorpal from the Command Line Options.

If a parameter is both set within the input file and specified on the command line, the command line parameter value
takes precedence. The command line override enables you to configure an input file with default values while exploring
alternative parameter settings from the command line. From the command line, you can quickly change simulation
run lengths, dimensionality, output timing, etc.

Vorpal automatically adjusts its decomposition to match the number of processors it is given, unless a manual decom-
position is provided for the correct number of cores in the input .pre file.

In contrast to Vorpal for serial computation, which creates a single text output file, Vorpal for parallel computation
creates multiple text output files. Each individual processor from the parallel run sends comments to a different output
file. A parallel computation output file’s name includes a label that identifies the number of the processor that generated
that file, for example:

e esPtclInCell_comms_0_1.txt

e esPtclInCell_comms_0_2.txt
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in which the final _0 and _1 before the file name suffix indicate the number of the processor.

By default Vorpal writes one HDFS file for each field or particle species even for a parallel run. However, one can
modify this behavior, as noted at the above link. Having one file for each field or particle species for each processor
can sometimes get around parallel I/O problems. When that is necessary, one can construct a single file for a field or
particle species using the utilities, nergeH5F 1ds and mergeH5Ptcls, which come with Vorpal.

Running Vorpal with mpiexec Using a Hostfile

If the you need to run an MPI job but do not have access to a queuing system then a hostfile must be set up. If this is
the case you must know the node names on the cluster that the job is to be run on. You must then create a text file with
your text editor of choice, this is your hostfile, and place it in your home directory. The hostfile simply contains each
node name repeated on a new line as many times as there are threads in that node. For example consider a two node
cluster with four threads each, the hostfile will contain

nodel
nodel
nodel
nodel
node2
node?2
node?2
node?2

To run a job one must then source VSimComposer shell script using the command:

source <VSIM_SCRIPT_DIR>/VSimComposer.sh

Note: This action changes your environment in your current shell, and so may make other programs fail. Do this in a
separate shell from any shell in which you intend to run standard programs, like vi or emacs.

You are now ready to run in MPI using the mpiexec command with the above hostfile (signified as <hostfile> below.
For mpich (which is provided for Linux), the command is

mpiexec —-f <hostfile> -n <#> <other mpiexec options> vorpal |\
-1 simulationname.pre <other vorpal options>

The equivalent command for openmpi (which is provided for macOS) is

mpiexec —-hostfile <hostfile> —n <#> <other mpiexec options> vorpal |\
-1 simulationname.pre <other vorpal options>

The number of nodes, <#>, must be consistent with the computational resources and the hostfile.

8.3 Running Vorpal using a Queuing System

Running Vorpal with MPI either directly or with Parallel Queuing Systems requires use of different shell scripts to
enable invocation of the Vorpal executable, as outlined below. In this section we discuss Linux queuing systems. For
running Vorpal through Windows HPC Cluster Pack see Windows HPC Cluster.

Queuing systems, such as PBS, LoadLeveler, LSF, SGE and Slurm, require the submission of a shell script with
embedded comments that act as commands that the queuing system interprets. Below we show some of the more
common embedded comments. Discussion of all the embedded comments is beyond the scope of this document.
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Furthermore, the command for submitting the job can vary. Below we will provide a common command, but you
should contact the system administrator to ensure that you have the correction job submission command.

8.3.1 PBS/Torque/OpenPBS

Here is an example of a basic shell script for a PBS-based system.

#PBS -N vaclaunch

#PBS -1 nodes=2:ppn=2

export VSIM_DIR=SHOME/VSim-9.0

source S$VSIM_DIR/VSimComposer.sh

cd /directory/containing/your/input/file

mpiexec -np 4 vorpal -i vaclaunch.pre -n 250 -d 50

The -I commands relate to the resource requirements of the job. This file explicitly specified the number of cores per
node, and number of nodes, so we have a total of four MPI ranks on which to execute the job, which is mirrored in the
mpiexec -np argument.

If the contents of the above file are in vaclaunch.pbs, then the job would commonly be submitted by

gsub vaclaunch.pbs

although some MOAB based systems might use msub.

8.3.2 Sun Grid Engine (SGE)

Here is another example, this time for a SGE (Sun Grid Engine) job.

#$ —-cwd -V
#$ -1 h_rt=0:10:00
#$ -1 np=16

#$ -N magnetron2D

export VSIM_DIR=$HOME/VSim-9.0

source $VSIM_DIR/VSimComposer.sh

mpiexec -np 16 vorpal -i magnetron2D.pre

This time the -cwd -V tells the queue system to use the current working directory for the job, and to import the current
environment and make this avialable for the script.

In this case, the queue system calculates the configuration based on the choice of 16 cores. On this cluster the -/
commands is also used to specify the run duration, which, in this example, is set to 10 minutes.

If the contents of the above file are in magnetron2D.gsub, then the job would commonly be submitted by

gsub magnetron2D.pbs

8.3.3 Platform LSF

Here is a third example, for the Platform LSF system:

#BSUB —-o EBDP-VSim9.0.out
#BSUB —e EBDP-VSim9.0.err
#BSUB -R "span[ptile=16]"
#BSUB —-n 32

(continues on next page)
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(continued from previous page)

#BSUB —-J testVSim9.0

#BSUB —-W 45

cd $SHOME/electronBeamDrivenPlasma
export VSIM _DIR=$HOME/VSim-9.0
source $VSIM_DIR/VSimComposer.sh

export MYJOB=electronBeamDrivenPlasma.pre

mpiexec -np 32 vorpal -i ${MYJOB}

With this submission system and job scheduler, -W is used to denote the wall time for the job in minutes. The name is
passed by -J.

Sometimes one must reference a specific project for accounting purposes in the job submission file. For this you may
use the -A option.

If the above commands are in the file, electronBeamDrivenPlasma.lsf, then the job is commonly submitted by

bsub < electronBeamDrivenPlasma.lsf

8.3.4 Slurm

Here is an example from a Cray system with a custom Vorpal build running from a directory /project/nnnnn/gnu-5.2.40.

#!/bin/bash

#SBATCH account=nnnnn

#SBATCH ——-job-name=Ipa

#SBATCH —-output=Ilpa.out

#SBATCH error=lpa.err

#SBATCH ——-nodes=2

#SBATCH —-time=00:05:00

srun —--ntasks=32 —--hint=nomultithread --ntasks-per-node=16 /project/nnnnn/gnu-5.2.40/
—vorpal-exported/bin/vorpal -i laserPlasmaAccel.pre -n 100 -d 20

If the file containing the above is named, laserPlasmaAccel.slm, then this job is submitted with

squeue laserPlasmaAccel.slm

8.3.5 Windows HPC Cluster

When running under Windows HPC Cluster tools, one must modify the above procedure to take into account that one
must run mpiexec through another application, sigcapture.py, which is distributed with VSim, in order to have a clean
shutdown. The way to do this is illustrated in the batch file, winClusterSubmit.bat, that is in the Contents/engine/bin
directory. One can use this file, but one must first modify the environment parameters, INST_DIR and SIM_DIR, at
the top, the desired output file names, the number of processors, and the name of the input file that you wish to run.
After making the appropriate modifications, one can simply run that batch file, e.g.,

> winClusterSubmit.bat

The output will show the full job submit command that was issued. Doing job cancel <jobnum>, where
<jobnum> is the number of the job, will now result in a clean shutdown, cleaning up the token file and doing a dump
before quitting.
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CHAPTER
NINE

OUTPUT DATA

9.1 HDF5 Format Data Output Files

Vorpal outputs data in two forms, text and HDF5. Text output is used for progress reporting, while HDF?5 is used for
data files. The HDFS5 data files have the . h5 suffix.

Hierarchical Data Format Version 5 (HDF5) is a library and file format for storing graphical and numerical data and for
transferring that data between computers. Vorpal and VSimComposer output data in HDF5 format. The Hierarchical
Data Format was developed by the National Center for Supercomputing Applications at the University of Illinois at
Urbana-Champaign. For more information about HDF5 (See http://hdfgroup.org/HDFS5).

9.2 Dumping Fields, Particles, and GridBoundaries

The following are the general dumping options that can be set in field, particle, and grid boundary blocks. These can
be used when the user wishes to customize the dumping options for the particular blocks and not change the global
dumping options.

* dumpOncePerRun (boolean)
If true, this object will be dumped only once per run. This specification can co-exist with other specifications.
¢ commandLineDumpPeriodicity (integer)

This option may be automatically set by vorpal to override other attributes specifying when this object should
dump its data.

e dumpPeriodicity (integer)
If dumpPeriodicity = p, then this object will be dumped to disc when its timestep mod p equals 0.
If p=0, this object ” “will never be dumped.

e dumpPeriod (integer)
(deprecated: please use dumpPeriodicity instead)
If dumpPeriodicity = p, then this object will be dumped to disc when its timestep mod p equals 0.
If p=0, this object will never be dumped.

e dumpSteps (integer list)
A list of the time steps at which this object should dump its data to disc.

* dumpSteps (expression)
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A function of a scalar integer n (the current time step) that returns 1 if this object should be dumped at step n,
and 0 if not.

To use an Expression, it must be specified within the <Expression dumpSteps> block:

expression = (a function of 'n', the timestep, that yields 0 or 1)
For example, expression = ( mod(n, 100) == )
or expression = ( or(n==100, n==200))

Vorpal produces one HDFS5 file for each field or species at each dump time. For example, if the simulation parameter
nsteps = 100 and the simulation parameter dumpPeriodicity = 10, Vorpal dumps data 10 times during the
simulation and outputs a total of 10 HDFS5 files for each field or species while running the simulation. Vorpal also
produces one Globals file at each dump containing data that is general to the whole simulation, as opposed to one
species or field. Finally, Vorpal puts out a Hi st ory file containing the data of the specified histories.

9.3 Change the Names of Output Files

If you want to change the names of the output files, which include the .h5 files, you can specify the -o output option
when you run Vorpal.

For example, you want to replace emPlaneWave with emPlaneWaveTest1 in the names of the emPlaneWave
simulation’s output files. Run Vorpal from the command line using this command:

vorpal -i emPlaneWave.in -o emPlaneWaveTestl

The output files will be:
e emPlaneWaveTestl_all_1.txt
* emPlaneWaveTestl_comms_0.txt
* emPlaneWaveTestl_completed.txt
e emPlaneWaveTestl_dumpedobijs_0.txt
e emPlaneWaveTestl_electrons_1.h5
* emPlaneWaveTestl_Globals_1.h5
* emPlaneWaveTestl_SumRhoJ_1.h5

e emPlaneWaveTestl_YeeStaticElecField_1.h5

9.4 Displaying the Content of .h5 Files

The h5dump utility converts the binary data in .h5 files into human-readable ASCII data in .txt files, and is
available for all the platforms on which Vorpal runs. You can download the utility from the HDFS website (http:
//hdfgroup.org/HDFS).

The basic command is:

’hSdump -0 output_file_name.txt your_h5_file.hb

So, to convert the emPlaneWave_ electrons_1.hb5 to text format, use this command:

’h5dump -0 emPlaneWave_electrons_1.txt emPlaneWave_electrons_1.h5
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9.5 General Structure of Simulation Output .h5 Files

For each type of output file below, main data entries within that output file are displayed as a list of fields at the
same level within the list. For those data fields within an output file that contain one or more subcategories of data,
subcategories appear in an indented list below the main data category to which the subcategories apply.

Type of Output File: Globals

compGridGlobal
runInfo
time

Type of Output File: SumRhoJ

SumRhoJ
int array [NX NY NZ 4]

SumRhoJ[0] = Rho, charge density
SumRhoJ[1] = Jx
SumRhodJ [2] = Jy
SumRhoJ[3] = Jz
compGridGlobal
compGridGloballimits
runInfo

time

Type of Output File: Fluid

NeutralGasName
int array [NX NY Nz 1]
NeutralGasName[0] = Density
compGridGlobal
compGridGloballimits
runInfo
time

Type of Output File: comboEmField

comboEmField
int array [NX NY NZ 6]
comboEmField[0] = Ex
comboEmField[1l] = Ey
comboEmField[2] = Ez
comboEmField[3] = Bx
comboEmField[4] = By
comboEmField[5] = Bz

compGridGlobal

compGridGloballimits

runInfo

time

Type of Output Files: YeeStaticElecFldTrilinos

YeeStaticElecF1ldTrilinos
int array [NX NY NZ 3]

YeeStaticElecFldTrilinos[0] = Ex
YeeStaticElecF1dTrilinos[1] = Ey
YeeStaticElecF1dTrilinos[2] = Ez

(continues on next page)

9.5. General Structure of Simulation Output .h5 Files 115




VSim User Guide, Release 9.0.2-r2448

(continued from previous page)

compGridGlobal
compGridGloballimits
derivedVariables
runInfo

time

Type of Output Files: YeeStaticElecFldTrilinosPotential

YeeStaticElecF1ldTrilinosPotential
int array [NX NY NZ 1]
YeeStaticElecFldTrilinosPotential[0] = Electrostatic Potential, Phi
compGridGlobal
compGridGloballimits
runInfo
time

Type of Output Files: emMultiField — ElecMultiField

ElecMultiField
int array [NX NY NZ 3]
ElecMultiField[0] = Ex
ElecMultiField[1] = Ey
ElecMultiField[2] = Ez
compGridGlobal

compGridGloballimits
derivedVariables
runInfo

time

Type of Output Files: emMultiField — MagMultiField

MagMultiField
int array [NX NY Nz 3]
MagMultiField[0] = Bx
MagMultiField[1] = By
MagMultiField[2] = Bz
compGridGlobal

compGridGloballimits
derivedVariables
runInfo

time

Type of Output File: GridBoundary name

name
int array [NX NY Nz 2]
name [0] = true (1) or false (0) is the lower left front corner inside or not?
name[1l] = true (1) or false (0) is the cell center inside or not?

namelLargeBndryFaces
namelargeFaceFracs
nameSmallBndryFaces
nameSmallFaceFracs
nameStairStepBndryEdgesData
nameStairStepBndryFacesData
compGridGlobal
compGridGloballimits

(continues on next page)
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(continued from previous page)

derivedVariables
poly

runInfo

time

Type of Output File: universe (DEPRECATED)

globalGridGlobal
globalGridGloballLimits
derivedVariables
poly
runInfo
time
universe
int array [NX NY NZ 2]

Type of Output File: history

runInfo
historyNamel
historyName2

Note: These historyName arrays contain time data pertaining to the type of history chosen in the input file.

Type of Output File: species

species
int array [NX NY NZ 6]

species[0] = x position
species[l] = y position
species[2] = z position
species[3] = x velocity
species[4] = y velocity
species[5] = z velocity

compGridGlobalLimits

runInfo

time

Note: The information above is representative of 3D data. The actual number of elements in an array may vary
depending on the dimensionality of the simulation. The number of elements in a species output file will also vary
based on the type of species used. For more information on the output of species data, see the next section.

9.6 Columns in Particle Simulation .h5 Output Files

Below is a table displaying how the columns in particle simulation . h5 output files for various species kinds corre-
spond to the columns that can be seen in the . h5 file when the file is opened using a tool such as HDFView. HDFView
may be downloaded for free from the HDF Group at http://www.hdfgroup.org/hdf-java-html/hdfview/. HDFView dis-
tributions are available for 32-bit and 64-bit Linux, Mac, and Windows platforms.
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Table 9.1: Columns in .hS in Particle Simulation Output Files

Species Number of Columns | Comma-separated Columns
cmplxRelBorisDF 5 + NDIM x,[y,[z]]Px, Py, Pz, real weight, imaginary weight
envBoris 5 + NDIM x,[y,[z]1Px, Py, Pz, tag, weight
freeRel 3 + NDIM x,[y,[z]]Px, Py, Pz
freeRelVW 4 + NDIM x,[y,[z]1Px, Py, Pz, weight
noMove 3 + NDIM x,[y,[z]]PX, Py, Pz
noMoveVW 4 + NDIM x,[y,[z]1Px, Py, Pz, weight
nonRelBoris 3 + NDIM x,[y,[z]]PX, Py, Pz
nonRelEs 3 + NDIM x,[y,[z]1Px, Py, Pz
relBoris 3 + NDIM x,[y.[z]]Px, Py, Pz
relBorisBallisticVW | 4 + NDIM x,[y,[z]1Px, Py, Pz, weight
relBorisCyl 3 + NDIM u0,[ul,[u2,]]PO, P1, P2 (see Legend)
relBorisDF 4 + NDIM x,[y,[z]]Px, Py, Pz, weight
relBorisEffMassExtd | 2 + 3(NDIM always 3) | x, YV, z, Px, Py, Pz, valley index, weight (always 1)
relBorisFuncVW 4 + NDIM x,[y,[z]]Px, Py, Pz, weight
relBorisTagged 4 + NDIM x,[y,[z]]Px, Py, Pz, tag
relBorisVW 4 + NDIM x,[y,[z]]Px, Py, Pz, weight
relBorisVWTagged 5 + NDIM X,[y,[z]]PX, Py, Pz, tag, weight
relBorisVWScale 6 + NDIM x,[y,[z]]Px, Py, Pz, tag, scale parameter, weight
cell 3 + NDIM x,[y,[z]1Px, Py, Pz
cell(VW) 4 + NDIM x,[y,[z]]Px, Py, Pz, weight
cell(tagged) 4 + NDIM x,[y,[z]1Px, Py, Pz, tag
cell(VW, tagged) 5 + NDIM x,[y,[z]]Px, Py, Pz, tag, weight
Note: The cell species (kind = cell) set variable weight (VW) and tagging with the

variableWeightParticle and taggedParticle parameters.

Table 9.2: Legend

NDIM Number of Dimensions: 1, 2, or 3
Dimension Notation

1D 2D 3D

X Xy Xyz

1D 1D,[2D] 1D,[2D,[3D]]
Cylindrical Coordinates

Polar u0, ul, u2 1, phi, z

Cylindrical u0, ul, u2 z, 1, phi

Tubular u0, ul, u2 phi, z, r
Momentum/Mass Notation Convention
momentum/mass = gamma*v = P

gamma*vx:Px | gamma*vy: Py gamma*vz: Pz

9.7 HDFView Example Simulation .h5 Output File lllustration

Below are HDFView displays of Vorpal field and species . h5 output files from an example simulation, as well as
brief descriptions of said output. HDFView may be downloaded for free from the HDF Group (http://www.hdfgroup.
org/hdf-java-html/hdfview/)
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HF HDFView 2.13
Eile

indow Tools Help

RecentFiles

0T_YeellagField_7h§

[& ransportzmissionDiamens

) YeeMagField at / [ransportEmissionDiamondT_YeeMagField_7.h5 in C:L o X
% Yeshiagield =

o € dervedVariables =

o € globalGriaGlonal ‘ I ]

- imit

o Carunints 0 1 2 3 4 5 5 8 9 10 12 13 14 1 16 17 18 19 2
00 oo 0 0 0.0 0 0 0 0 0.0 oo 0 00 0 oo oo

> Qatime [1.5236721..|7 5735707.. [24676448...|1.7827232.. |1.71062687.. 1.2200051...| 7 6006227 1582281..5.5208080...|1 6651012 53333176_|-1 1363105 |12356410_|-0 3170439 |8 5891346 _ |2 7804933 _|16623437._|-20708810_|-4 2416234_la {
[4:3334857..|5 4526867.. [2.7186206...|16559521.. |1 4066770..-6.2589009..| 1 4327838, 0903668...-2.7563636..]1.1420674. 1.8362779..]2.4928240... [2.4059659... |5 5994322.. [2.5052197... |1.8219132... 2.6123108...[1.1031613... | 2.6027747..12.{
1848543... | 71707588../2.8074230...2.3238601... |4 5695763.|14695103...7 648 1000... 2.6402385...-1.0360590..|- 6363196...7 087368 ... |1.6417557..-1.7021309../0.2376 4. |5.2680759.. [0.7573056... |1.5263441... [5.0507722... |8.5507386... [2.3930254... |-1.9277026..24
8779672.. 5130892 1.0482495../5.9132740...[15406386... |24673285...|1.5026992.. [51082148...-2.2407408..|3.3004330... |1 1108732... |2.7391235...2.0999612.. | 2.2569134..]2
7319743.. 1525508 1.5262228..|-6 0734825..[4.4007595... |2.9846713... 1.7063841 6.2701161... 36340796, 9186332...-6.0854235..2
4681849...[2.8032325.. [5.0021672... |5 8304253 5 9.2215150... 1.0168832..[2.6343449... 2.1204801.. [9.7085101. 26903641, [5.0636742 1,245 1037..[1.1479574...5.{
3550%67...[5.933079 2916555 1644289...|1.7218646... [1.5388609...|2.0967936.. [29730628. 4..1-13924436. 39755444, 9..147149214.39169111...[5.4
3070712... [ 47775141 8645049 7540672...|1.1284166.. [9.0720764... |3.7436419.. 55500448 2305107..[3.0789535... |3.0550843...-2.3075509..6.4621687... .|
52141883, 1.7756101 6836417...[0.5036900 £ 5 8.9301203...|-2.1828086..]3.4058250... 3 0032050.. 49064803 [26351277..]-8.0936020..|-4.8870990...-2.2272064.| 1.0810653... 4.
2.6337408..]2.0836499. 5568102...[5.0489508 46982530..[1 5250863... |2 5043784... |3.2765014...[4.8253348 5980855.-1.2804000..|3.3771115...-0.4556566..22330159... 4]
24540021 25725004, 308066...|1.1126720 40399400..[1.6463940...|1.7832392... [1.5730403... 6.0232042 1571732..:6.6123305..1.1664962..[1.2501344.. [3.2542026... 3. {
150107702 1857202 0414014...[4.6027001 5 [21059374...[6.7405361... [1 347561 1... -2.7100346..|2.4986203...[7.5658349... |1 3783916.. [5.8267871... |-6.0870022...5. 1945543... |2.6282374...4.3972072... 2.1261962.. 3]
[2.1282210.1.7948436 4827732 3607679...|1.1227936... [1.4169524, 7263733...[3.0000680.. [3.0040741... 1.8452481..|35101257... |13458825... |3.1050331... 2.0282759... |6 86 32764...[24
26735436, 0025824, £622223...[1.0412857.. [2.6742695 7508197...|1.1492924.. [2.1449080... 1.6096614..|4.8680899... |17195079... |2.0704725... -1.0537211.]5.2240940...[44
53245305 2278302 3228557...|1.3007637.. [1.9509889. [12323713...[1.0281183.. [58223557... [1.7249873..|5.0449657... [12568011... |1 4877240...[0.0538454... 7 4676693...[2
22508127 7..[1.0750047 2155885 [6.0805375...[8.1310831... |2 4063319...[4.3021256... 71366335 [4.7645701... |8.7035375.. [4.5142510... |8 4204945.. |14
14041350 5. [4.4350847 6650763 6.7387974...[3.0224696...1.7973202...[2.7499050... |5.5766098. 28900244...|8.8709244...[26307367... 8.2470252... 1
13204661 . [1.9406080. 1491680 [44417771...|3.3325336..]3 7500384...|1.3862320...7.0546844...|3.1045516... |-8,1261600..-2.933 1531../5.2365313... 6.4
(78175321 [3.5627940..]1.6932010. 3200705, [27992384...[1.9836690..[7.3382541... 1.9733775... |51956150...4.2712116... |1.0002674... -3 4647545..|1 4958720
2118564 ... [4.6315056... [47507731... 2.5682562... [9.6370126... | 271217549 3674045 50119172 [4.0486715 5.5415838... 2. 1371773.. [8.3661306... |-1.2249005..|7 1963055... -1.0678150.
44102826...[5.6031326... [+ 0078372...[6.8723110...|5.6686581... |1.0168728. 2801162 4.4245005...[5.7649858 5.1350210...[6.7866212.. [7.8107812... |-1.8768426...-1.4336756..|-3.4447566
6.0621122...[5.1474892.. [5.0079810... 5.0049141...|5.4946108... [3.8980251. 9752415..14.9334075...|1.6303806... 51628501 43121645...[7.5462686... [0.1918773... |6.1240526../-1.6899043.. 4.127 1245...3
[1.8308166../3.1500292.. [3.0439962... 2.0442416... |-1.0500879../5.0903045, 3923058, 25536287...|1.6456801 3.2262703...[9.4195436... [4.3002955...|4.9730036... | 1.1798087..|-3.4789908.
[1.762006..|-1.5104320..[2.8212232...|5.0037083.. [1.0427352...|4.6662141 3360334 7.8992268...[7.3508781 28550688...[9.9996026...[3.2682036... |7 4654309.. | 5.8806570..,7.27028 15
[1.0821508..|-1.2207604.2201042¢... 5 0559569...[5.7940404...|1.4447959 5782687, 7468642...|1.1673878 6.5102885...[4.0526300... [4.42487632...|5.3864687... | 5.3255776..]3.29 75610
4.5720032...[3.8479315... [15893185. [0.9356306...|9.3702446... [3.3893860. 0887633 [15367189.. 35710125 3.5850768...[2.1697526... [5.5479705...|3.4789991.. | 5.2324263..7.5985928..|-1
22444270, 7926478..16.6592153... 8.2639877... | 12620164 3632625, 31032807 4495086...|0.6710717...|-4.1715622..| 5 5581185,
222496692 8860871...|1.7959939.. [5.7373280... |-1.6726712 1.1402060. 21880867 0130363..|-2.6993695..1.3697332../7.6356233
[3.3636520..] [2.8108357..[1.3717069.. [1.4889724... |1 4481803... 33668783 13572422 46182434, [4.9130803..]-4.2078275..2.0012676..]3.3100763. [34
22328817 6..16.6491224. [4.6561035... [1.1773050... 15460049, 48352690 9119458 [22787691..,1.5267434..1.1942398... 28949838
46038338 4351044..[3.0076969...|0.7433008...|-9.3783024..|-4.2288506 1283232 3.6630053... 23703224 | 4.9110135..|-15205030. [2.8474680... | 4.4847761..[4.8152231../6.0723652.. | 1.5526024.
«

il 1 [ D

VeeMagField (800, 2)
64-oitloating-point,
Number of afributes =8

time = 7.240992583020731E-12

globalGridGlobal
vsTimeGroup = time
vsType =variable

41x31x31x3

This depicts the output for a data dump of the Yee Magnetic field from the "Transport and
Emission in Diamond (Text-based Setup)” example simulation. Here, we can see in the Metadata

field to the left that the grid size + guard cells (40 x 30 x 30, plus a guard cell for each
dimension), along with other simulation data.

Loglnfo | Metadata

HF HDFView 2.13
Eile

indow Tools Help

Fig. 9.1: HDFView display of a field file.

51| 1577502 18348485 1E-6|7.842613435883674E-7 |4 1720150335880936E7
- imit 6. |-1.0278517792956097E-6 _|4.789374440972927E-7 _[5.315937403901626E-7
@ runinfo -1.0418457584821247E-6 |-0.837782008424664E-7 |1.1521719465546888E-7
= .492577601567658 3 1790305927078905E-7
= -1.4586440064065083E-6. |4.752553958818581E-7

@time . 1670488892¢205 -6 _|1.6962400679628424E-5 |1

0012230028000287E-6[1.32617083265307E-7
[1.3537253954260044E-6_|5.9730792075509
[1.963025366742356-6_ [5.037155812678011E
1.3931271515179767E-6_|-2.71848937513377 14E7
1.7193134189285734E-6 | 5.391840770193649E-7
1.8845534209172906E-6_|1.37305661083591731
1.013929103470987E-6__ [8.758278744758345E-7
|2.8514004678122006E-6_|1.046946578122303E-6
1.3692324448145426E-6_[2.18647377603227621
1.000885561590878 1E-6_|-1.388613822473305E-6.
[1.0060254769141212E-6_[8.425570341014132E-
1.1258953301634188E6_|
[1.1654309020775152E6 |
1.3744401839120255E-6 |
[1.6845081987267902E 6|
1.0090242647129768E-6 | 2.3237217984942886E-7
[1.149787023711256E-6__ [7.945243078059769E-7 _|-1.0729684433990011E6
1.3163672286656074E-6_|7.384730080505487E-7 | 5.454193096254776E6
1540872480003528E6 | 2

1.3673613142320452E7
[1.3772796776491006E-6
6.057224871089376E-7
5.816420544084047E7
5.008353505731452E7
1.429722615259533E-6
1.2466678411207939E-6
6.395646842856115E-7

172060.49180976834

[122389.83004658368_|-25654.115536032473
405328 7750328595 | 33809.967619951905
L1112 1a1osa0mna |

150414.5519219648
|-67370 62111564471 |

2726911488 154323

o ove7rs | ctearTen

[ transportEmissionDiamondT_Y4 W' veeMagField at / [ransporEmissionDiamondT_YeellagField_7h5 in CA\ o X

B veenagrieis e ol T o
o €2 derveavariables P ar £ 705 n Gl ]
& €2 globalGraGlobal 2l Taoe
G gosalcrdGiapallimis -

s T —
& €4 uninfo I I

X 3 y : z Pz _ Index _ (always 1)

- Qe This is an example of the
89 vanspertemissiondiamendT_s: o . 2 s s 7 P!

13470.441191059543
[112963.01472045454.
324040.21186992613
[110506.5939130513
[117535.12599536284.
173448.22413940635
[-18010.4756050357
37100.568527040516
340911.1874030702
13446.326547113596
[-66042.48315288298
-86667.99916626183
[143715.14924797628
8448.048376315483
96221.26556360949
1106595.00672119124.
63353.89174948045
13008827 184474883
[-70060.58333959243
(66485.8505118954
-268794.85742350725
[154803.70768715904
1273.9400072300857
52926.357376921995

output of a particle file from

the same example (“Transport

and Emission in Diamond (Text-

based setup)”) and the same

data dump. Here, the particle

kind is relBorisEffMassExtd, and

thus there are eight columns of

information.

The metadata field here

displays the 12 attributes

assigned to the

secondaryElectrons species in

the simulation, which arise

« I I ID

from both the basic .pre file

secondanElectronsLowE (800, 4)
64-oitloating-point, 921 x8
Number of afributes = 12
charge =-1.602176487E-19
mass = 9.10038216E-31
numPtdlsinklacro = 1.0
numSpatialDims =3

ptclEnds =921

time = 7.240992583020731E-12
vsAdsLabsls =XY.Z

vsLabel

vsLimits
vsNumSpatialDims =3
veTimeGroup = time

vsType =variableWithhesh

globalGridGlobalimits

inputs (species kind, charge,

mass, etc) and the simulation

parameters (dimensions, time
at dump, for example).

For more information on
species kinds, please visit VSim
Reference: Species.

Loginfo | Metadata |

Fig. 9.2: HDFView display of particle file.

9.7. HDFView Example Simulation .h5 Output File lllustration
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CHAPTER
TEN

DATA ANALYSIS

10.1 Opening and Running Two Stream (Visual setup)

It is possible to run postprocessing analysis scripts within the VSimComposer environment. These scripts can process
data generated in a simulation and write that data to a .h5 file that can then be visualized like any other simulation data.

Here, we will discuss the basic process of using a predefined analysis script. Other analysis options include using
text-based setup to set a default analysis script in their .pre file and importing custom analysis scripts. For more details
on these procedures, please see analysisdefault and VSim Customization: Create Your Own Script.

In this section, we will go through the basics of running analysis scripts, and will incorporate the two stream example
(visual setup) to illustrate the processes. To open the two stream example and follow along:

* Select the New -> From Example menu item in the File menu.

¢ In the resulting Examples window, expand the VSim for Basic Physics option.
* Expand the Basic Examples option.

 Select Two-Stream Instability and press the Choose button.

* In the resulting dialog, create a new folder if desired, and press the Save button to create a copy of this example
in your run area.

* This will open the Two-Stream Instabilitiy example. For this exercise, we will use the default parameters.

See Fig. 10.1.

10.2 Select a Predefined (Installed with VSim) Analysis Script

VSimComposer allows the user to select a predefined (installed with VSim) analysis script from the Analysis window.
You can either type in the filename of your analysis script or check the box Show All Analyzers to choose one from the
list. You can also select the Import Analyzer button at the bottom to import your own customized script.

For the two stream example, wait until the simulation run has completed and then click on the Analyze tab located
below the Run tab on the left hand side of the screen.

* In the Analysis Controls pane, check the box Show All Analyzers. This will bring up all of the available analysis
scripts.

* For this example, we will select computePtcINumDensity.py.

¢ In the Analysis Results pane and under the Outputs tab, instructions as to which variables have to be given by
the user will appear.
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VSim - Two-Stream Instability (text-based setup) — [u] X
File Edit Tools View Help

® (@] [0 /@ % VewnputFie [} Validate

twoStreanTpre  twoStreamTin

Two oppositely propagating electran beams, with periodic boundaries and 2 sinusoidal variation in their veloaties. A colision-ess
] plasma instability arising from smal charge imbalances can be seen in plots of the particle phase space.

VBAR [7.78¢6

VMOD [7.78e4 | 20

PRC [ 125, ]

NOmM |1 ]

NSTEPS [ 10000 ] 10"

TIMESTEP_FACTOR (0.9 ]

electronsl_ux (x10"6)
o

0.010 0.020 0.030 0.040 0.050 0.060 0.070
electronsl_x

€ Setup: COMPLETED Click run to continue ShowLog

Fig. 10.1: Setup Window for Two Stream Example

* For this particular script, the only two variables are the simulationName and the speciesName. For simulation-
Name, give it the name of the simulation, in our case twoStream. The speciesName parameter is either electronsO
or electronsl, the two species of electrons in this simulation.

See Fig. 10.2.
This process should be the same for both visual and text-based simulations.

However, there are different processes for keeping analysis scripts available for your simulation through closing and
reopening. For visual setup, simply run your simulation and analysis script of choice as usual, and then return to the
Setup tab and select the Save and Setup button in the top right. This process saves your analysis script in the .sdf file
for your simulation. For text setup, you can Set a Default Analysis Script in your .pre File.

10.3 Running the Analysis Script

Click the Analyze button located at the top right of the Control pane.

10.4 Output of an Analysis Script

The data generated from the execution of an analysis script will be stored as a .vshS file and is visualizable underneath
the Visualize tab. Be aware that the analysis script may also produce data that it writes to the screen or as hdf5 output.

Finishing up with the two stream example, the data we got from compute PtcINumDensity.py can be visualized through
the following:

¢ Open the Visualize tab. You may need to click on the Reload Data button at the bottom of the Visualization
Controls pane if you have gone back and forth between the windows and the VSim computational engine has
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VSim - Two-Stream Instability (text-based setup)

File Edit Tools View Help

Analysis Controls

\’ Search For Analyzer computePtdNumDensity.py [
o | Analyze stop Clear Qutput
Cutputs
how All Analyzers smulstionName | twoStreamT o
~
PR | computeBeam2ModeCoupling.py Calling 0
computeDebyelength.py specieshiame | electronsd
& computeFarFieldRadiation.py e e e o Lavion
G computeFarFieldFromKirchhoffBox.py avghany m:,jz“’ ron = THeme of the similation
Run computelnverseQ.py <XVar speciesName»
computePtclNumDensity.py iterateAvg description = "Name of the species te amalyze.”
£+ 3 computeST1Parsmeters.py </¥Vaz>
computeSParamsFromHists.py “iVar avglll> .
- descriprion = "Spatial Average over Nall cells, weightsd. Set to 1 for no average
computeSParamsViaOverlaplntegral.py e o1
= computeTimeSeriesAmplitude.py </¥var>
computeTimeSeriesFrequency.py <EVar iteratedug:
oy computeTransitTimeFactor.py descriprion = "Number of iteraticns for spatial average. Ignored if avgal =
— default = 1
convertFieldComponentCartToCylX.py e
convertFieldComponentCartToCylZ. py
o extractModes.py
Help extractModesViaOperator.py
performLowPassFilter.py Calling printHelp()
createMissingPtclsDumps.py Command TLine Usage: compuvePvelNumdensicy.py [options]
putFieldOnSurfaceMesh.py
computeCavityG.py This analysis script generates particle number density fields based on the
computePtclNumDensity.py (with example) particles data files.
options:
nelp, -h Show this help message and exmit.
lacion: -= sD
Name of the similation.
--speciesName=SPECTESNAME, -5 SPECTESNRME
Name of the species to analyze
- . N AVENEN
] Overnrite Existing Fies Spatial Average over NN cells, veighted. Set to 1 for
no average.
- , -1 e
The folowing variables can be used in Number of iteravions for spavial average. Igmored if
the above analyzer options: avalfxll = 1.
e, Whether a dataset or group should be overwritten if it
$DR =C: already exists
\Usersljcolins\Pocumentsibxcorp Vs
im3.0\simulations This analysis script outputs particle number density data as fields. These
SSIMNAME = troStreanT Geneity Tields can help to analyse the particle distribubion resulis in the
Remove from Default| Add to Default Open simulation domain.
v
Import Analyzer
D Analyze: READY Choose analyzer Show Log

Fig.

10.2: Analysis Window with Parameters

VSim - Two-Stream Instability (text-based setup)
File Edit

Tools  View Help

\’ Search For Analyzer computePtdNumDensity.py [
o ‘ Analyze Stop Clear Output
Qutputs
how All Analyzers smulationame |twoStreamT ki
writing file twoStresml slectronsODensicy 52.vshS ~
computeBeam2ModeCoupling.py X 83 hs_ ..
computeDebyeLength.py spedesiame | electronsd writing file twoStrearT_electronsODensity 83.vshS
computeFarFieldRadiation.py Processing file: twoStreanT_electrons0_84 hS...

y . writing file twoStreaml_elestrensODemsity 84.vshS
computeFarFieldFromKirchhoffBox.py avahba [1 o - g
computelnverseQ.py writing file twoStrearT electronsODensity 35.vshS
computePtelNumDensity. py P P
computeST1Parameterspy file _electrons0_B8E.hS...
computeSParamsFromists py writing file twoStreaml electronsODensity BE.vshS

P Processing file: twoStreamT_electrons0_87 hS...
computeSParamsViaOverlaplntegral.py writing file twoStreaml_electronsODensity_87.vshS
computeTimeSeriesAmplitude.py file: - clectronso_SE.hS...
computeTimeSeriesFrequency.py

- computeTransitTimeFactor.py writing file twoStresml electronsODensity 58.vshS
sualize e
convertFieldCompanentCartTaCylX.py writing file twoStrearT_electronsODensity 85.vshS
cenvertFieldCompenentCartTeCylZ py Processing file: twoStreamT_electroms0_9.hS
extractModes.py writing file tweStreaml_electrensODemsivy 9.vshs
exractModesViaOperator. py X 0_s0 s, ..
performLowPassFilter.py writing file tuoStreasml electronsODensicy 50.ushS
createMissingPiclsDumps.py e lectronsd 5Lhs. ..
putFieldOnSurfaceMesh.py writing file twoStreaml electronsODensity 51.vshS
computeCavityG.py Processing file: twoStreamT_electrons0_92 hs_ .
computePtclNumBensity. py (with example) writing file twoStreaml_elestrensODemsivy 52.vshS
file: X 0_s3.ns...
writing file tuoStreasmT electronsODensicy 53.ushs
£ile  electrons_S4.hS. ..
writing file twoStreaml_electronsODensity_S4.vshS
Processing file: twoStreanT_electrons0_95 hS...
writing file twoStreaml_elestrensODemsity 95.vshS
file: electroms0_36.hS...
] overnrite Existing Fies writing file tuoStreasml electronsODensity 5.ushS
£ile  electronst 37 hS_ ..
The folowing variables can be usedin | || #Fi5ing File twoStreamT_electronsODensity_S7.vshS
the above analyzer optiens: Processing file: twoStreanT_electrons0_S8 hS...
writing file a1 ©y_s3.vsns
IR =C: electroms0_33.hS...
\Usersyjeolins\pocumentsitecorpWs | | wricing £ile tvoStreamT electronsiDensity $5.vshS
ing.0\simulations
MNAME = twoStreamT
Remove from Default||Add to Default|  Open Rnalysis completed successfully
v
Import Analyzer
@ Analyze: READY Choose analyzer Show Log

Fig. 10.3: Analysis Window Successful Run

10.4. Output of an Analysis Script
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generated more data.
Switch the Data View to 1-D Fields.

For Graph 1, select electronsODensity for the Base Variable which is the first drop-down selection under Graph
1.

For Graph 2, select electronsODensity again for the Base Variable. In the Visualization Results pane (2nd graph),
click the FFT box to see the Fast Fourier Transform output of the frequency domain.

To match the visualization of this documentation, select Dump 2 in the slide bar at the bottom of the Visualization
Results pane.

Click on the DRAW button at the bottom of the Visualization Controls pane.

You can explore other visualization options in this window, or can rerun the simulation with different parameters to
investigate further.

VSim - Two-Stream Instability — o X
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Visualization Controls Visualization Results
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Fig. 10.4: Visualization of the analysis data
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CHAPTER
ELEVEN

VISUALIZATION

11.1 Introduction to the Visualize Window

VSimComposer’s Visualization feature is a flexible and comprehensive model viewer based on Vislt. The simulation
tutorials and examples in VSim Examples provide several examples of using the Visualization feature’s options in
context.

The VSimComposer visualization tool is context sensitive, meaning that only those features that can be used with the
current data are made available from the interface.

For more information on Vislt, please see: https://wci.llnl.gov/codes/visit/ and http://www.visitusers.org/index.php?
title=VisIt_Wiki

For more information on using the Vislt context menu see: Tools/VSimComposer Menu: Visualization Options.

The Visualization window is divided into a Visualization Controls pane on the left and a Visualization Results pane on
the right.

The type of data available to view is governed by the Data View pull down menu.

11.2 Select the Visualize Icon from the Icon Panel

Upon successful completion of the simulation run, the last message in the Engine Log tab is a reminder that you can
now select the Visualize icon from the icon panel on the far left of the VSimComposer window as seen in Fig. 11.1.

11.3 Data View Pull-down Menu

In the top left of the main pane, you may select the kind of analysis that is to be performed. Again, this menu is
context sensitive, so not all options may be available for your simulation. For example, you may only choose phase
space if you have particles, and you may only paint fields onto surfaces if you have complex boundaries specified in
GridBoundary blocks.

» Data Overview
¢ 1-D Fields

* Field Analysis
* History

* Phase Space

* Binning
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VSim - Two-Stream Instability — [u] X
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To see results, click on the "Visualize” icon in the icom pamel.
v
€ Run: SUCCESS Simulation engine finished successfully Show Log

Fig. 11.1: Visualize Icon in Icon Panel

* Paint Fields
See Fig. 11.2.

11.4 Standard Controls Available Across Multiple Views

Several control buttons or choices are available across several different Data Views. They have the same functionality
in each case and are documented below.

Annotation Level

To adjust the Annotation Level, use the Annotation Level drop-down menu at the lower left of the Visualization
Controls pane.

* No annotations
e Axes only

* Axes & Legends
* All annotations

See Fig. 11.3.
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VSim - Two-Stream Instability
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Fig. 11.3: Annotation Level

11.4. Standard Controls Available Across Multiple Views

127



VSim User Guide, Release 9.0.2-r2448

Reload Data

You can visualize data from a simulation run as soon as it becomes available. If you decide to visualize data before
a run is complete by switching to the Visualize tab, the VSim engine continues creating data files in the background.
Later, when more data is available for visualization or the simulation run is complete, use the Reload Data button to
visualize the new data. See Fig. 11.4.

VSim - Multipacting Growth in Waveguide (text-based setup) — o X

File Edit Tools View Help

Visualization Controls Visualization Results

\’ Data View: | Data Overview -

Ll Variables

O electrons_uy ~
[ electrans_uz
[ electrans x
O electrons_y
[ electrons_z
~ Scalar Data
v B
[ B_magnitude
Oex
Oey
Oez Wielcome to the data exploration tool. Thi tool alows you
con o combine plots of field variables, meshes, vectors, and
partides into a single image.

b
E% '(5) Edr E

Visualize | J To begin, choose a variable from the list on the left side of
~ Vector Data the screen.

Help Oe

~ globalGridGlobal
[ globalGridGlobal (8)
O globalGridGlobal (coax)
[ globalGridGlobal (E)
[ globalGridGlobal )
~ Geometries
[ poly
[ poly_surface v

[ Log Scale Color
[ pisplay Contours

Partide Style

Size. 2 =

Symbol Point -

Annotation Level:  Axes only - e

{2 Reload Date 3 e
@ Visualize: READY Visualization available ShowLog
Fig. 11.4: Controls Pane Buttons
Save Image

This button saves the current image to your computer. You will be given options on where to save, the file name, and
format as well as some options on size and dimension.

Labels

This brings up the Axis Labels window. See Fig. 11.5.

Axis Scale

This button enables adjusting the Scaling Factor for each axis. See Fig. 11.6.

Rendering

This button allows for adjustment of the lighting and stereo effects. See Fig. 11.7.
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Axis Labels — O X

H-Axis

Title | X-Axis |

Units | |

¥-Axis

Title |Y-Axis |

Units | |

I-Axis

Title |Z-Axis |

Units | |

OK Cancel Apply

Fig. 11.5: Axis Labels Menu

Limits — O X

Scaling Factor

X-axis |1 |

Y-axis |1 |

Z-axis |1 |

Reset View

QK Cancel Apply

Fig. 11.6: Axis Scale Menu
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\U Rendering 0.. — O X
[ ] specular Lighting

4k

Strength 100

4k

Sharpness |60

Stereo

(@ Mo Stereo Rendering
() Red/Blue Stereo

() Red/Green Stereo
() Interlaced Stereo

[ ] Enable Anti-Aliasing

OK Cancel Apply

Fig. 11.7: Rendering Menu

Colors

This button allows changing of the color table used for the plot and allows you to set limits on the minimum and
maximum. See Fig. 11.8.

Reset View

This button returns the objects in the Visualization Results pane back to their original location.

Auto Reset

Checking the Auto Reset box will force a Reset View each time the dump slider is moved.

Dump Slider

The slider at the bottom of the Visualization Results pane allows the user to move through the simulation results in
time. Only the times for which files were “dumped” can be viewed.
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Color Options — ] XK
Color Table |hot -
Limits

[ ] Fist Minimum 0

|:| Fizx Maximum 0

oK Cancel Apply

Fig. 11.8: Colors Menu

11.5 Data Overview

Variables

The Variables section of the Visualization Controls pane enables you to choose which aspects of the simulation data to
visualize. The types of variables that are available in the Variables section are dependent on your particular simulation.
Below are some typically available types of variables for a 3D simulation containing fields and particles.

Particle Data
Types of Particle Data may include any Species in the input file:
* electrons
* ions
* neutrals
Scalar Data
Types of Scalar Data may include fields like:
* E
*B
]
See Fig. 11.9.
Vector Data
Types of Vector Data include:
*E
*B
]
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VSim - Multipacting Growth in Waveguide (text-based setup)

File Edit Tools View Help

Visualization Controls Visualization Results
\’ Data View: |Data Overview - il
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Dump: 0
Annotation Level:  Axes &Legends -
i) | N
{2 Reload Date o =

@ Visuslize: READY Visualization available ShowLog

Fig. 11.9: Particle and Scalar Data Variables

Meshes
Types of Meshes include:
¢ globalGridGlobal (B)
* globalGridGlobal (E)
* globalGridGlobal (J)
¢ globalGridGlobal (coax)
Geometries
Types of Geometries include:
* poly
* poly_surface

See Fig. 11.10.

Log Scale Color

If the appropriate field is selected, the Log Scale Color checkbox will be available to enable and disable display of log
scale color.

Checking this box will put the color on a log scale. This is useful to see details in a field. See Fig. 11.11.
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VSim - Multipacting Growth in Waveguide (text-based setup)
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Fig. 11.10: Vector, Mesh and Geometry Data Variables

VSim - Electromagnetic Particle in Cell (text-based setup)
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Fig. 11.11: Log Scale Color Checkbox
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Display Contours

The default value in the Contours field is 5. If you select the Display Contours check box and have an appropriate data
set selected, the number of contours can be changed to any positive number. See Fig. 11.12.

VSim - Electromagnetic Particle in Cel (text-based setup) - u] X
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Fig. 11.12: Contours

Clip All Plots Checkbox

If the appropriate data is selected, the Clip All Plots checkbox will be available to enable and disable plot clipping.

When Clip All Plots is enabled, the Plane Controls can be used to select an axis intercept or normal vector for the
clipping. See Fig. 11.13.

Particle Style

The Particle Style section of the Visualization Controls panel enables you to control the appearance of particles in the
visualization.

The Size field contains the size of each particle symbol.
The Symbol pulldown menu contains choices for the following shapes:
¢ Point (default)
* Box
* Axis
* Icosahedron

¢ QOctahedron
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VSim - Vacuum Electromagnetic Pulse (text-based setup: - o e

Visualization Results

AV | > = ‘e ovenvew | [Y cip lne conte T 0 | [Renderng  [coors | IResetven | avtoreset

Welcome
Variables Clip Plane Normal

~ Scalar Data O X (plar
> B
Satup vE

to x-axis)
O Y {plane normal to y-axis)

[ E_magnitudd @ Z (plane nomal to z-axis)

Ry OEx © Custom Normal (obiique dip)
o OEy Custom Clip Plane Normal
Ez(E) 7 (XT0°-6)
Q > VectorData x| 6420246
N > Meshes ¥ (5 .
z @

Origin of Normal Vector

% (o ]

? t [o J

Heln z[o |
[ Log Scale Color | apaly [cond || ok

[ Display Contours

Clip All Plots Flane Controls

Mesh Controls

Opadty ]
Dump: &
£} Reload Date @ =
@ Visuslize: READY Visualization available ShowLog

Fig. 11.13: Clip All Plots Checkbox

* Tetrahedron
* Sphere Geometry
* Sphere

See Fig. 11.14.

11.6 Field Analysis

The Field Analysis data view will allow further analyzing of a particular field. The Visualization Controls pane allows
for selection of the field and selecting the line out location. The Visualization Results pane contains a 2d view of the
chosen field, and a lineout at the selected location.

Field

The Field drop-down menu will allow you to choose which field from your simulation to do further analysis on. See
Fig. 11.15.

Slice Settings

Slice settings will appear when a 3D field is viewed. The slice settings allow you to set the position of a slice of the 3D
field to create a 2D plot. The Plane Controls botton allows for further control, including creating a slice at an angle.
See Fig. 11.16.
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VSim - Multipacting Growth in Waveguide (text-based setup)
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Fig. 11.14: Particle Style

VSim - Electromagnetic Particle in Cell (text-based setup)
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Fig. 11.15: Field drop down
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|
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Fig. 11.16: Slice settings and plane controls for a 3D plot

Log Scale Color Table

Checking this box will put the color on a log scale. This is useful to see details in a field. See Fig. 11.17.

Lineout Settings

The position of the lineout can be changed using the Lineout Settings. The lineout can easily be set to vertical or
horizontal at a specified intercept location, or the Advanced tab can be used to set a line in any arbitrary direction or
length.

After setting the desired location of the lineout, press the Perform Lineout button to replot the lineout. See Fig. 11.18.

Layout

The layout of the Visualization Results pane can be changed from the default of Side-by-side 2d/1d. Options include:
* Side-by-side 2d/1d
* Stacked 2d/1d
e 2d Only
* 1d Only
See Fig. 11.19.
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VSim - Electromagnetic Particle in Cell (text-based setup) - o X
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Fig. 11.18: The lineout settings controls
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VSim - Electromagnetic Particle in Cell (text-based setup) - o x
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Fig. 11.19: The layout dropdown options

11.7 History

The History data view allows for plotting of any 1D array histories that were included in your input file prior to running
your simulation.

Up to 4 histories can be viewed at one time.

Location

The location drop-down allows you to plot multiple histories on top of each other. By setting the location of graph 1
and graph 2 to Window 1, both plots will appear in the same window.

Color

The color of the line can be modified using the Color drop down. Choices include red, blue, green, and black.

Style

The style of the line can be modified using the Style drop down. Choices include solid, dash, dot, dotdash, and points.

FFT

Selecting the FFT checkbox will take a Fast Fourier Transform of the data.
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Log Scale

Selecting the Log Scale checkbox will put the y-axis on a log scale.

Zoom

Setting the Zoom radial selection will switch the mouse click feature to zoom. Start by clicking the mouse inside the
plot window and then dragging to create a rectangle. Finish by un-clicking the mouse button. The plot will be zoomed
to the data contained inside the rectangle.

Navigate

Setting the Navigate radial selection will switch the mouse click feature to navigate. Click the mouse inside the plot
window and drag to move the plot. See Fig. 11.20.
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Fig. 11.20: The History View

11.8 Phase Space

The Phase Space data view allows for plotting of any particles (species) in your simulation.

Base Variable

The Base Variable can be used to switch between any of the particle species in your simulation.
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X-axis

The variable to be plotted on the x-axis.

Y-axis

The variable to be plotted on the y-axis.

Z-axis

The variable to be plotted on the z-axis.

Color

The particles can be plotted in either a solid color such as red, green, or blue, or they can be plotted using another
variable as their color. An example is to plot the velocity as the color on an X, y, z spatial plot.

Point Size (pixels)

The size of each particle symbol.

Symbol

The Symbol pulldown menu contains choices for the following shapes:
¢ Point (default)
* Box
* Axis
¢ Icosahedron
* Octahedron
e Tetrahedron
¢ Sphere Geometry
* Sphere

Enable Second (Third) Plot

Up to 3 particle species can be plotted at one time in the Phase Space window. To enable another plot, check the box.

Reset View on Draw

When changes are made to the variables to each plot, you must click the Draw button. Check the Reset View on Draw
button if you would like the view reset each time the draw button is clicked.
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Draw

When changes are made to the variables to each plot, you must click the Draw button to redraw the plot.

See Fig. 11.21.

VSim -

Multistage Collector (text-based setup)

File Edit Tools View Help
Visualization Controls

Visualization Results

Data View: |Phase Space -
Plot 1
Base Variable: | electrons -
X-axis |electrons_x ~ Otog
Y-axis | electrons_y ~ Oteg
Z-axis |electrons 2 v | Oteg
Color |electrons uz v | [J1og
Point Size (pixels)
Symbol Sphere -

[[] Enable Second Plot

[] Reset View on Draw

DRAW

Annotation Level: |Axes&legends v
= n
(= Reload Datt

Save Image | |Labels | | Axis Scale | |Reset View | [] Auto Reset

Scatter
Var: electrons_x,
electrons_y,
electrons_z,
electrons_uz
o 1.455e+006
—1.216e+007
I —2576e+007
—3936e+007
550764007
Max: 1.455e+004
Min: -5.297e+007

Dump: 1

(D Visuslize: READY Visuaization availsble

Show Log

11.9 Binning

Fig. 11.21: The Phase Space View

The Binning data view allows for “binning” the particles (species) in your simulation and creating histogram-style

plots.

Base Variable

The Base Variable can be used to switch between any of the particle species in your simulation.

Variable

The Variable to be binned.

Bins

The number of Bins. The variable will be divided into the number of bins chosen.
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Reduction Operator

The Operator is the method used for binning.

Reduction Variable

If the Variable is active (depending on the operator), the variable what the operator acts on.

Draw

When changes are made to the variables, you must click the Draw button to redraw the plot.

Slicing

Slice settings will appear when a third dimension is added. The slice settings allow you to set the position of the slice
of the 3D field to create the 2D plot. The Plane Controls button allows for further control, including creating a slice at
an angle. See Fig. 11.22.
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Fig. 11.22: The Binning View

11.9. Binning
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CHAPTER
TWELVE

TROUBLESHOOTING

12.1 Troubleshooting Electrostatic Simulations

12.1.1 The Simulation Does Not Finish Properly

The most common cause of crashes is improperly set up particle boundaries. The particle boundaries must completely
surround the space in which particles are loaded. Otherwise particles can drift out of the grid and try to reference fields
that do not exist. This leads to a Vorpal segmentation fault.

Another possible reason for an electrostatic simulation not finishing properly is that a particle has crossed more than
one cell in a time step. This could allow the particle to pass through a particle sink without being absorbed.

* One solution is to reduce the duration of the time step.

* Another solution is to limit the number of cells a particle can cross in one time step by artificially reducing the
velocity of high speed particles. See maxcellxing

It could be that the definition of the Particle Species is incorrect.

The following Species input block is not defined correctly:

<Species electrons>
kind = nonRelBoris
emField = myZeroField

</Species>

* The problem: The input block does not specify mass and charge.

e The result: The simulation runs normally with no complaints. The default mass and charge are those of a
positron.

 The solution: Include the mass and charge of your species every time they are defined.

12.1.2 The Electrostatic Solver Does Not Converge

If the electrostatic solver does not converge, this often indicates a problem with the setup. The matrix can become
singular in a fully periodic system. For solutions, see the section fully-periodic-systems.
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12.2 Troubleshooting Electromagnetic Simulations

12.2.1 The Simulation Does Not Finish Properly

The most common cause of crashes is improperly set up particle boundaries. The particle boundaries must completely
surround the space in which particles are loaded. Otherwise particles can drift out of the grid and try to reference fields
that do not exist. This leads to a Vorpal segmentation fault.

A common problem with electromagnetic simulation is not following the Courant condition [CFL28]. The Courant
condition states roughly that the time step must be small enough that a light wave cannot cross more than one cell in a
single time step.

12.2.2 The Output Shows an Unexpected High-Frequency or Checkerboard Pattern

These patterns can be symptoms of an instability resulting from violating the Courant condition. Roughly stated, the
Courant condition states that the time step must be small enough that a light wave cannot cross more than one cell in
a single time step.

12.3 Troubleshooting Visual Setup Crashes

The Visual Setup makes setting up simulations much simpler than writing an input file, but the output messages when
a simulation crashes can be mysterious. If a simulation crashes before the engine takes the first step, it is more than
likely that there is an error in the . sdf file. Documented below are some common errors, and the output messages
they will create at runtime. If your simulation is crashing before the first step, take a look to see if any of the error
messages shown below matches yours.

If your error message is NOT below, send an email to support@txcorp.com and an Application Engineer will
take a look at your simulation, and maybe your error will show up in the documentation for the next release!

12.3.1 General Tips

¢ Check the . in file for any unevaluated expressions.

* The message “Object %% % %% %: Could not locate object * in the input file object hierarchy” usually means
that something is missing from the . sdf file. Either a variable used in the simulation isn’t present or is miss-
named, or an attribute isn’t set/is left blank. Try to figure out what the “%%% %% %" object is in the simulation
then figure out what is missing. See below for some specific examples the examples.

* Running in parallel can sometimes suppress error messages. If you get a crash try running in serial for a better
error message.

« If a simulation with particles makes it to the first step, then hangs, it is possible that more particles than VSim
can handle are being loaded into the simulation.

* Objects need to be assigned a material before they can be used else where in the simulation.

* Geometry objects cannot set boundary conditions on the walls of a simulation. That is, a boundary condition
with the “boundary surface” attribute set to “shape surface” will fail to set a boundary on the upper x, lower x,
upper y, etc surfaces of the simulation.

e When using a geometry object to set a boundary condition internal to the simulation boundaries, make the
geometry extend beyond the nodes on which you wish to set the boundary.
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12.3.2 Parameter/Constant Not Named Properly

The following error was created in a simulation that had a constant named BEAM_RADIUS but had a SpaceTimeFunc-
tion that used “BEAMRADIUS”.

Here, the unknown expression (“undefined symbol”) was printed out, providing an avenue for beginning the debugging
process.

Sources are:
BeamEmitter
sputterNeutralEmitterd

ERRCR: In setting up simulation:
Txs5ymbolTable: :checkUndefVar: Undefined symbol 'BERMRADIUS".

Settings in the Z axis will be ignored

Lines from 'ionBeamSputtering.pre' processed.
Finished with 'ionBeamSputtering.pre'.

Error building data.

END ENGINE OUTPUT -———————————————

Engine completed with error: VORPAL INPUT-FILE ERRCR (code 5)

12.3.3 History Attribute Not Set

This error was from the same simulation as the error above. A history to count the number of physical particles was
added, but the species was left blank.

Unlike the error above, there is no “ERROR: ...” statement printed out. The nature of the error has been highlighted
in the image below for visibility. Sometimes, the nature of the error can be buried in the output, so keep a sharp eye
out for statements like the one below, because it does (indirectly) point to the cause of the crash.

Source named BeamEmitter added to Species ArgonIons.

Source named sputterMNeutralEmitter added to Species ARrgonlons.
Building species neutralCopper with NDIM = 2.

Added sink, lowerOhbsorber, to global region:

[-1, 0) = [-1, 33)Added sink, upperOibsorker, to glokal region:
[32, 33) x [-1, 33)Added sink, lowerlBbsorber, to global region:
[0, 32) = [-1, 0)Added sink, upperlBAbsorber, to global region:
[0, 32) x [32, 33)ERRCR: In sctting up simulation:

Cbject numPhysPtcls0: Could not locate object please in the input file object hierarchy..

Settings in the Z axis will be ignored

Lines from 'ionBeamSputtering.pre' processed.
Finished with 'ionBeamSputtering.pre'.

Error building solvers.

12.3.4 Missing Attribute in Boundary Condition

This error is very similar to the one above (History Attribute Not Set). In this case a Dirichlet boundary condition
named “dirichlet]” was added to the simulation, but a surface for the boundary condition was not specified.

The name of the boundary condition that was added was “dirichlet]”. In the image below, notice that this name appears
in the error message (“Object dirichlet1Filler ...”).

12.3.5 Over-Specifying Boundary Conditions

This error arose when two, overlapping CSG geometry objects were used to set the voltage on a region in the simula-
tion, so the voltage was over-specified.
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ERROR: In setting up simulation:
Problem found setting up MultiField:
Chiject dirichletlFiller: Could not locate object selectSurface in the input file object hierarchy..

Settings in the Z axis will be ignored

Lines from 'ionBeamSputtering.pre' processed.
Finished with 'ionBeamSputtering.pre'.

Error building solvers.

Depending on which electrostatic solver is being used, a different message will be output. The first error message
below was the result when using the “superLU” direct solver:

Lines from 'ionBeamSputtering.pre' processed.

Finished with 'ionBeamSputtering.pre'.

ERRCR: An unhandled exception was raised: Error! The parameter "Total numeric factorization time"™ does not exist
in the parameter (sub)list "ANONYMOUS".

The current parameters set in (sub) list "ANONYMOUS"™ are:
"Total matrix redistribution time"™ : double = 0
"Total Amesos overhead time" : double = 0
"Total symbolic factorization time™ : double = 0

Throw number = 1

END ENGINE OUTPUT ————————————————

This message was output when using the “gmres” iterative solver:

Species neutralCopper has velocity limits = [525072, 46453€].
lowerOAbSOT upperlAbsorber lowerlAbsorber upperlAbsorber

U=ing “power-method"' for eigen-computations
T

** ML Epetra::MultilevelFreconditioner

Matrix has 1103 rows and 4€9% nonzeros, distributed over 1 process(es)
The linear system matrix is an Epetra CraMatrix

## Transforming column map of Main linear system matrix

Defaul lues for "DD*

Maximum number of levels = 10

Using increasing lewels. Finest level
Humber of applications of the ML cycle
Humber of PDE equations = 1
Aggregation threshold = 0

Max coarse size = 128

R and P smoothing : P = (I-\omega A) P_c, R = P°T
R and P smoothing : ‘omega = 1.333/lambda max
Hull space type = default (constants)

0, coarsest level = %
1l

12.3.6 Under-Specifying Boundary Conditions

This is an example of an error where the printed error statement provided little to no help in debugging, unless you are
deeply familiar with matrix solver packages (Epetra constructs matrices and is the part of the Trilinos Library which
is used by VSim).

The cause of this error is that there are insufficient boundary conditions resulting in an in complete matrix. If you see
this error, adjust your boundary conditions to make sure boundary conditions are completely set on all boundaries of
the simulation Note: geometries cannot be used to set boundary conditions on the walls/boundaries (lower x, upper X,
lower y, etc.) of a simulation.
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ERRCR: In setting up simulation:
Problem found setting up MultiField:
Epetra error -1 occurred calling FillComplete() on matrix..

Settings in the Z axis will be ignored
Lines from 'ionBeamSputtering.pre' processed.
Finished with 'ionBeamSputtering.pre'.

12.3.7 Particle Loader Missing Loading Volume

Below is an example of what happens when a particle loader is not setup correctly. This is another more mysterious
error message, since after the “ERROR: In Setting up simulation” there is very little to indicate the location of the bug.
However, notice that the last thing printed before the error was “Sources are: /n particleLoader0”. This is a hint as to
where to check your input file.

Sources are:
parcicleloadex0

ERROR: In setting up =simulation:
Ho prmVec named °'lowerBounds'.

12.3.8 Fluid Missing Volume

This error is almost identical to the particle loader error listed above. A background fluid was added to the simulation,
and the volume attribute was not set. Notice how the simulation crashes right after printing out a statement about the
“neutralFluid]”.

s+ 32) % [-1, O)Added sink, upperlhbsorber, to global region:
[0, 32) = [32, 33)neurralFiluidi has the grid inicial conditions: inicialDensity.
ERROR: In setting up simulation:
Ho prmVec named 'lowerBounds®.
Sercings in the Z axis will be ignored

12.4 Troubleshooting Plasma Density

If applyTimes is set, and includes time t=0 in the range, particles may be loaded both during initialization and in the
zeroth time step of the model, potentially giving twice the density you want.

Use together with a history of kind=speciesNumPhysical and compare the total population to the number of particles
you expected.

Use together with the computePtc]INumDensity script to check the overall density of the loaded particles.
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12.5 Troubleshooting Missing Secondary Particles

If suppressEnergy is left to its default value of O in text driven simulations, this will prevent loading of secondary
electrons subject to an E field which would accelerate it into the boundary. The user can try switching off the sources
of E fields to check if the emission is correct. Due to space-charge it’s quite likely that many of the secondary electrons
will then experience the field and be driven into the boundary, having their emission suppressed. In other words they
will not appear in the simulation. Setting suppressEnergy to a large value like 1.e20 should address the issue.

See also the descriptions of Secondary Electron Emitter and secElec in the VSim Reference Manual.

12.6 Troubleshooting Performance

VSim is designed to optimally use the computational hardware you have available, whether a laptop or a leadership
class supercomputing facility.

It achieves this through the use of advanced algorithms, but this does not guarantee any given simulation will run as
fast as possible. This document outlines some simple checks which may aid speeding up a simulation.

On the one hand, there are different types of algorithms for field solves, particle movers and monte-carlo, and these
may all scale up in slightly different ways, and require different amounts of inter- processor communication for large
parallel simulations. Having many histories may also impact performance.

Firstly, it helps to understand which parts of the simulation are taking the most time. The best way to do this is to
remove elements of the simulation one at a time, and to assess the difference in speed. Having measured performance
of field solves, particle pushes (if applicable), monte carlo interactions (if applicable) and history objects, it may be
possible to simplify some of these, for example by adjusting the number of physical particles per macroparticle.

In general one need not dump the fields and particles more often than is necessary as this will lead to slow visualisation,
and the slowing down of the simulation while the data is written.

12.6.1 Electromagnetic Solves

Electromagnetic solves tend to be bound by memory access and the ability to pass boundary data across the network.
As a rule of thumb - performance tends not to increase well when the domain on each processor is smaller than
40x40x40 - but this limit will depend on the relative performance of your network fabric and CPU. Also, cells outside
perfect electrical conductor take longer than inside, so it can sometimes be worth adjusting the domain decomposi-
tion strategy to ensure the load is balanced equally. Minimize the regions over which any MAL or PML boundary
conditions are applied, as these will be comparatively slow compared with a normal cell update.

12.6.2 Electrostatic Solves

Electrostatic solves can be very communication intensive. Consequently, there may be a ‘sweet spot’ in terms of not
only the total number of processors to use, but the number of processors per node. System administrators may be able
to provide diagnostic tools to help monitor this behavior. With fixed number of nodes, varying the domain size may
also help with understanding the performance bottlenecks.

12.6.3 Particle Balancing

Particles may not be evenly distributed throughout the simulation domain for all times, and their distributions may
vary from species to species. The ‘binning’ tool in VSimComposer may be used to count the number of particles vs
X,y,z, and modifying the domain decomposition will sometimes help ensure the load is balanced optimally. It can help
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to temporarily add extra diagnostics to measure total populations of macroparticles for all species as they vary through
your simulation, and to focus on those with the most macroparticles.

If the number of macroparticles of some species is changing by many orders of magnitude, consider a strategy which
includes macroparticle combining or splitting. See: montecarlointeractions-interactions-nullselfcombination-kind

For densities that are uniformly high, and with consequent low mean free path, consider whether a fluid/hybrid
approach might be better.

12.6.4 Particle Interactions

For collisional plasmas, the time to run discharge simulations is often dominated by the computation of interactions
between the particles.

The most important thing is to make sure you are using the right set of interactions to describe your plasma. If you are
uncertain, consider running a global model to analyze the reaction paths and ensure insignificant paths are eliminated
from the simulation.

Monte-carlo type algorithms for interactions should be set such that the timestep is small enough that interaction
probabilities are always small as advised in monte_carlo_interactions_package.

12.6.5 Histories

Histories store their data in RAM in between data dumps and can write very large datasets. Some histories need to do
non-trivial amounts of computation each time step.

12.6.6 Configuration Issues

The installer Tech-X provides can be expected to work well out of the box on desktop and high performance computing
systems.

HPC systems often have high performance parallel systems. Commonly these are set up differently from your home
area, and you will need to ensure that you are running with your data being output to a specific partition. Check the
cluster documentation for more information.

HPC sytems are sometimes configured with a different MPI (to VSim’s required mpich MPI) in the environment set
up by the queue system. In rare cases the MPI installation provided by VSim can pick up the wrong network card or
fail to use the correct infiniband driver (normally where this has been customized heavily on those clusters). This will
likely manifest as very poor parallel performance. For example, a simulation using sixteen cores and one node may
run much faster than a simulation on thirty-two cores and two nodes (subject to the scaling advice above). In these
cases we recommend you contact Tech-X support at support@txcorp.com for advice. Modification of the environment
is non-trivial and may have unexpected consequences.

12.7 Troubleshooting MPI failure to start on OSX

On some versions of OSX, users have reported issues with MPI processes failing to start. This problem
can be identified as it causes errors of the kind

It appears a solution for this is simply to run:

Then to run VSimComposer from the same terminal.
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12.8 Troubleshooting Windows Permissions

If you see permission errors, try running the command prompt as administrator by right clicking the
prompt and clicking “Run as administrator”.

12.9 Troubleshooting VSimComposer Visualization

12.9.1 On Windows, VSimComposer Claims No Data Found Even Though it Exists
It is possible you are trying to visualize data from a folder other than a straight forward hard drive on the system.
VSim relies on Vislt for visualisation and the following are known to cause problems:

» Simulation directory path on a remote file system

» Simulation path containing international characters

¢ Simulation path uses the Universal Naming Convention (starts \)

On Windows machines, data inside a directory following Universal Naming Convention (UNC), e.g., \ma-
chine\directory\file, cannot be visualized using Vislt, the underlying visualization tool to VSimComposer. UNC style
paths are not supported. Instead, map the UNC path to a letter drive on the machine.

12.9.2 Particle Style Does Not Update When Grid Boundary is Plotted

If you are having difficulties updating your particle species in the visualization window, it may be due to the order in
which you are adding elements to the visualization.

Particles and grids are both meshes in the visualization tool that VSim uses (Vislt), and only the latest mesh gets
updated. This may be why updating the particles does not have the desired effect; the latest mesh is the grid and it is
the one being updated. If you want to update particles, you can instead add the grid first and the particles second. This
sequence will lead to updating the particle sizes and styles correctly.

12.9.3 Field Plots Not Being Updated

In certain simulations, you may be plotting multiple fields and notice that certain ones advance in time while others
never update past time 0.

This is due to the fact that the latter fields, as illustrated by the J field in the Magnetic Fields of Wire (Text-based setup)
example simulation, are actually static fields that are never updated throughout the simulation run. Thus, when these
static fields are examined in the Visualization window, only the initial field data at time O is displayed because that is
the only data generated.
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CHAPTER
THIRTEEN

ADVANCED SIMULATION TOPICS

13.1 Running a Parameter Sweep in VSim/Vorpal

One can run a parameter sweep by creating a script (.bat file for Windows or .sh file for Linux/Mac).

After following the instructions in Running Vorpal from the Command Line, you should be able to run on the command
line. The argument —iargs can be used to pass a parameter value to your input file for running.

vorpalser -i myFile.pre —-iargs FREQUENCY=1.e9

If you are content with running one file at a time (eg for relatively quick simulations, or where all simulations scale
perfectly onto all the cores you have available), the quickest way to scan through a set of frequencies, for instance,
might be to write a script (.bat or .sh) to loop over the values.

13.1.1 Linux/Mac

A basic example to loop through a number of wavelengths (2-10 by steps of 1) in the emPlaneWave example is as
follows:

for number in ‘seq 2 1 10" ; do
vorpalser —-i emPlaneWaveT.pre —-iargs WAVELENGTHS=S$number -o emPlaneWaveT_${number} \
> emPlaneWaveT_${number}.log

done

13.1.2 Windows

A basic example to loop through a number of wavelengths (2-10 by steps of 1) in the emPlaneWave example is as
follows:

FOR /L %n IN (2,1,10) DO vorpalser.exe -1 emPlaneWaveT.pre -iargs WAVELENGTHS=%n \
-0 emPlaneWaveT_%n > emPlaneWaveT_%n.log

In a batch file, use %%n in the above command.

Additionally you may want to use VSimComposer for visualisation after the simulation is complete, which requires
you to have the .pre file in the run directory, and one directory per simulation. The script below was written for a
cygwin machine with four cores. One core was kept clear so that the machine did not slow too much. The wc

| cut —-f£f2 —d" " approach will not work for larger core counts as the format of wc will change if there are more
characters. The awk command is pretty standard and would be better. This is principally to provide inspiration if you
wish to do something more complex. If you have comments and suggestions please email technical support.
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13.2 Selecting Solvers and Solver Parameters

Solvers are used when the field is defined implicitly, i.e., when the there is a relation between the field values at various
locations and what one is given. For example, in an electrostatic simulation, the potential is found by solving Poisson’s
equation,

~V?=p

This partial differential quation is then discretized to obtain a large linear equation that in the problem interior relates a
linear combination of the values of the potentials at a node and nearby nodes to the value of the potential at that node.
At the boundaries, the value of of the potential is directly related to the desired boundary value. Consequently, Vorpal
must solve a large linear system, where the number of independent values, i.e., the length of the vector, is the number
of field values in the problem.

As an example, in a Poisson solve for a 10 cell by 10 cell problem, because the potential must also be known at the
node above the last cell, there are 11 x 11 = 121 values of potential to solve for. The matrix for this solve therefore
has 121 x 121 = 14641 elements. One can see that these matrices become very large as the problem size increases.

Vorpal gives the user a fair number of choices for solving these problems. The first choice is whether to use a direct
solver, which uses methods like LU decomposition, or an iterative solver, which finds the solution through successive
matrix operations that converge to the solution. This first choice generally depends on the size of the problem. For
problems that are too large, one cannot hold the matrix in memory, and so one generally goes with an iterative method.
This is not definitive, however, as for smaller problems, an iterative method may still get one to solution more rapidly.

When using a direct solver, it is important to ensure that the matrix is not singular. In almost all cases this is true, but
with fully periodic boundary conditions, the Laplace matrix is singular, as can be seen by the fact that the constant
function is in its null space. One can make the matrix nonsingular by applying a boundary condition at a single cell.
However, this problem has no solution when the total charge in the system does not vanish. Thus, one must ensure
that the system is overall neutral. This can be enforced in Vorpal by adding a neutralizing background charge density.

Iterative solvers have no problem with periodic boundary conditions, and with them one need not impose any single-
cell bounary condition. Iterative solvers works very well on the Poisson problem. However, for iterative solvers one
much choose a tolerance, which is a measure of the residual reduction compared to the initial residual, is the stopping
criterion for the iterative solver. Values of 10~% often are sufficient for giving meaningful results. If the solver does
not converge, increase the tolerance. If the resulting potentials miss a lot of small scale structure, reduce the tolerance.

For interative solvers, one must also choose a preconditioner. Preconditioners transform the linear system used in
the Poisson solver into systems with more favorable convergence behavior. For a simple fully periodic system, a pre-
conditioner may not be necessary. For most other cases, using a pre-conditioner significantly improves the convergence
behavior. Multi-grid preconditioning tends to yield the best convergence behavior and is especially good for Poisson’s
equation.

For a comparison of different pre-conditioners and solvers for electrostatic simulations, see P. Messmer et.al. [MB04].

The Visual Setup user interface by default sets up what are believed to be the best solvers, preconditioners, and
parameters. However, it also allows the freedom to try others. Experimentation may be needed to arrive at the fastest
running simulation.
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domain The rectangular Cartesian grid. The physical domain is the grid specified by a user. The extended domain is
the grid with guard cells added by Vorpal.

extended domain See domain.
FDTD Finite-difference time-domain. The FDTD method is a technique for solving problems in electromagnetics.
float A floating-point number.

guard cell A cell located outside the user-defined simulation grid that Vorpal adds for parallel processing and other
computational purposes. Charges cannot be deposited in guard cells, but you can use guard cells when you
describe boundary conditions.

HDFS Hierarchical Data Format Version 5. A library and file format, developed by the National Center for Super-
computing Applications at the University of Illinois at Urbana-Champaign, for storing graphical and numerical
data and for transferring that data between computers. Vorpal and VSimComposer output data in hdf5.

input block An input block is an object consisting of parameters. Input blocks can be nested within other input blocks.
For example, input blocks for boundary conditions are nested within the input block for an electromagnetic field.

input file A Vorpal simulation file, which has a .pre suffix. Users define a simulation and its variables in an input file.
VSimComposer then runs the input file through a preprocessor to produce a processed input file.

MPI Message Passing Interface. An application programming interface (API) for communicating between processes
executing in parallel.

multi-grid pre-conditioner A pre-conditioner that enables a solver to use a hierarchy of grids to solve a partial
differential equation problem. The multi-grid pre-conditioner applies the results from coarse grids to accelerate
the convergence on the finest grid.

parameter A parameter is a variable value (integer, floating-point number, or text string) that users define to create a
simulation.

parse To divide input into parts and determine the meaning of each part.
physical domain See domain.

pre-conditioner An algorithm that works with an electrostatic solver to transfer an original linear system matrix into
a matrix that has better convergence behavior.

processed input file A Vorpal simulation file, which has a .in suffix. VSimComposer processes the input file to
produce a processed input file.

Python An open-source, interpreted scripting language managed by the Python Software Foundation.

SI units The International System of Units (Le Systeme International d’Unites), which has seven base
units: meter, kilogram, second, ampere, kelvin, mole, and candela.

solver An algorithm that calculates the results of electrostatic problems.
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TxPhysics A cross-platform library of computational modules, provided by Tech-X Corporation, for modeling
charged particles.
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* Vorpal™ © 1999-2002 University of Colorado. All rights reserved.
e Vorpal™ © 2002-2018 University of Colorado and Tech-X Corporation. All rights reserved.
e VSim™ except for Vorpal™ is © 2012-2018 Tech-X Corporation. All rights reserved.

For VSim™ licensing details please email sales@txcorp.com. All trademarks are the property of their
respective owners. Redistribution of any VSim™ input files from the VSim™ installation or the VSim™
document set, including VSim Installation, VSim Examples, VSim User Guide, VSim Reference, and VSim
Customization, is allowed provided that this Copyright statement is also included with the redistribution.
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